10.3. Shadow of the Terminal ................................................................. 117
11. Content - Workstation Deployment ................................................... 120
11.1. Step 1 – On the PC ........................................................................ 120
11.2. Step 2 – Workstation Display Client ............................................... 122
11.3. Adding the Workstation Display Client to the Terminal ..................... 128
12. Devices – Terminal Configuration ....................................................... 135
12.1. Terminal Configuration in ThinManager ............................................ 136
12.2. User Accounts in the Terminal Configuration Wizard ....................... 153
12.3. Copy Settings from another Terminal ................................................ 165
12.4. Using Groups for Organization ....................................................... 168
12.5. Using Groups for Configuration ...................................................... 176
13. Devices – IP Configuration ............................................................... 186
13.1. ThinManager Ready Thin Client IP Configuration ............................... 187
13.2. Adding and Configuring Thin Clients ............................................... 192
13.3. PXE Server and PXE Boot ............................................................ 193
13.4. Local WinTMC Configuration ........................................................ 208
13.5. WinTMC Configuration in ThinManager ........................................... 211
14. Devices – Mobile Devices ............................................................... 216
14.1. Configuring an iPad in ThinManager ............................................... 216
14.2. Configuring an Android Device in ThinManager ................................. 224
15. Active Directory and ThinManager Users ........................................... 230
15.1. Using Active Directory for Terminal Server Account ......................... 232
15.2. Using Active Directory for Terminal Users ......................................... 237
15.3. Password and Account Management ................................................ 242
16. TermSecure Overview ................................................................. 255
16.1. TermSecure Functions ................................................................. 255
16.2. User Accounts in TermSecure ....................................................... 255
16.3. Deploying TermSecure Quick List .................................................. 256
16.4. TermSecure User Configuration Wizard .......................................... 257
17. TermSecure Users Accounts .......................................................... 266
17.3. Create the TermSecure User using Active Directory ......................... 272
17.4. TermSecure Groups ................................................................. 278
17.5. Shortcut Method of Adding TermSecure Access Groups .................... 284
17.6. Adding a TermSecure User to a TermSecure User Group .................. 287
17.7. Batch Create TermSecure Users using Active Directory OU ................ 291
18. Using Access Group Permissions to Deploy Apps .............................. 299
18.1. Create Access Group ................................................................. 299
<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>23.3.</td>
<td>Share Keyboard and Mouse Module</td>
<td>419</td>
</tr>
<tr>
<td>24.</td>
<td>ThinManager Server Configuration Wizard</td>
<td>423</td>
</tr>
<tr>
<td>25.</td>
<td>Reports and Schedules</td>
<td>442</td>
</tr>
<tr>
<td>25.1.</td>
<td>Selecting Reports</td>
<td>442</td>
</tr>
<tr>
<td>25.2.</td>
<td>Report Tab</td>
<td>443</td>
</tr>
<tr>
<td>25.3.</td>
<td>Print Report</td>
<td>444</td>
</tr>
<tr>
<td>25.4.</td>
<td>Report Template Installation</td>
<td>445</td>
</tr>
<tr>
<td>26.</td>
<td>Scheduling</td>
<td>447</td>
</tr>
<tr>
<td>26.1.</td>
<td>System Scheduling of Reports</td>
<td>447</td>
</tr>
<tr>
<td>26.2.</td>
<td>Scheduling Configuration Backups</td>
<td>453</td>
</tr>
<tr>
<td>27.</td>
<td>TermMon ActiveX Data</td>
<td>456</td>
</tr>
<tr>
<td>27.1.</td>
<td>Registering the Control</td>
<td>456</td>
</tr>
</tbody>
</table>
1. ThinManager Introduction

1.1. ThinManager

ThinManager is an content delivery system. ThinManager delivers content from a source to a device where a user can view and interact with the content.

ThinManager is the tool that allows you to define sources, deploy content, configure devices, and allow user access. ThinManager is a software program that is installed on a computer in your system. Each device connects to it to receive its configuration and instructions.

The simplest use of ThinManager is to deploy a Windows application from a Windows terminal server to a ThinManager Ready device.
However ThinManager provides many more options for deploying applications.

**ThinManager Options**

**Source**
- Display Servers
  - Terminal Server
  - Workstations
  - IP Cameras
  - Terminals via Shadow

**Content**
- Display Clients
  - Windows Application
  - Workstation
  - Camera
  - Shadowed Terminals

**Device**
- ACP Thin Client
- PXE Thin Client
- WinTMC on PC
- iTMC on iPad

**User**
- Manual Login
- Auto-Login
- TermSecure

**Standard Industrial Architecture**

An industrial network will pull the I/O to the PLCs. The Terminal Server will host the sessions that run the HMI and talk to the PLCs to gather and display the data.
1.2. Access

ThinManager has an additional security system that controls deployment of applications to users. This is called TermSecure in ThinManager and is integrated as Access in Relevance.

1.3. Relevance

Relevance builds on the ThinManager system by adding location to the application delivery. This allows content to be sent to the right person at the right place at the right time.

You create Locations in Relevance and send content to the locations. These can be assigned locations with a tethered terminal or can be unassigned locations that have no terminal at the location and are accessed solely by mobile devices.

Locations can be resolved manually or by using bar codes, QR codes, Bluetooth beacons, or GPS.
2. ThinManager Interface

The ThinManager interface was changed in ThinManager 7.0 to a style based on the Microsoft Outlook template. This section will lead you through the important sections. You may find specific information by pressing the F1 key while in the ThinManager program.

The ThinManager Interface has several components.

1. **Application Button** – This launches the ThinManager Server Configuration wizard to configure global ThinManager settings.
2. **Quick Access Toolbar** – This lets you add icons of commonly used tasks from the menu bar, like Restart, Send Message, Modify, Backup, and Shadow. Select the Quick Access drop-down arrow to customize this tool bar.
3. **Menu Bar** – The menu bar separates the functions into categories.
4. **Ribbon Bar** – The menu bar now has the ribbon with icons for the functions. The ribbon can remain visible or hidden when unused. This is controlled by the Minimize the Ribbon command on the Quick Access drop-down arrow menu.
5. **Detail Pane Tabs** - The Detail Pane has tabs that allow you to choose what details you want to display. The tabs and detail selections change depending on what is selected in the tree. You can drag the tabs to change the order.
6. **Detail Pane** – The Detail Pane displays the information for the selected tab for the highlighted tree component. You can tear away the detail pane by dragging the tab away from ThinManager. You can re-dock the pane by dragging the pane title bar back to the tabs.
7. **Tree** – The tree shows the components of ThinManager. The tree now uses the Outlook Bar Tab control so the branches of the ThinManager tree are shown one at a time.

8. **Tree Selector** – The selector buttons at the bottom of the tree control select which branch is active and visible. These can be pulled upwards to stack the buttons, or pulled down to minimize the buttons.

Stacking the buttons is provides quicker switching but the minimized buttons allows more room to show components in a larger system.

There is an arrow that allows customization, tasks like hiding branches or reordering the branches of the tree.
2.1. Menus

The menus of ThinManager use the Microsoft Outlook ribbon but contain similar functions as previous versions.

This is a brief description. Many of these functions will be explained in greater details in the sections of the manual that cover setup and configuration.

**Edit**

**Edit** includes:

- **Add ThinManager Server** – This allows you to connect to, and manage other ThinManager Servers from your local interface. You need the appropriate permissions on the remote computer for access.
- **Disconnect** – This breaks the connection to the remote ThinManager Server.
- **Remove** – This deletes the remote ThinManager Server from the local list. It doesn’t affect the remote ThinManager Server.
- **Refresh** – This refreshes the data.
- **Modify** – This will open the configuration wizard for whatever item is highlighted in the tree.
- **Add** – This will launch a new configuration wizard for whatever branch is highlighted in the tree.
- **Add Group** – This will launch a group configuration wizard for whatever branch is highlighted in the tree.
- **Rename** – This allows you to rename a highlighted item.
- **Delete** – This will allow you to delete a highlighted item.
- **Find** – This will allow you to search for names, descriptions, IP addresses, and other data in the tree.
- **Find Next** – This allows you to repeatedly search for a term.

**Manage**

**Manage** includes:

- **Restore** – This opens a file browser to let you restore a previously saved ThinManager configuration.
- **Backup** – This opens a file browser that lets you backup and save a ThinManager configuration for emergency restoration. This backup can be automated using the Scheduler.
- **Synchronize** – This allows you to manually synchronize a pair of ThinManager Servers if you aren’t using the recommended automatic synchronization.
- **PXE Server** – This launches the PXE Server configuration wizard.
- **ThinManager Server List** – This opens the ThinManager Server configuration wizard for automatic synchronization.
- **DNS Configuration** – This opens the DNS configuration wizard to allow ThinManager to resolve names using your DNS.
- **Configure Default Terminal** – This allows configuration of the default terminal if you are using auto-creation of terminals.
- **Web Management** – This allows the configuration of Screentronix access.
- **Manage Accounts** – This allows you to manage passwords of Active Directory accounts. See Active Directory and ThinManager on page 230 for details.
- **Synchronize Passwords** – This allows you to synchronize the passwords between ThinManager and the Active Directory for the chosen accounts. See Active Directory and ThinManager on page 230 for details.
- **Settings (Active Directory)** – This allows you to use Active Directory, set Password Settings, and select whether to use Windows Security Groups or Active Directory Organizational Units for TermSecure. See Active Directory and ThinManager on page 230 for details.
- **Access Groups** – This opens the Access Groups for TermSecure or Relevance access. See TermSecure Overview on page 255 for details.

### Install

**Install** includes:

- **Firmware Package** – This allows you to update your firmware packages. The firmware package is a firmware version and the modules for that version.
- **Firmware** – This allows you to update the firmware without updating modules.
- **Modules** – This allows you to update a module without updating the firmware.
- **Boot Loader** – This allows you to update the boot loader used in PXE boot.
- **Chain Loader** – This allows you to update the chain loader used in PXE boot.
- **License** – This launches the Licensing window to add licenses to ThinManager.
- **TermCap Database** – The TermCap Database has information on the abilities of every ThinManager Ready thin client. A new version is released with every newly supported thin client. Service packs update the TermCap but this allows you to update the TermCap if a new unit you have isn’t listed.
- **Reports** – This allows you to add a report and sql query if you need a newly released one before it is added in a service pack.

### Tools

**Tools** includes:

- **Restart** – This will resend the configuration to a highlighted terminal.
- **Reboot** – This will cycle power to a highlighted terminal and reload the firmware and configuration.
- **Power On** – This will power on a highlighted virtual machine.
- **Reboot Server** – This will cycle power to a highlighted terminal server. Although it will give you a warning prompt, don't select this unless you are serious about restarting a terminal server.
- **Calibrate Touchscreen** – This will initiate the calibrate touchscreen program on a highlighted terminal.
- **Send Message** – This will send a message to a highlighted terminal.
- **Enable** – This command will re-enable a disabled terminal, terminal server, or location.
- **Disable** – This will disable a highlighted terminal, terminal server, or location. A terminal will stop showing the session but will show an ACP splash screen instead. The session will continue running on the terminal server. A disabled terminal server will kick all the ThinManager thin clients off the terminal server, forcing them to a backup server. The terminal server is still functional and will allow RDP connections from other sources. This is useful for forcing failover to a backup so you can update your terminal servers on the fly. A location will stop showing the session when disabled.
- **Clear** – This will allow you to clear the event log for the highlighted terminal or terminal server.

---

**View**

**View** includes:

- **Status Bar** – This checkbox shows the status bar at the bottom of the ThinManager interface.
- **Show Connected Only** – This will hide any unpowered or unconnected thin clients. Although it can be useful it is best left checked as it can be confusing when the unpowered terminal is hidden.
- **Reports** – This opens the Select Reports window that lets you select the reports for the various components. Select the Report tab for a highlighted component to see the actual report or use the Scheduler to generate a report automatically.
- **Application** – This lets you choose the color scheme for ThinManager.
- **Tabs** – This allows you to choose the tab scheme for ThinManager.
- **Print** – This allows you to print a highlighted Report tab.
- **Print Preview** – This allows you to preview the print format of the highlighted Report tab.

---

**Remote View**

**Remote View** includes:

- **Interactive** – This allows you to click into a shadowed session and control the session. Unchecking this will make it a "look but don’t touch" system.
- **Scaled to Window** – This shrinks the shadowed terminal to fit into the details pane. Unchecking this will show it in the correct resolution with scroll bars to give you a closer view.

- **Go Full Screen** – This will make the shadowed terminal’s image full screen. This can be reversed by selecting the CTL+ALT+Break buttons. If you go full screen and forget the key sequence use ALT+F4 to close ThinManager. It will close the full screen session.

- **Send Keys** – This sends the selected key sequence to a shadowed terminal.

- **Connect Options** – This allows you to configure the RDP settings when you connect to a terminal server console from ThinManager.

---

**Help**

*Help* includes:

- **About ThinManager** – This shows the version and build number of ThinManager.

### 2.2. Customizing the Toolbar

The ThinManager toolbar has a Quick Access area in the title bar that can be customized by adding icons of your most commonly used functions.

Launch the Customize window by selecting the small drop-down arrows to the left of the ThinManager title.

Select *More Commands...* from the *Customize Quick Access* Toolbar Menu. This will launch the Customize window.
Customize Window

The Commands list on the left are the available command options. Selecting one and moving it to the right list will add it to the Quick Access bar.

The Choose commands from drop-down allows you to select commands from each menu group.

Once you have selected your commands, and adjusted the order using the Up and Down arrows, you can save your commands by selecting the OK button.

Quick Access Tool Bar

The icons for the selected functions will appear in the Quick Launch menu. Clicking one will launch that function or wizard.
3. Users in a ThinManager System

There are three types of users in a ThinManager system. They are Windows Users, TermSecure Users, and ThinManager Security Group Users. The Windows users may be local accounts or domain accounts.

3.1. Windows Users

Windows Users are the Microsoft accounts created in Windows that allow access to the Windows terminal servers. These are configured within Windows and authenticated by Windows. They can be given varying levels of access and power using Windows User Groups and Group Policies.

All users and terminals need a Windows account to log in to a terminal server.

ThinManager 8 introduced Active Directory integration to the ThinManager system. This is covered in Active Directory and ThinManager Users on page 230.

3.2. ThinManager Security Group Users

ThinManager Security Group Users are Windows User Group members who have been configured in the ThinManager Server Configuration Wizard to have varying levels of access and control within the ThinManager program.

ThinManager Security Groups are configured on the ThinManager Security Groups page of the ThinManager Server Configuration wizard. See ThinManager Server Configuration Wizard on page 423.

3.3. TermSecure Users

TermSecure Users are users who can go to a ThinManager Ready thin client and receive access to specific Display Clients due to their membership in a TermSecure Access Group. The login and authentication is done by ThinManager a level above the Windows login.

TermSecure gives additional powers to grant or deny access to Windows applications but still relies on a Windows user account to login to a terminal server.

There are different strategies for TermSecure Users.

- If a user is using a Terminal-specific Application then they don't require a Windows account since they will be accessing the application on the terminal. They do need the Permission from an Access Group to open a hidden application.

- If a user is accessing their own User-specific Applications then they need a Windows account associated with them so they can log in and start these sessions.
  - The TermSecure User can be created from an Active Directory account.
  - The TermSecure User can be created to match the name of a Windows account and use that Windows account without using Active Directory.
  - The TermSecure User can be created with one name and be associated to a Windows account of a different, aliased name.
4. Sources - Terminal Servers

Microsoft servers with the terminal services or remote desktop role provide the foundation of thin client computing. It consolidates management of the Windows environment to mainframe architecture. This was originally called Terminal Services but is now called Remote Desktop Services. This document will use Terminal Server for the computer and operating system and will use Remote Desktop Services for the connection using the Remote Desktop Protocol.

First you need to build and configure the server using standard Microsoft practices.

Second, you need to define the server as a Display Server in ThinManager.

4.1. Microsoft Configuration

- Microsoft is the authority on their servers and you should refer to them for instructions on the use and configuration of their server.

Here are a few common tips.


- Create a Microsoft Licensing Server and add a Terminal Server Client Access License, or TS CAL, for each thin client. These are called RDS CALs (Remote Desktop Services CALs) in Server 2008R2 and later. The servers also require a normal CAL.

- Create a unique Microsoft user profile for each terminal on the terminal server. Make sure that the user is a member of the Remote Desktop Users Windows group.

- Apply appropriate security to each user profile using the standard Microsoft techniques.

- Install all applications in the Install Mode. This can be done by typing `change user /install` in a command window or by using the Add or Remove Programs in Server 2003 or by using the Install Application on Terminal Server in Server 2008.

Make sure that the following network ports are unblocked, including in the Windows firewall:

- UDP/4900 - TFTP - Used for the TFTP download of the firmware.
- TCP/2031 - Configuration - Used to pass the configuration from the ThinManager Server to the thin client.
- TCP/2032 - ThinServer Proxy Service – used by the Mobile ThinManager iPad and iPhone apps.
- UDP/67 – IP Address Assignment – Used by the PXE Server (if using PXE boot).
- UDP/69 – TFTP – Used by the PXE Server (if using PXE boot).
- TCP/1494 - Citrix - Used by the ICA protocol (if using ICA instead of RDP).
- TCP/3389 - RDP - Used by the RDP protocol (if using RDP in v2.4.1 or later).
- TCP/5900 - Shadowing - Used to shadow terminals. This can be changed on the Shadow Configuration page of the ThinManager Server Configuration Wizard.
- UDP/1758 – Used if the default Multicast is used. The MTU packet size can be changed on the Multicast Configuration page of the ThinManager Server Configuration Wizard.
- ICMP Echo Packets (Ping) – Used by WinTMC and Enforce Primary.
- DHCP - This needs configured, as needed.
4.2. Defining Terminal Servers in ThinManager

Once the terminal servers are built you must define them as Display Servers in ThinManager.

Go to the **Display Server** branch of the ThinManager tree.

Right Click on the **Terminal Servers** branch to open the menu.

Select **Add Terminal Server** to launch the **Terminal Server Wizard** to define the terminal server.

✓ Run the wizard for each terminal server you want to add to the system.
Introduction - Terminal Server Wizard

The first page of the wizard talks about DNS. Go to Manage > DNS Configuration to define your DNS server if you are using one. If this is done you just need to use the name and not the IP addresses.
4.2.1. Non-Domain Terminal Server

List your terminal server in the **Terminal Server Name** field of the **Terminal Server Name** page.

- **Use the Discover button to validate the server name and automatically fill in the IP addresses.**
  Clicking the **Discover** button will validate the name and will fill in the **Terminal Server IP** if the name is correct and the server is reachable. This is a great tool that checks spelling mistakes and prevents connection problems.

- **Add an administrative account to the Log In Information fields.**
  The **Log In Information** fields are for an administrative account on the terminal server. This is needed for SmartSession load balancing and server management from ThinManager. The ThinServer will connect to the terminal server to retrieve CPU, Memory, and Session status for load balancing but the Microsoft server will only give the information to an administrator. By entering an administrative account from the remote server the ThinServer will be able to access the information that is critical for SmartSession load balancing.
  
The wizard will warn you if the passwords don’t match.
4.2.2. Domain Member Terminal Server

A ThinManager Server is a domain has a Search button in addition to the Discover button. This launches a series of windows that allow you to select a domain user account for the administrative login.

✓ Use the Search button to add an administrative account to the Log In Information fields. Selecting the Search button will launch a Search for AD User window that allows you to select an Active Directory user.
Search for AD User Window

The Search for AD User window has a Location button that allows you to search the Active Directory locations.

Select the Locations… button to launch the Select AD Location to Search window.

Select AD Location to Search Window

Continue with the wizard by selecting the branch of the Active Directory tree that contains your administrative user account.

Highlight it and select the OK button.
Highlighting an Active Directory branch in the **Select AD Location to Search** window and selecting the **OK** button will re-open the **Search for AD User** window with the list of domain users from that branch.

Highlight the desired user and select **OK**. This will add the domain user to the **User Name** field of the Terminal Server Wizard.

**Search for AD User Window**
Once the domain user is in the **User Name** field of the Terminal Server Wizard you need to add the correct password to the **Password** field.

The **Verify** button will check the entered password and tell you if it is valid or incorrect. Once you have received a positive result select the **Next** button to continue with the wizard.
ThinManager 8.0 User Manual

Terminal Server Capabilities - Terminal Server Wizard

✓ Check the “Available for Display Clients using SmartSession” checkbox to use the terminal server with SmartSession

SmartSession load balancing uses the CPU levels, Memory usage, and Session count to calculate the resources available for the terminals. ThinManager needs to poll the server every 8 seconds to maintain accurate status levels. However, you don’t need to poll the server if you aren’t using SmartSession. For this reason SmartSession polling is turned off by default. You need to check the Available for Display Clients using SmartSession checkbox to activate SmartSession.
The Data Gathering page allows you to set the speed and frequency that ThinManager polls the terminal servers. This covers both SmartSession and the data on the Users, Sessions, and Processes tabs of the server.

The default Fast interval should be fine but it can be changed for less frequent polling or set to custom values.
If you activate SmartSession load balancing by checking the **Available for Display Clients using SmartSession** checkbox on the Terminal Server Capabilities page then the wizard will show the SmartSession Configuration page that allows you to tweak SmartSession load balancing.

See SmartSession on page 74.

Select the **Finish** button to accept the changes and close the wizard.

✓ Repeat for each terminal server that you will use.
4.2.3. Automatically Find Terminal Servers

ThinManager has a search function that will find terminal servers on the network to speed your configuration.

Go to the Terminal Server branch of the Display Server tree.

Right click on Terminal Servers and select Edit Terminal Servers. This will launch the Terminal Server List Wizard.
Click the **Find Servers** button on the **Terminal Server List Wizard**. This will launch the **Available Terminal Servers** list.

The **Available Terminal Servers** list will show all the terminal servers that ThinManager can communicate with in a workgroup. This does not work in a domain.

Highlight the one you want to add and select **OK**. This will launch the Terminal Server Wizard with the name and IP address filled in.
There is a **Domain or Workgroup** field to allow you to expand the search. Enter the domain or workgroup and click the **Find** button to search again.

### 4.3. Terminal Server Graph

Highlight a terminal server in the Terminal Servers branch of the ThinManager tree and select the Graph tab to see the performance levels of the server CPU usage, memory usage, and session count. These are the values that ThinManager uses to calculate the SmartSession resource load.

![Terminal Server Performance Graph](image)

### 4.4. Terminal Server Status

Highlighting the Terminal Servers branch of the ThinManager tree will show the connection status between ThinManager and the servers. Ideally the terminal servers are configured properly so that ThinManager will communicate with them and be able to pull load status into ThinManager for use in management and SmartSession load balancing.
Terminal Server Status

A properly connected terminal server will show a green bar in its icon and show “OK” in the Status tab. Sometimes the connection fails and the icon shows red.

- **Active ThinServer to Server Connection**
- **Failed Connect Attempt**
- **No Connection Attempt**

Terminal Server Status Lights

- **Green** – This means that the ThinServer can talk to the terminal server and pull data using the administrative account you are using.
- **Gray** – This shows that the administrative account was left blank and the ThinManager Server isn’t trying to communicate with the server.
- **Red** – This means that the server is offline or the administrative account failed to connect to the server.

✓ A Red or Gray icon do not mean that the terminals can’t login and run on the servers. This only indicates the ability of ThinManager to access the resources on the server.

Fixes:
If your icon shows **gray** re-open the **Terminal Server Wizard** and enter an administrative account in the **Log In Information** fields on the **Terminal Server Name** page.

If your icon shows **red** and the status message says that the "User specified does not have permission to connect" re-open the **Terminal Server Wizard** and correct the administrative account in the **Log In Information** fields on the **Terminal Server Name** page.

If your icon shows **red** and the status message says "The RPC Server is unavailable" or the "WTSAPI32.dll failed" then the terminal server is offline or is missing the Terminal Services/Remote Desktop Protocol role.

### 4.4.1. Local Administrative Login for ThinServer

Large domains sometimes have issues where the connection will time out before the domain controller can validate the user name. A simple solution is to create a local administrative user account on each server. Then have the ThinServer login in with this account. This will speed up the data retrieval.

You change the ThinServer service login in Microsoft Services on your ThinManager Server. This may be found in the **Administrative Tools** or in the **Server Manager**.

![Services in Windows 2008 Server Manager](image)

Double click on the **ThinServer** service on your ThinManager Server to open the **Service Properties** window.
Select the Log On tab on the ThinServer Properties window.

Change the log in account from the Local System account and specify the local administrative account you want to use. Make sure it is a member of the Administrative Group.

Select the OK button and restart the ThinServer service to apply the changes to the login.
4.4.2. Disabling Terminal Servers for Failover Tests and Updates

ThinManager allows you to disable a terminal server by highlighting the terminal server icon in the ThinManager tree and selecting **Tools > Disable**. This will force ThinManager controlled thin clients to drop their connection to the server and switch to an alternate server.

![Display Client Tree Showing Disabled Terminal Servers](image)

**Display Client Tree Showing Disabled Terminal Servers**

This is a useful tool for testing Failover and Instant Failover. The terminals should switch to their back up server. The network card on the server isn’t disabled and you can make RDP connections from a PC but the ThinManager thin clients will stop using the server.

You can also use this for updates during the normal production hours. Once you disable the terminal server you can reset the sessions by right clicking on the sessions on the Sessions tab and selecting **Reset Session**. Once the server is clear of sessions you can patch and update the server and applications, and even reboot it if necessary. This won’t impact production as all the terminals are using a backup server.

Once your updating is finished you can enable the server from **Tools > Enable** to allow the terminals to use the server again.

This **Disable/Enable** tool allows you to move servers offline one at a time for updating.
5. Sources – IP Cameras

ThinManager allows the integration of IP cameras into the ThinManager system. There are three steps.

- First, configure the camera and add it to your network using the guidelines from the camera maker.
- Second, add the configured camera to ThinManager as a Display Server source.
- Third, deploy the content of the cameras by creating a camera display client and applying it to the terminals.

5.1. Configure the Camera

Each camera manufacturer sends out their cameras with a default IP address and a default administrative account. This will need to be configured to add the camera to your network. Methods vary from vendor to vendor but a web interface is common.

- Please follow the instructions from the camera manufacturer to configure your camera for use.

![Browser Based Camera Configuration](image)

Browser Based Camera Configuration
5.2. Define the Camera as a Display Server

The Camera Configuration Wizard is launched from the Camera branch of the Display Server tree. Open the Display Server tree by selecting the Display Server icon at the bottom of the ThinManager tree.

Right click on the Cameras branch and select Add Camera to launch the Camera Configuration Wizard.
Enter a name for the camera.

Select the protocol that the camera will use. The choices are:

- Legacy Motion JPEG.
- Motion JPEG
- RTSP-HTTP
- RTSP-TCP
- RTSP-UDP
- RTSP-UDP multicast

5.2.1. Legacy Motion JPEG

This was the original method of configuring IP cameras in ThinManager. Cameras were testing and verified by the ACP development team and the information was added to the TermCap database.

One selected a Make and Model from a list contained in the TermCap database and ThinManager filled in the necessary URL.

This method has been updated.
5.2.2. Motion JPEG
Improved deployment of Motion JPEG in the ThinManager system
Motion JPEG URL specified by the camera manufacturer.
More flexible are you aren’t required to use a camera from the termcap.

5.2.3. Real Time Streaming Protocol
ThinManager now supports the Real Time Streaming Protocol (RTSP) for IP cameras.
RTSP has several transport layers, RTSP-http, RTSP-tcp, RTSP-udp, and RTSP-udp multicast. One
needs to specify the URL that that specific camera uses for the video stream.

- Select the desired transport method.
- Enter the IP address of the camera and select the Next button.
- Enter an account for the camera that allows streaming unless the camera allows anonymous
  access.
- Enter the RTSP URL specified by the camera manufacturer.
- Select Finish to close the wizard and finish the configuration.
Camera Authentication Page

Enter an account for the camera that allows streaming unless the camera allows anonymous access. The thin client will be unable to access the video feed without it.
Camera Management Screen

One the camera is defined in ThinManager properly you can access the camera’s browser control panel by highlighting the camera in the ThinManager tree and selecting the Connect tab. You can make changes as needed.

**Note:** If a camera uses a 32-bit ActiveX then it can be connected and viewed within a 32-bit ThinManager but not a 64-bit ThinManager.
If a camera uses a 64-bit ActiveX then it can be connected and viewed within a 64-bit ThinManager but not a 32-bit ThinManager.
6. Sources - Workstations
Microsoft built RDP connectivity into the XP Pro, Vista Pro, and Windows 7 Pro workstations. You can make an RDP connection to them and transfer the desktop to another computer. ThinManager takes advantage of this feature to allow you to port a workstation to a thin client. These may be physical workstations or virtual workstations.

- Go to the workstation and activate the remote desktop function.

.open the workstation System Properties either by right clicking on the My Computer icon and select Properties or by double clicking on the System icon in the Control Panel.

- Check the Allow users to connect remotely to this computer checkbox.
You can specify which users can access the workstation by clicking the Select Remote Users button.
Remote Desktop Users

The users listed below can connect to this computer, and any members of the Administrators group can connect even if they are not listed.

<table>
<thead>
<tr>
<th>admin1</th>
<th>admin5</th>
</tr>
</thead>
<tbody>
<tr>
<td>admin2</td>
<td>pburns</td>
</tr>
<tr>
<td>admin3</td>
<td>ThinMan</td>
</tr>
<tr>
<td>admin4</td>
<td></td>
</tr>
</tbody>
</table>

pburns already has access.

Add...  Remove

To create new user accounts or add users to other groups, go to Control Panel and open User Accounts.

Remote Desktop Users

Clicking the **Select Remote Users** button will open the **Remote Desktop Users** window. Use the **Add** button to grant permission to users.

This makes the workstations a source. You deliver the workstation to the thin client by defining Workstation Display Clients as shown in the Content section.

See Content - Workstation Deployment on page 120.
7. Sources – VCenter Servers

ThinManager plays well with virtual machines. The easiest way to handle virtual machines is to treat them as physical machines. ThinManager doesn’t care if they are physical or virtual.

If you use VMware’s ESXi you can connect using the ThinManager interface to access several of the management features provided by VMware’s VCenter.

Select the VCenter icon on the ThinManager tree to open the VCenter Server tree.

[Image: VCenter Server Tree]

Right click on the VCenter Server branch and select Add VCenter Server to open the VCenter Server wizard.
Enter a name and the IP address for your ESXi server.
Enter the administrative account in the Log In Information fields and select Finish to accept the changes and close the wizard.
Populated VCenter Server Tree in ThinManager

It will take a few minutes to connect and populate once you select finish. You can highlight the VCenter Server to see the connection status in the Summary tab.
VCenter Server Functions

Once the VCenter Server tree has populated you can right click on a virtual machine and do the following:

Power Operations:
- **Power On** – Turns on a stopped or suspended virtual machine.
- **Power Off** – Turns off a stopped or suspended virtual machine.
- **Suspend** – Suspends a running virtual machine and stores the state.
- **Reset** – Cycles power to the virtual machine to restart the virtual machine.

Snapshot:
- **Take Snapshot** – Captures and stores the state of the virtual machine.
- **Revert to Current Snapshot** – Reapplies the stored state of a previously saved virtual machine.
- **Snapshot Manager** – Launches the Snapshot management tool.
- **Rename** – Allows the virtual machine to be renamed.
- **Remove from Inventory** – Removes the virtual machine from the tree WITHOUT deleting the files.
- **Delete** – Removes the virtual machine from the tree AND deletes the file system.
Snapshots

Snapshots save the state of the virtual machine in a file. Snapshots allow you to preserve a working status before applying new applications, programs or updates. If the changes fail or are undesired, then the snapshot can be restored allowing the virtual machine to return to the pre-change state.

Right-clicking on the virtual machine and selecting **Snapshot>Take Snapshot** will launch the Create Snapshot window.

![Create Snapshot Window](image)

The **Create Snapshot** window allows you to name the snapshot and enter a description.

Select **OK** to save the snapshot or **Cancel** to close without saving.

Multiple snapshots of a virtual machine can be taken.

Right-clicking on the virtual machine and selecting **Snapshot>Revert to Current Snapshot** will apply the last snapshot taken.

Right-clicking on the virtual machine and selecting **Snapshot>Snapshot Manager** will launch the **Snapshot Manager** window.
The **Snapshot Manager** window shows all saved snapshots for the selected virtual machine. The **Snapshot Manager** window shows the name, description, and creation date of a highlighted snapshot. The buttons on the Snapshot Manager include:

- **Revert To** – This applies the selected saved snapshot.
- **Delete** – This deletes a highlighted snapshot.
- **Delete All** – This deletes all saved snapshots.
- **Edit** – Opens the Create Snapshot window to allow changes to the name and description.
- **OK** – Closes the **Snapshot Manager**.

A dialog box will require confirmation before changes are made.
You will receive a warning when you initiate a snapshot restoration.

7.1. Adding a Virtual Server

Virtual terminal servers that reside on a VCenter Server can be defined using a wizard. Select the Terminal Server icon on the ThinManager tree to open the Terminal Server tree. Right click on the Terminal Servers branch and select Add Virtual Terminal Server.

Terminal Server Tree

Selecting the Add Virtual Terminal Server command launches the Terminal Server Wizard.
Virtual Machine Selection Page

The Terminal Server Configuration Wizard shows an additional page when you select the **Add Virtual Terminal Server** command.

Select your VCenter Server in the drop-down if you have multiples defined.

The VCenter Server tree will populate the selection box.

Select the virtual terminal server you want and select the **Next** button.
Finish the configuration as you do other terminal servers by adding the administrative account in the Log In Information fields. The IP address should fill automatically.

Finish the wizard as you would regular terminal servers by clicking Finish or by clicking Next and checking the SmartSession load balancing checkbox.
The tree will show a different icon for a terminal server configured as a virtual terminal server. A virtual terminal server treated as a physical terminal server will show the same icon as a physical terminal server.

Display Server Tree

Once added a virtual terminal server can be used in display clients just like physical terminal servers.
8. Content – Terminal Services Display Client

Content is sent to devices through Display Clients. The most common content sent to a device is a Windows application. These are sent as terminal services display clients. You can either give a person a full desktop or limit them to a specific application with AppLink.

ThinManager allows you to deploy several applications to a device at once using MultiSession.

Launch the Display Client Configuration Wizard

Applications are defined using the Display Client Configuration Wizard. It is launched by selecting the Display Client icon at the bottom of the ThinManager tree, right clicking on the Terminal Services branch, and selecting Add Display Client.
8.1. Desktop

You can present a desktop to a device for the user. The device can automatically login with the terminal account or you can allow the user to login manually so that they receive the desktop that is associated with their user account.

Enter a name for the display client in the **Client Name** field.

The **Type of Display Client** is automatically filled if you right click on the Terminal Services branch. If you right click on the top level Display Clients branch then you will have to select the type of display client you want.
Display Client Options Page of the Display Client Wizard

The checkbox settings are:

- **Allow group to be tiled** – This allows the display client to be tiled when checked.
- **Allow Group to be moved (MultiMonitor)** – This allows the display client to be moved from screen to screen when using MultiMonitor. A display client that allows it to be moved can be anchored with a setting on the Screen Options page of the Terminal Configuration Wizard.
- **Include IP Camera Overlays** – This allows an IP Camera overlay to be added to this display client.
- **Always maintain a connection** – This keeps a session active, reconnecting and restarting if it is closed. If unchecked, the user can close a session and another session won’t start automatically.
- **Connect at boot-up** – This starts a session for this display client at boot up. Otherwise a user action is required to start the session if unchecked.
- **Disconnect in background** – If checked, a display client being used in a MultiSession configuration will disconnect once it is moved into the background. This could be done to require fewer resources.
ThinManager thin clients can use the default **Microsoft RDP (Remote Desktop Protocol)** or the **Citrix ICA (Independent Computing Architecture)**.

Select the protocol you wish to use with the display client.
The Terminal Services and Workstation Options page of the Display Client Wizard is the key page in Display Client configuration. These settings control how terminal server content is deployed to the terminal.

- **Leave the Application Link checkbox uncheck to deploy a desktop.**
- **Uncheck “Allow Auto-Login” if you want to provide the login prompt and force manual login.**

These are the configurations that this page controls:

- **Allow Auto-Login** – This automatically logs into the session if a user account is applied to the terminal. Unchecking this shows the login window and forces a manual login. This is useful to provide a user with a login based on their group policy.
- **Application Link** – AppLink launches a single application instead of a desktop. The session lacks the Explorer shell and does not show desktop icons or the Start menu. Closing the AppLink program will kill the session and re-spawn a new session with the application running. This allows the administrator to control content to the user in a simple manner without needing to use group policies.
- **SmartSession** – This adds SmartSession to the display client which provides load balancing between member terminal servers. SmartSession uses CPU availability, memory, and the number of sessions on the member
terminal servers to determine the load on the servers. Thin clients connect to the terminal server with the most available resources.

- **Enforce Primary** – This setting tells a thin client to reconnect to its original terminal server if that terminal server has failed and recovered. This is not available if SmartSession is selected.
- **Instant Failover** – This provides Instant Failover where the terminal will connect to two terminal servers in the Display Client. The terminal will have an active session on two terminal servers but will only display one session. If the first terminal server fails, the session of the second terminal server session is immediately displayed, eliminating any downtime due to terminal server failure. An Instant Failover display client will want to have two active sessions so if one terminal server fails the display client will start a session on a third terminal server if you have one in the server list.

![Display Client Members Page of the Display Client Wizard](image)

The **Display Client Members** page of the **Display Client Wizard** allows the selection of terminal servers that you want the application to run on.

Move the terminal servers you want to use from the **Available Terminal Server** list to the **Selected Terminal Server** list by highlighting the desired server and using the Left or Right arrow.

- If your defined terminal servers do not show in the list then you probably selected SmartSession on the previous page without checking the “Available for Display Clients using SmartSession” on the Terminal Server Capability page of the Terminal Server Wizard.
You can click the *Edit Server List* button to open the *Terminal Server List Wizard* to open each terminal server wizard to check the needed checkbox.

Adding two terminal servers to the *Selected Terminal Server* list will provide failover. In normal failover the terminal will connect to the first terminal server. If it fails it will connect to the second.

SmartSession load balancing does not follow the list order but instead goes to the terminal server with the lightest load.

Select the *Finish* button to complete the wizard and save the configuration.
8.2. Single Application Deployment with AppLink

ThinManager uses its AppLink function to launch a single application instead of a desktop. This allows you to control what the user can see and interact with.

The application is launched instead of the Windows Explorer desktop. Closing the application will cause the terminal to disconnect and re-launch a new connection to the server with the application running.

To create a single application display client launch the Display Client Configuration Wizard by selecting the Display Client icon at the bottom of the ThinManager tree, right clicking on the Terminal Services branch, and selecting Add Display Client.

![Client Name Page of the Display Client Wizard](image)

Client Name Page of the Display Client Wizard

Enter a name for the display client in the Client Name field.

The Type of Display Client is automatically filled if you right click on the Terminal Services branch. If you right click on the top level Display Clients branch then you will have to select the type of display client you want.
Display Client Options Page of the Display Client Wizard

The checkbox settings are:

- **Allow group to be tiled** – This allows the display client to be tiled when checked.
- **Allow Group to be moved (MultiMonitor)** – This allows the display client to be moved from screen to screen when using MultiMonitor. A display client that allows it to be moved can be anchored with a setting on the **Screen Options** page of the **Terminal Configuration Wizard**.
- **Include IP Camera Overlays** – This allows an IP Camera overlay to be added to this display client.
- **Always maintain a connection** – This keeps a session active, reconnecting and restarting if it is closed. If unchecked, the user can close a session and another session won’t start automatically.
- **Connect at boot-up** – This starts a session for this display client at boot up. Otherwise a user action is required to start the session if unchecked.
- **Disconnect in background** – If checked, a display client being used in a MultiSession configuration will disconnect once it is moved into the background. This could be done to require fewer resources.
ThinManager thin clients can use the default Microsoft RDP (Remote Desktop Protocol) or the Citrix ICA (Independent Computing Architecture).

Select the protocol you wish to use with the display client.
The Terminal Services and Workstation Options page of the Display Client Wizard is the key page in Display Client configuration. These settings control how terminal server content is deployed to the terminal.

- Check the “Application Link” checkbox to deploy a single AppLink application.
- Uncheck “Allow Auto-Login” if you want to provide the login prompt and force manual login.

These are the configurations that this page controls:

- **Allow Auto-Login** – This automatically logs into the session if a user account is applied to the terminal. Unchecking this shows the login window and forces a manual login. This is useful to provide a user with a login based on their group policy.
- **Application Link** – AppLink launches a single application instead of a desktop. The session lacks the Explorer shell and does not show desktop icons or the Start menu. Closing the AppLink program will kill the session and re-spawn a new session with the application running. This allows the administrator to control content to the user in a simple manner without needing to use group policies.
- **SmartSession** – This adds SmartSession to the display client which provides load balancing between member terminal servers. SmartSession uses CPU availability, memory, and the number of sessions on the member
ThinManager 8.0 User Manual

- 64 -

terminal servers to determine the load on the servers. Thin clients connect to the terminal server with the most available resources.

- **Enforce Primary** – This setting tells a thin client to reconnect to its original terminal server if that terminal server has failed and recovered. This is not available if SmartSession is selected.
- **Instant Failover** – This provides Instant Failover where the terminal will connect to two terminal servers in the Display Client. The terminal will have an active session on two terminal servers but will only display one session. If the first terminal server fails, the session of the second terminal server session is immediately displayed, eliminating any downtime due to terminal server failure. An Instant Failover display client will want to have two active sessions so if one terminal server fails the display client will start a session on a third terminal server if you have one in the server list.

![Display Client Wizard](image)

*Display Client Members Page of the Display Client Wizard*

The **Display Client Members** page of the **Display Client Wizard** allows the selection of terminal servers that you want the application to run on.

Move the terminal servers you want to use from the **Available Terminal Server** list to the **Selected Terminal Server** list by highlighting the desired server and using the Left or Right arrow.

- **If your defined terminal servers do not show in the list then you probably selected SmartSession on the previous page without checking the “Available for Display Clients using SmartSession” on the Terminal Server Capability page of the Terminal Server Wizard.**
You can click the **Edit Server List** button to open the **Terminal Server List Wizard** to open each terminal server wizard to check the needed checkbox.

Adding two terminal servers to the **Selected Terminal Server** list will provide failover. In normal failover the terminal will connect to the first terminal server. If it fails it will connect to the second.

SmartSession load balancing does not follow the list order but instead goes to the terminal server with the lightest load.

![AppLink Page of the Display Client Wizard](image)

The **AppLink Page** of the Display Client wizard has a field for the path to the executable to launch the desired application.

- **Enter the path to the application in the “Program Path and Filename” field.**

There is a **Browse** button that launches a file browser to allow you to select the executable file.
**File Browser**

Select the **Browse** button to open the file browser. Navigate to the executable file, highlight it, and select the **Open** button.

This will populate the **Program Path and Filename** field.
Select the Finish button to complete the wizard and save the configuration.

There are a few factors to consider when entering the application in the Program Path and Filename field:

- The file browser is on the ThinManager Server and not the Terminal Server unless you installed ThinManager on your Terminal Server.
- The path to the application needs to be the same on each terminal server.
- If the file is different on different servers you may need to use a batch file to launch the application using different paths.

A batch file is created and put in the same location on each terminal server.

The batch file can be as simple as 3 lines:

```plaintext
CD "C:\Program Files\Microsoft Office\Office14"
Start EXCEL.EXE
CD \
```
The batch file may need different paths on different servers. The first line is changed to reflect the location on that particular terminal server.

```
CD "C:\Program Files (x86)\Microsoft Office\Office14"
Start EXCEL.EXE
CD \
```

This first line uses the **Program Files (x86)** instead of **Program Files** to reflect the location on that particular terminal server.

When a terminal connects to a terminal server it will be directed to the batch file.
The batch file will direct the terminal to the right location.

**Batch File as the Program Path**

Point to the batch file in the common location if using a batch file to launch the application from different paths.
Created Display Clients in ThinManager Tree

Once you have created a display client it will show in the Display Client branch of the ThinManager tree.
8.3. Deployment Options

Terminal Services Display Clients have a variety of deployment options. These are controlled on the Terminal Services and Workstation Option page of the Display Client Wizard.

![Terminal Services and Workstation Option page of the Display Client Wizard](image)

Which checkbox you select changes the way applications are deployed.

8.4. Allow Auto-Login

*Allow Auto-Login* — This automatically logs into the session if a user account is applied to the terminal.

- Check the “Allow Auto-Login” checkbox to allow the session to start without needing user interaction if a user account is assigned to the terminal.

Using Auto-Login is the default setting. It is important for instant failover so that the backup session is immediately displayed without user intervention.

Unchecking this shows the login window and forces a manual login. This is useful to provide a user with a login based on their group policy, like when desktops are deployed.
8.5. **Application Link**

**Application Link** – AppLink launches a single application instead of a desktop. This allows you to control a user’s access. If the Display Client uses AppLink the user will not get a desktop or icons but will be limited to the application specified. Closing it will re-launch the program, assuring that it is always running. This allows the administrator to control content to the user in a simple manner without needing to use group policies.

![AppLink Page of the Display Client Wizard](image)

The AppLink Page has three fields.

- **Program Path and Filename** - Enter the path to the desired application in the field.

  **Note:** Quotation marks may be needed when there is a space in the path.

- **Command Line Options** – This field provides a space for command line options and switches. This field may not be required.

- **Start in the following folder** - This field is provided in case you need to specify the working directory for the program when using a relative path for the initial program. This field may not be required.

It has one button:
• **Browse** – The Browse button will allow you to select the executable file using a file browser. Make sure the path is correct on all terminal servers.

**Note:** If a Terminal Services Display Client contains several terminal servers, the path must be valid on all terminal servers. If different terminal servers have different paths to the desired program, write a batch file to open the program.

---

*Command Prompt Shortcut Properties*

The **AppLink** fields can be explained by looking at the properties of a shortcut. The Command Prompt shortcut property has a **Target** field and a **Start In** field. The **Target** is the path to the executable. The **Start In** field is the home directory for the application.
**AppLink Paths**

This shows how the path data from the shortcut is used in AppLink.

The **Target** field is equivalent to the **Program File and Filename** field.

The **Start In** field is equivalent to the **Start in the following folder** field.
Web Site Deployment

A browser can launch by including the URL of the desired site in the Command Line Options field.

8.6. SmartSession

SmartSession – This adds SmartSession to the display client which provides load balancing between member terminal servers.

SmartSession uses CPU availability, memory, and the number of sessions on the member terminal servers to determine the load on the servers. Thin clients connect to the terminal server with the most available resources.
The formula that ThinManager uses to calculate SmartSession load balancing is

$$\text{SmartSession Load} = (\text{CPUwt} \times \text{CPU}\%) + (\text{RAMwt} \times \text{RAM}\%) + (\text{SessionWt} \times \text{Session}\%)$$

The load = (CPU weight x the CPU Use %) + (Memory weight x Memory Use %) + (Session weight x Session Number %)

The Weight is configurable in the Display Client Wizard. The % range is configurable in the Terminal Server Wizard.
8.6.1. Weight in SmartSession

If you are concerned with one of the SmartSession measurements, either processor, memory, or sessions, you can increase the weight of that component to make its measurement a bigger factor. This is done on the SmartSession Setting page of the Display Client Wizard.

![SmartSession Settings Page of the Display Client Wizard]

Once you have selected the SmartSession checkbox on the Terminal Services and Workstation Options page of the Display Client wizard a SmartSession Settings page will be added before the AppLink page. This allows you to change the weight of each SmartSession load balancing component.

Changing the weight of one of the components will increase its value and make it more sensitive to overload of that resource.

If, for example, you are concerned with the CPU being taxed on the servers you can increase the CPU Utilization Weight to make that value increase the SmartSession load number more.
8.6.2. **SmartSession Ranges**

Normally ThinManager uses the full range of CPU and RAM to determine the SmartSession load. You can adjust that in the Terminal Server Wizard.

Open the Terminal Server Wizard by double clicking on the desired server on the Terminal Servers branch of the Display Server tree. Navigate to the SmartSession Configuration page.

![SmartSession Configuration Page of the Terminal Server Wizard](image)

Each resource that ThinManager measure for SmartSession load balancing has an adjustable range. The **CPU Utilization** and the **Memory Utilization** uses 0% to 100% as its scale. The **Sessions** resource is based on 50 sessions, where 0 sessions is 0%, 25 session sis 50%, and 50 sessions is 100% used.

If you are concerned about using all your resources on a server you can lower the **Maximum** setting. Changing the **Sessions** maximum to 25 would mean that 25 sessions is 100% utilized and ThinManager will consider the server less available. Likewise, changing the **CPU Utilization** maximum to 75% will tell ThinManager that the server is loaded at 75% CPU utilization, leaving some spare CPU available.

These numbers can be left at the default settings, or can be tweaked through trial and error to determine the best performance.

- The settings can be left at the defaults unless you notice a performance problem that changing the Weights or Ranges may correct.
8.6.3. Queuing

Another SmartSession feature is Queuing. This was developed to smooth the transition from one server to another during failover.

A starting session usually takes more resources to initialize than it takes to run. If a server fails and all or its terminals switch to a backup the many starting sessions may overload and tax the new server. This is especially true with HMIs, SCADAs, and other resource demanding applications.

When a terminal first starts an application that uses SmartSession ThinManager will check the resources of the member servers and ThinManager will send the terminal to the server with the lightest load, the most available resources.

Queuing acts like an intelligent bottleneck. When ThinManager sees that if all the servers have maxed out their resources then ThinManager will wait to give the server assignments to the terminals. It will wait until the loads drop and resources become available. Then ThinManager will send another terminal to the server.

Without Queuing the terminals would switch immediately, taxing the system and greatly slowing performance until all the sessions initialized and reached stable load levels.

![SmartSession Settings Page of the Display Client Wizard](image)

The Queuing function is automatically applied to SmartSession Display Clients. The default settings will give a minimum wait of 0 seconds and will let terminals connect after 120 seconds, even if the load has not lowered.
If the server bogs down with the default settings then try a longer interval. Checking the Infinite checkbox will keep the terminal waiting until the load lowers to an acceptable level. However, this may not be a good idea because if the server has problems, like a memory leak, then the resources may never lower enough to allow the terminals to connect. It would be better to move the Max field to a higher interval.

SmartSession load balancing and Queuing can be applied to a display client with a single member terminal server.

This allows the single server to have the terminals connect in an orderly fashion spreading the demand for startup resources instead of all connecting at the same time and overloading the server.

8.7. Enforce Primary

ThinManager uses a list of assigned terminal servers that the terminal can connect to. The top terminal server is considered the primary terminal server.

The thin client will connect to the terminal servers in order. If the terminal fails to connect to the first one it will try the second, then third, until it finds a listed server that allows a connection.

With Enforce Primary the top terminal server in the list is considered the Primary Terminal Server and the terminal will always try to connect to this server. If the terminal is running on the primary server and the server fails then the terminal will switch to a backup. However, the terminal will monitor the primary
terminal server. If the primary terminal server becomes available then the terminal will switch back to its assigned Primary Terminal Server.

8.8. Failover

ThinManager has a failover feature where you can assign two or more terminal servers to a terminal. If the first server fails the terminal will detect it and switch to the backup server. This prevents downtime and loss of productivity.

- It is a best practice to use Failover in every ThinManager system.

Failover requires:

- Two or more servers
- The same applications installed with the same path
- The same Windows accounts on each server

Configuring Failover is a simple as defining multiple terminal servers using the Terminal Server Wizard and adding two or more servers in the Selected Terminal Server list on the Display Client Member page of the Display Client Wizard.
**Terminal Connected to First Terminal Server**

The terminal connects to the first terminal server in the Selected Terminal Server list.

**Terminal Connected to Second Terminal Server**

If the first terminal server fails the terminal will detect it, disconnect, and try the next server in the list. It will launch the same display client with the same credentials.

The speed in which server failure is detected can be modified on the Monitoring Configuration page of the Terminal Configuration Wizard.
When a ThinManager Ready thin client or ThinManager Compatible thin client connects to a terminal server and starts a session it forms a secure socket connection with a heartbeat. If the connection is lost the terminal will try to reconnect. If it fails it will connect to the next terminal server in the list.

- The **Monitor Interval** is how many seconds the terminal will wait before attempting to reconnect.
- The **Monitor Retry** is the number of times the terminal will try to reconnect before switching,
- The **Monitor Timeout** is the interval between reconnection attempts.

Using the **Fast** setting a terminal will wait five seconds, try, wait a second, try a second time, wait a second, try a third time, then switch to the other server. This takes 10 to 20 seconds in a real world scenario.

There are other settings, including a custom setting but the slower settings are usually not needed with today’s fast networks.

The terminal can switch to a backup in 10 to 20 seconds but the applications need to load. If you don’t want to wait for the application to load you can use Instant Failover.
8.9. Instant Failover

A Display Client configured with the Instant Failover checkbox will send the terminal to connect to two terminal servers at startup, giving it two active sessions.

---

**Instant Failover with Two Active Sessions**

If the first terminal server fails, the session of the second terminal server session is immediately displayed, eliminating any downtime due to terminal server failure.

---

**Terminal with Instant Failover and Backup Sessions**

An Instant Failover display client will want to have two active sessions so if one terminal server fails the display client will start a session on a third terminal server if you have one in the server list.

Instant Failover requires:

- Two or more servers
- The same applications installed with the same path
- The same Windows accounts on each server
- The Display Client needs the **Instant Failover** checkbox checked on the Terminal Services and Workstation Options

- Use the Auto-Login function so switching is automatic and doesn’t require a user to login to start the session
- Instant Failover is free from ThinManager but you will probably need a second license from your application vendor.
9. Content – Camera Display Clients

IP camera video feed can be displayed on ThinManager Ready thin clients and ThinManager Compatible thin clients.

- Configure the camera device according to the camera vendor guidelines and add to your network.
- Define the camera as a Camera Display Server.
- Create a Camera Display Client and add camera output as overlays. See Content – Camera Display Clients on page 84.
- Add the Camera Display Client to a terminal. See Terminal Configuration in ThinManager on page 136.

Display Client applications for the terminal are defined using the Display Client Configuration Wizard.

Add Camera Display Client

It is launched by selecting the Display Client icon at the bottom of the ThinManager tree, right clicking on the Terminal Services branch, and selecting Add Display Client.
Camera Display Client Name Page of the Display Client Wizard

Name your display client by entering a name in the **Client Name** field.

The wizard starts like the **Terminal Services Display Client Wizard** but changes at the **Overlay Outline** page.
Camera feeds are laid out on the **Overlay Layout** page of the Display Client Wizard. You can either use a camera overlay template or lay out a custom overlay.
9.1. Camera Overlay Template

The wizard has a number of layouts pre-configured. Use the Choose Camera Layout drop-down to select from one to sixteen camera grids. These run from 1x1, through 2x2 and 3x3, to 4x4 cameras.

One you have selected a template the wizard lets you add a camera per grid.
The wizard will show an Overlay Camera page for each overlay. The gray overlay is the one you are assigning cameras to.

You can leave the default **All Cameras Available** checked and all of the cameras are available in that overlay.

The **Set Initial Camera** button opens a list of the cameras that lets you select which camera you want to be displayed first.
Select Initial Camera Window

The Select Initial Camera window shows the cameras in a tree. Select the one you want to be displayed first and select the OK button to close.
Overlay Cameras Page

To limit the overlay to a smaller set of cameras you uncheck the **All Cameras Available** checkbox and use the **Add** button to select the desired camera or cameras.
Clicking the **Add** button in the **Cameras to Show** frame will launch the **Select Camera or Group** window.

Select a camera and click the **OK** button. Repeat until all the desired cameras are selected.
Selected List of Cameras

If you select multiple cameras the top listed camera will be the camera that is shown first. Select the **Finish** button when you have selected cameras for each overlay.
9.1.1. **Overlay Options**

Once you add a camera or cameras to the overlay you can select the *Overlay Options* button to configure the overlay options.

The *Overlay Options* page has setting to alter the camera display.

**General Options:**

- **Enable Overlay** – This option allows the overlay to be visible at startup. Unchecking this setting will start the display client with the camera in a disabled non-visible state. The TermMon ActiveX Control can be used by an application to enable the overlay.

- **Interactive** – This option allows the user on the terminal to interact with the overlay. If the user clicks in the overlay area, he can perform functions such as switching cameras and making the overlay full screen.

- **Scale** – This option will scale camera frames to be to the size of the overlay window. Aspect ratio will be maintained.

- **Crop** – This option will crop the camera frame if it is larger than the camera overlay. This option when combined with the *Scale* option will always fill the entire overlay area.

- **Show Complete Camera Name** – Using this option allows the entire path of the camera to be displayed. The path includes any groups of which the camera is a member.

- **Border Size** – This setting determines the size of the overlay outside border.

**Title Options:**

- **Title Position** – This is the position of the camera name within the overlay.

- **Title Size** – This is the size of the camera name when displayed within the overlay. Set this to *Don’t Show Title* if you do not want the camera name displayed.
Cycling Options:

- **Enable Cycling** – Check this setting to cycle between the cameras assigned to the overlay.
- **Cycle Time** – This is the time in seconds that the overlay will display each camera before switching to the next camera.

**Note:** The *Cycling Options* are not available if you check the *All Cameras Available* checkbox on the *Overlay Cameras* page. You must individually list the cameras in the *Camera to Show* window.

*Shadow of a Terminal with a Camera Display Client*

Once a terminal has a Camera Display Client added and is rebooted, the cameras become visible. When the Camera Display Client is selected the terminal will make a connection to the camera and request the feed using the administrative account you entered when you defined the camera as a display server. This connection will only be active if the camera display client is active. If you switch to another display client then the terminal will drop the connection to the camera.

The overlays and cameras will show green lightning bolts when active and red when inactive.
9.1.2. Custom Overlays

You can create custom overlays instead of using the pre-configured templates.

Create a new Camera Display Client by right clicking on the Camera branch of the Terminal Services branch of the Display Client tree and selecting Add Display Client.

![Overlay Layout Page of the Camera Display Client Wizard](image)

Overlay Layout Page of the Camera Display Client Wizard

Select the Add Overlay button to open the Custom Overlay window.

![Custom Overlay Window](image)

Custom Overlay Window

The Custom Overlay window allows you to define the boundaries of the overlay.
Select the position of the overlay in pixels using the **Left** and **Top** fields.
Define the size of the overlay in pixels in the **Width** and **Height** fields.
Click the **OK** button when done.

*Overlay Layout Page of the Camera Display Client Wizard*

Once the Custom Overlay window is closed the Overlay Layout page will show the boundaries of the custom overlay.
Overlay Cameras Page

The Display Client Wizard will continue to add a camera or cameras to the overlays just like it did for the pre-configured templates.
Multiple Custom Camera Overlays

You can add as many custom overlays as will fit on a display client screen.
Multiple Custom Camera Overlays

The wizard will allow you to add cameras to each overlay in turn.
Select the Finish button when done.
9.1.3. Adding a Camera to an Existing Application

Camera overlays can be added to an application using the Terminal Server Display Client Wizard. This is an overlay. It will cover the screen of that display client is the area you define. You can hide and reveal the overlay with the TermMon ActiveX from ACP.

- Use the TermMon ActiveX to hide and reveal the camera overlay

See Cameras and the TermMon ActiveX on page 106.

Open a Terminal Server Display Client wizard and navigate to the **Display Client Options** page.

![Display Client Options Page of the Terminal Server Display Client Wizard](image)

Check the **Include IP Camera Overlays** checkbox.

This will add an **Overlay Layout** page to the end of the wizard.

Navigate to the **Overlay Layout** page of the wizard.
Overlay Layout Page of the Display Client Wizard

Select the **Add Overlay** button to launch the **Custom Overlay** window.
Select the position of the overlay in pixels using the **Left** and **Top** fields.
Define the size of the overlay in pixels in the **Width** and **Height** fields
Click the **OK** button when done.
Once the custom overlay is defined and the Overlay Layout page is closed you will have the Overlay Layout Page showing the boundaries of the custom overlay.

Select the Next button to continue the wizard.
Specify the cameras as before, either using the **All Cameras Available** checkbox or the **Add** button.
Select Camera or Group window is launched from the Add button and allows you to select a camera for the overlay.

Highlight the desired camera and select the OK button.

Repeat as needed.
Overlay Cameras Page of the Terminal Server Display Client Wizard

When the cameras are selected and the options configured you can select the **Finish** button to close the wizard.
Embedded Camera in Application

The camera will be displayed in the display client when it is added to a terminal configuration and the terminal is restarted.

9.1.4. Cameras and the TermMon ActiveX

Camera overlays that are added to an application using the Terminal Server Display Client Wizard will cover the screen of that display client in the area you define. You can hide and reveal the overlay with the TermMon ActiveX from ACP.

The TermMon ActiveX Control can be found on the ThinManager CD as termmon.ocx. It is also available in the Download section at http://downloads.thinmanager.com/. The Control must be registered before it can be used. Copy the file termmon.ocx to the computer where you want to use it. Register the OCX by executing

```bash
regsvr32 <path\termmon.ocx>
```

Once it is registered it can be added to the application and used to control the camera overlays. These are the commands available to use with the cameras:
- **CameraOverlayEnable** - This method is used to enable a camera overlay. This method requires two parameters. The first parameter is the name of the Display Client the overlay is on. The second parameter is the name of the overlay.

- **CameraOverlayDisable** - This method is used to disable a camera overlay. This method requires two parameters. The first parameter is the name of the Display Client the overlay is on. The second parameter is the name of the overlay.

- **CameraOverlayCycleStart** - This method is used to start camera cycling for a camera overlay. This method requires two parameters. The first parameter is the name of the Display Client the overlay is on. The second parameter is the name of the overlay.

- **CameraOverlayCycleStop** - This method is used to stop camera cycling for a camera overlay. This method requires two parameters. The first parameter is the name of the Display Client the overlay is on. The second parameter is the name of the overlay.

- **CameraOverlaySwitchNext** - This method is used to switch to the next camera in a camera overlay list. This method requires two parameters. The first parameter is the name of the Display Client the overlay is on. The second parameter is the name of the overlay.

- **CameraOverlaySwitchPrev** - This method is used to switch to the previous camera in a camera overlay list. This method requires two parameters. The first parameter is the name of the Display Client the overlay is on. The second parameter is the name of the overlay.

- **CameraOverlayFullscreenEnter** - This method is used to make the current camera in a camera overlay enter full screen. This method requires two parameters. The first parameter is the name of the Display Client the overlay is on. The second parameter is the name of the overlay.

- **CameraOverlayFullscreenExit** - This method is used to make the current camera in a camera overlay exit full screen. This method requires two parameters. The first parameter is the name of the Display Client the overlay is on. The second parameter is the name of the overlay.

- **CameraOverlaySwitchByName** - This method is used to change cameras in a camera overlay. This method requires three parameters. The first parameter is the name of the Display Client the overlay is on. The second parameter is the name of the overlay. The third parameter is the name of the camera. The camera name must include the full path if the camera is in a camera group.

- **CameraOverlayMove** - This method is used to change the position of a camera overlay. This method requires four parameters. The first parameter is the name of the Display Client the overlay is on. The second parameter is the name of the overlay. The third parameter is the x location. The forth parameter is the y position.

- **CameraOverlayResize** - This method is used to change the size of a camera overlay. This method requires four parameters. The first parameter is the name of the Display Client the overlay is on. The second parameter is the name of the overlay. The third parameter is the width. The forth parameter is the height.

- **CameraOverlayResizeMove** - This method is used to change the size and position of a camera overlay. This method requires six parameters. The first parameter is the name of the Display Client the overlay is on. The second parameter is the name of the overlay. The third parameter is the x position. The forth parameter is the y position. The fifth parameter is the width. The sixth parameter is the height.
10. Content – Terminal Shadow

The Terminal Shadow display client allows one ThinManager thin client to shadow another. You can shadow one specific thin client or have a menu of terminals to shadow at will.

Terminal Shadow is valuable because it allows a user to shadow another terminal without needing to launch ThinManager to use the ThinManager shadow function.

The ThinManager Terminal Shadow sends the screen display from the shadowed terminal to the shadowed. It doesn't redirect the display from the terminal server but sends the images from the actual shadowed terminal.

Terminal to terminal shadowing is set up and configured as a Terminal Shadow Display Client.

Launch the Display Client Wizard by right clicking on the Terminal Shadow branch of the Display Clients tree and selecting Add Display Client.
10.1. Shadow Any Terminal

The Terminal Shadow display client can be created with a list of terminals that can be shadowed. This is a great troubleshooting tool because a station can be given a chance to view other terminals to monitor problems or to analyze problems without having to travel to the specific problem area.

Right clicking on the Terminal Shadow branch of the Display Clients tree and selecting Add Display Client will launch the Display Client wizard for Terminal Shadow.

![Client Name Page of the Terminal Shadow Display Client Wizard](image)

Enter a name for the Terminal Shadow display client and select Next to continue.
The Display Client Options page of the Terminal Shadow Display Client wizard is the same as the Terminal Server Display Client wizard.

Select **Next** to continue.
The Terminal Shadow Display Client page of the Terminal Shadow Display Client wizard is unique. Leaving the **All Terminals Available** checkbox selected will add all of the terminals to the Shadow menu.

You can unselect the **All Terminals Available** checkbox and use the **Add** button to launch the **Select Terminal or Group** window to select specific terminals.

See Shadow a Specific Terminal.
10.2. **Shadow a Specific Terminal**

You can use the Terminal Shadow Display Client to shadow a specific terminal, duplicating the display to another thin client. This can be helpful to provide a worker access to his HMI in various places in a large station, like a commercial oven at a baking line.

Launch the Display Client wizard for Terminal Shadow by right clicking on the **Terminal Shadow** branch of the **Display Clients tree** and selecting **Add Display Client**.

![Client Name Page of the Terminal Shadow Display Client Wizard](image)

Enter a name for the display client in the **Client Name** field and select the **Next** button.
The Display Client Options page of the Terminal Shadow Display Client wizard is the same as the Terminal Server Display Client wizard.

Select **Next** to continue.
The Terminal Shadow Display Client page of the Terminal Shadow Display Client wizard is unique. Unselect the All Terminals Available checkbox and use the Add button to launch the Select Terminal or Group window to add specific terminals.
Select Terminal or Group Window

The **Select Terminal or Group** window allows you to select a single group or a terminal and add to the Shadow menu. Highlight your selection and click the **OK** button.

If you select a terminal you can repeat until you have selected all the terminals you want.
The selected Group or terminals will be displayed in the Terminal to Shadow frame.
You can allow the shadower to interact with the shadowed terminal by leaving the *Interactive Shadow* checkbox selected.
Unchecking the *Interactive Shadow* checkbox will allow the shadower to “look, but not touch.”
You can use the Screen to Shadow drop-down to control which screen of a MultiMonitor thin client you shadow.
Click the *Finish* button to complete the wizard.
10.3. **Shadow of the Terminal**

The Terminal Shadow display clients are added to the terminal like other display clients.

![Display Client Selection Page of the Terminal Configuration Wizard](image)

The Terminal Shadow display clients have an icon of a terminal and a monitor session.

Move the desired Terminal Shadow display clients to the *Selected Display Clients* list by double clicking on them or using the arrows on a highlighted display client.

Click the **Finish** button to save the configuration and restart the terminal to send the configuration to the terminal.
A Terminal Shadow Display Client with more than a single terminal will open with a **Select Terminal to Shadow** menu.

Highlight the terminal you want to shadow and select the **OK** button. You will connect to the terminal and display the screen from the shadowed thin client.

### 10.3.1. Display Client Group Selector During Shadow

The Terminal Shadow display client will be displayed in the Group Selector Menu of the terminal it is assigned. The group selector shows the local display clients assigned to the terminal.

![Select Terminal to Shadow](image)

#### Local Terminal Menu Selector

When the local Group Selector menu is shown the Group Selector of the remote terminal is hidden. If you want to use the remote terminal’s Group Selector you select **Hide** on the local Group Selector. This will hide the local selector and show the remote Group Selector.

![Local Terminal Menu Selector](image)

#### Remote Terminal Menu Selector

Once the remote group selector menu is used the local terminal will revert back to the local group selector.
The picture shows the Group Selector for both the local 1_PXE terminal and the remote 02_Logic terminals.
11. Content - Workstation Deployment

Microsoft built RDP into their workstation operating systems so that a permitted user can make a connection to a workstation and transfer the desktop session to another computer. This allows ThinManager to capture a session on a Windows XP Pro, Vista Pro, or Windows 7 computer and transfer it to a thin client. This is very helpful. It allows applications that aren't terminal services compliant to be run on a workstation but the user can receive the session on a hardened industrial thin client instead of a PC.

Transferring a workstation session to a thin client requires:

- Turning on the Remote transfer on the PC.
- Creating a Workstation Display Client.
- Applying the Workstation Display Client to a terminal..

The workstation can be a physical computer or a virtualized desktop.

11.1. Step 1 – On the PC

The workstation needs to have the Remote Desktop function enabled in Systems Properties.

Go to the workstation Control Panel and open the System Properties. It can also be opened by right clicking on My Computer and selecting Properties.

![System Properties](image)

*System Properties for XP Workstation*

Select the Allow users to connect remotely to the computer checkbox to enable remote connections.
The **Select Remote Users**... button opens a **Remote Desktop Users** window that allows you to specified authorized users.

![Remote Desktop Users Window](image1)

**Remote Desktop Users Window**

The **Remote Desktop Users** window shows the users authorized to connect to the computer to transfer the session.

Add users by selecting the **Add...** button that opens a **Select Users** window. This window allows you to pick the users to add and authorize.

![Select Users Window](image2)

**Select Users Window**

Add the desired users to the text box.

Use the **Check Names** button to validate.

Click **OK** to add the user.

Close all the windows to finish the tasks.
11.2. Step 2 – Workstation Display Client

You need to create a **Workstation Display Client** to act as a template for the workstations you want to transfer to a thin client.

Right click on the **Workstation branch** of the **Display Client** branch of the ThinManager tree and select **Add New Display Client**.

*Workstation Display Client Wizard*

The Workstation Display Client acts as a template for the behavior of the connected workstations.
The **Client Name Page** of the **Workstation Display Client** wizard is similar to other **Display Client Option** pages. Enter a unique name and select the **Next** button.
The Display Client Options Page of the Workstation Display Client wizard is similar to other Display Client Option pages except for the Start Virtual Machine if necessary checkbox. It is a good idea to check this checkbox.
The Terminal Services and Workstation Options page of the Workstation Display Client is similar to other display clients.

You can deploy the workstation as a desktop by leaving the Application Link checkbox unchecked.

You can deploy a specific application by checking the Application Link checkbox and specifying an application on the AppLink page.

**Note:** This function is not available with all workstation operating systems.
If you select the Application Link checkbox on the Display Client Options page you will need to enter the path of the desired application in the Program Path and Filename field on the AppLink page. This application will launch as the initial program instead of the desktop, locking the operator to a single application of your choosing.

**Note:** This function is not available with all workstation operating systems.

Select the Finish button to close the wizard.
ThinManager with Workstations in the Display Client Tree

The completed display clients will be displayed in the **Workstation** branch of the **Display Client** tree in ThinManager.
11.3. Adding the Workstation Display Client to the Terminal

Open the Terminal Configuration Wizard by double clicking on the terminal in the Terminal branch of the ThinManager tree.

Navigate to the Display Client Selection page.

The Workstation display clients can be added like the other display clients by moving them to the Selected Display Clients list on the Display Client Selection page of the Terminal Configuration Wizard.

If the workstation uses a different account then the terminal use the Override button to change the Windows account that is used for logging in.
Override Settings

The **Override** button on the Display Client Selection page will launch the **Override Settings** page. Check the **Override** checkbox in the Windows Login Settings frame and add the workstation’s correct user account to the **Username** and **Password** fields.

You may enter a Windows user account manually or use the **Search** button to pull a user account from the Active Directory as shown in Domain Member Terminal Server.

Click **OK** to accept.
Override Indicator

Display clients with an override will display a yellow plus sign on their icon.
Select the Next button to continue.
Complete the Workstation Display Client Configuration Page

The Workstation display client will show a new page, the Complete the Workstation Display Client Configuration page. This is where you add the workstation you want to transfer to the terminal.

There are two options, using a physical workstation or a VCenter virtual workstation.

Select the Add Workstation button to add a physical workstation.

Add Workstation Window

The Add Workstation window allows you specify a workstation by IP address and name.
Enter the IP address and name in the **Workstation IP Address** field and the **Workstation Display Name** field.

You may also use this to point to a virtual workstation. Just add the virtual machine’s IP address and name to the **Workstation IP Address** field and the **Workstation Display Name** field.

If your virtual machines are on a VCenter Server that is defined in ThinManager you can use the **Add Virtual Workstation** button.

The **Add Virtual Workstation** button opens an **Add Virtual Workstation** window that is populated by any VCenter Servers you have defined in ThinManager.

Select the VCenter Server in the **Select VCenter Server** dropdown.

Expand the VCenter tree.

Highlight the desired virtual workstation and click the **Add** button.

This will select the workstation.
Complete the Workstation Display Client Configuration Page

The workstation will be displayed in the *Selected Workstations* textbox on the *Complete the Workstation Display Client Configuration* page.

You can add a second workstation as a backup, if desired.

**Duplicate Workstation Warning**

Workstations can only have one connection to a remote user. They use a one-to-one model instead of the one-to-many model of terminal services.

ThinManager has an error check system that prevents a workstation from being deployed twice.
**Note:** A workstation can be added multiple times as a backup but only once as the primary workstation.

*XP Workstation on a Thin Client*

Once the Workstation Display Client is added to a terminal and the terminal is restarted the terminal will connect to the workstation and transfer the workstation display to the terminal.
12. Devices – Terminal Configuration

There are five types of terminals that can be used in a ThinManager system. They are:

- ThinManager Ready thin clients
- ThinManager Compatible thin client
- iTMC client for iOS iPads and iPhones
- WinTMC client for Windows PCs
- AndroidTMC for Android Devices

Adding a device is a two-step process. First the device needs to be pointed to the ThinManager Server to receive a configuration. The second step is to have a configuration created in ThinManager for the device to download.

We will cover the configuration of the device in ThinManager first then show how to connect each device to ThinManager second.
12.1. Terminal Configuration in ThinManager

The Terminal Configuration Wizard is launched from the Terminals branch of the ThinManager tree. Open the Terminals tree by selecting the Terminal icon at the bottom of the ThinManager tree.

![Terminal Branch of the ThinManager Tree](image)

Right click on the Terminals branch and select Add Terminal to launch the Terminal Configuration Wizard.
Enter a name for the terminal in the **Terminal Name** field. It should be 15 characters or less.

The **Description** button launches a **Terminal Description** window that allows you to add extra information about the terminal.

The **Terminal Description** field is handy to add extra information when the terminal names are industrialized, like **USP_MX10_L1_qty** or **Prod_TrayPkgShrkWrp_OIT**.

Select **OK** to close the Terminal Description window.
Select the **Next** button to configure the configuration.

**Terminal Hardware Page of the Terminal Configuration Wizard**

The Terminal Hardware page allows you to specify the make and model of the terminals you are adding. Use the correct Make and Model if you can. This allows you to configure the terminal to match the capabilities of the hardware you will be using.

**Note:** When a terminal connects to its configuration for the first time ThinManager will adjust the configuration to match the actual hardware used and not the pre-configured hardware selected to prevent errors. ThinManager will "dumb down" the configuration if needed. The default model, the ACP DC-40-100, is used because it has limited video resolutions that every modern terminal can use. If a different model is assigned to this configuration it may end up with the lower video resolutions.

ThinManager uses the MAC address (Media Access Control address) to identify the terminals. The Terminal ID will be automatically filled when hardware is associated with the configuration.
PXE Boot Configuration for ThinManager Compatible Thin Clients

PXE boot ThinManager Compatible thin clients need to be configured at Generic / PXE. You also need to configure the PXE Server in ThinManager by selecting Manage > PXE Server. See PXE Server and PXE Boot on page 193.
ThinManager has an Android application that allows the Android to run an RDP session that is controlled and managed by ThinManager. Select **GENERIC / Android Device** as the **Make** and **Model** of the client.
ThinManager has an iOS application that allows the iPad to run an RDP session that is controlled and managed by ThinManager. Select **Apple / iOS Device** as the **Make** and **Model** of the client.
**Hardware Configuration for WinTMC Clients**

ThinManager has a PC application that allow the PC to run an RDP session that is controlled and managed by ThinManager. Select **GENERIC / WinTMC** as the **Make** and **Model** of the client. Select the **Next** button to configure the configuration.
The Terminal Options page has a few settings of interest.

- **Allow replacement at terminal if offline** – This allows the terminal to show up in the replacement list during a new terminal connection.

- **Put Terminal in Admin Mode at Startup** – This turns the terminal on without showing the display clients. This is useful to use as the terminal to register HID cards or registering fingerprint scans.

- **Set Schedule** – This will allow the Schedule button to become active. See Scheduling on page 447.

- **Enable Terminal Effects** - This allows the desktops in MultiSession to slide smoothly into the desktop instead of appearing instantaneously.

- **Show terminal status messages** - This allows the terminal to display status messages in the upper left corner of the screen.

- **Allow terminal to be shadowed** – This dropdown sets the Shadowing setting allowing the configuration of Shadowing Options.
  - **No** – This will prevent the terminal from being shadowed by anyone.
  - **Ask** – This will ask the user to allow shadowing. The user will need to say **Yes** on a message window before the shadowing is allowed.
- Warn - Will display a message window alerting the terminal that it is to be shadowed, but doesn't require user input before the shadowing is allowed.
- Yes – Will allow shadowing to occur without warning or user input.

- **Allow Interactive Shadow** – This allows users with Shadowing permission to interactively shadow the terminal.

Select the *Next* button to configure the configuration.

---

**Terminal Mode Selection of the Terminal Configuration Wizard**

ThinManager uses **Display Clients** to deploy applications. Keeping the **Use Display Clients** checkbox allows you to use these. If you uncheck this checkbox you will lose other functions like MultiMonitor, TermSecure, MultiSession, and Instant Failover.

Select the *Next* button to configure the configuration.
Display Clients are assigned to the terminal on the **Display Client Selection** page.

The created display clients are in the left hand **Available Display Clients** list. Moving them to the right hand **Selected Display Clients** list will add the display client to the terminal configuration.

Select the **Next** button to configure the configuration.
Display Client Selection Page of the Terminal Configuration Wizard

Display clients can be moved by double clicking on them or by highlighting them and using the left and right arrows.

Adding two or more display clients is **MultiSession**. It gives you the ability to deploy applications from different servers with ease.

The **Override** button launches the **Override Settings** window that allows you to modify the login settings.
The **Override Settings** page allows you to change the user account used for logins, add a command line option, or change the resolution.

If you are in a domain you can use the **Search** button to pull a user account from the Active Directory. See Using Active Directory for Terminal Users on page 237.

Select the **OK** button to close the **Override Settings** window.

Select the **Next** button on the **Display Client Selection** page to configure the configuration.
A single display client needs no additional navigation on the terminal. If you have multiple display clients on the terminal you need to have a method to switch between the sessions. The **Terminal Interface Options** page and **Hotkey Configuration** page allow you to configure switching methods.

The mouse options for switching are:

- **Show Group Selector on Terminal** – This checkbox, if selected, will display an on-screen drop-down menu that can be activated by mouse.

- **Enable Tiling** – This checkbox, when selected, allows the Display Clients to be tiled on the monitor to provide an overview of all the sessions at once.

- **Screen Edge Group Selection** – This checkbox, if selected, will activate a feature that will switch windows if the mouse is moved to the edge of the screen.

The **Selector Options** button launches the **Group Selector Options** window that has the settings for switching between sessions when using MultiSession.
The **Group Selector** is hidden in the top center of the terminal screen and can be revealed by moving the mouse to the center of the top edge.

The Group Selector will remain visible if the **Auto-hide Selector** checkbox is unchecked.

Checking the **Tile on Selector activation** will put the **Tile Command** on the Group Selector.

The Group Selector font size can be adjusted with the **Selector Menu Size** dropdown.

Select the **OK** button to accept changes or the **Cancel** button to close.

The **Tiling Options** button launches the **Tile Options** window that has the settings for tiling sessions when using MultiSession.

The **Tile Options** window has several settings.

- **Show Grid** – This checkbox, when selected, will show the tiled sessions in a grid with each grid labeled with the session name as while the session is loading.

- **Tile Inactivity Time** – This field sets the length of time that the terminal screen will stay focused on a selected session before reverting back to a tiled state due to inactivity.

- **Tile Display Clients at startup** – This checkbox, when selected, will show the sessions tiled when the terminal first connects to its sessions.

- **Include Main Menu as tile** – This checkbox, when selected, will include a session displaying the TermSecure Main Menu.

- **Tile on right click (mouse or touchscreen)** - This checkbox, when selected, will initiate tiling when a session is right clicked.

- **Tile Interactive** – This checkbox, when selected, will allow a user to click into a tiled session and control it interactively without switching focus to a single session. To focus on a single session use the Group Selector Dropdown or the tiling hotkey (**CTL + T**), if enabled.
Select the OK button to accept changes or the Cancel button to close.
Select the Next button on the Terminal Interface Options page to configure the hotkeys.

Hotkey Configuration Page of the Terminal Configuration Wizard

Terminal Hotkeys on the Hotkey Configuration page allows the selection of keyboard combinations that allow switching between sessions.

- **Enable Instant Failover Hotkeys** - This checkbox, if selected, allows the hot key switching between the two active sessions of a Display Client that is using Instant Failover. The terminal needs to be using a display client with Instant Failover for this to be active.

- **Enable Group Hotkeys** - This checkbox, if selected, allows the hot key switching between different sessions of a terminal using MultiSession.

- **Enable Tiling Hotkey** – This checkbox, if selected, allows SessionTiling to be activated by a hotkey combination. Tiling has to be selected on the Terminal Interface Options page for this to be active.

Selecting the Change Hotkeys button when Enable Instant Failover Hotkeys is selected will allow the hotkeys to be changed from the default.
Select Hotkeys for Instant Failover

The default hotkey for Instant Failover switching is set to Control+F9. This can be changed by selecting the Alt Key radio button or using the drop-down to select another function key.

Select the OK button to accept changes or the Cancel button to close.

Selecting the Change Hotkeys button when Enable Group Hotkeys is selected will allow the MultiSession switching hotkeys to be changed from the default.

Select MultiSession Switching Hotkeys

The default hotkey for MultiSession switching is set to Control+Page Up and Control+Page Down. This can be changed by selecting the Alt Key radio button or using the drop-down to select another hot key.

Select the OK button to accept changes or the Cancel button to close.
Selecting the **Change Hotkeys** button when **Enable Tiling Hotkeys** is selected will allow the hotkeys to be changed from the default.

![Select Hotkeys](image)

The default hotkey for SessionTiling activation is set to **Control+t**. This can be changed by selecting the **Alt Key** radio button or using the drop-down to select another hot key.

Select the **OK** button to continue or the **Cancel** button to close without accepting changes.

Select the **Next** button on the **Hotkey Configuration** page to configure the configuration.
12.2. **User Accounts in the Terminal Configuration Wizard**

Each terminal needs a unique Windows account to start sessions on Windows Terminal Servers. These Windows accounts can be created locally on each Terminal Server or in an Active Directory for domain accounts using standard Windows procedures. You may apply Microsoft security as desired.

![Log In Information Page of the Terminal Configuration Wizard](image)

Leaving the *Windows Log In Information* fields blank will force the user to manually log into their sessions. This is useful for office settings or shared terminals. Each user logs in with their personal account and gets the privileges that the administrator granted them.
12.2.1. Local Windows User Accounts

Filling the *Windows Log In Information* fields with an established Windows account allows the terminal to automatically log in and start sessions without user action. This is useful in industrial settings where the terminals are public and running 24/7.

![Log In Information Page of the Terminal Configuration Wizard](image)

Enter a local Windows account in the *Username* field. Enter its password in the *Password* and *Verify Password* fields if you want to have the terminal automatically log in.

Leaving these fields blank will require the user to manually logon each time the terminal connects.

- Individual display clients can be set to require a manual login by unselecting the *Allow Auto-Login* checkbox on the *Terminal Services and Workstation Options* page of the *Display Client Wizard*.
- You may use a domain Windows account by adding the domain to the *Domain* field.
- Individual display clients can be set to use a different Windows account than the terminal by using the *Override* button on the *Display Client Selection* page of the *Terminal Configuration Wizard*.

Select the *Next* button to configure the configuration.
12.2.2. Active Directory User Login Account

A ThinManager Server in a domain may pull an Active Directory account into the **Username** field using the **Search** button. This launches a series of windows that allow you to select a domain user account for the terminal login account.

Selecting the **Search** button will launch a **Search for AD User** window that allows you to select an Active Directory user.

![Search for AD User Window](image)

The **Search for AD User** window has a **Location** button that allows you to search the Active Directory locations.

Select the **Locations**… button to launch the **Select AD Location to Search** window.
Select AD Location to Search Window

Continue with the wizard by selecting the branch of the Active Directory tree that contains your administrative user account. Highlight it and select the OK button.

Search for AD User Window

Highlighting an Active Directory branch in the Select AD Location to Search window and selecting the OK button will re-open the Search for AD User window with the list of domain users from that branch.
Highlight the desired user and select **OK**. This will add the domain user to the **Username** field of the Terminal Configuration Wizard.

![Terminal Configuration Wizard](image)

**Terminal Server Name - Terminal Server Wizard – Domain**

Once the domain user is in the **User Name** field of the Terminal Configuration Wizard you need to add the correct password to the **Password** field.

The **Verify** button will check the entered password and tell you if it is valid or incorrect. Once you have received a positive result select the **Next** button to continue with the wizard.

![Invalid Account Message](image)

**Invalid Account Message**

If you receive a message of an invalid account try the correct password.
Valid Password Message

Once you have a valid user account select the **Next** button to continue the configuration wizard.
Video Resolution of the Terminal Configuration Wizard

The Video Resolution page of the Terminal Configuration Wizard lets you choose the Resolution, Color Depth, and Refresh Rate for your monitor.

The resolutions in the dropdown are dependent on the make and model of hardware used.

Select the Next button to configure the configuration.
The **Mobile Device Options** window has several settings that control the user experience on mobile devices. It will only be displayed when configuring an Android or iPad terminal.

This page allows you to disable features normally displayed in the mobile apps.

**Toolbar Buttons**

- **Show Scan Data Button** – This checkbox, when unselected, will hide the Scan Data button.
- **Show Scan Resolver Button** – This checkbox, when unselected, will hide the Scan Resolver button.
- **Show User Login Button** – This checkbox, when unselected, will hide the User Login button.

**Sound Options**

- **Play Location Sounds** – This checkbox, when selected, will play a sound when a location is entered.
- **Play User Login Sounds** – This checkbox, when selected, will play a sound when the user logs in as a TermSecure or Relevance user.

**User Interface Settings**

- **Show Zoom Map** – This checkbox, when unselected, will hide the screen map while zooming.
- **Show Toolbar** – This checkbox, when unselected, will hide the app toolbar.
- **Allow Exit to ThinManager Server List** – This checkbox, when unselected, will prevent the user from leaving the app to switch ThinManager Servers.
Module Selection Page of the Terminal Configuration Wizard

Modules are components that provide additional functions to a terminal but aren’t required for the running the basic configuration.

Modules include touchscreen drivers, sound drivers, dual Ethernet port modules, USB drives, screen savers and other functions.

The Add… button launches the Attach Module to Terminal window.
The *Attach Module to Terminal* window allows you to select a module to add to the terminal. Select the *Next* button on the *Module Selection* page to configure the configuration.
The **ThinManager Server Monitor List** page is a legacy page from early versions of ThinManager and is not used.

This page was used before Auto-Synchronization was added to ThinManager. This page was needed to list the ThinManager Servers for the terminals. Auto-Synchronization does this automatically so the page will not show if using Auto-Synchronization.

This page was left to prevent problems when upgrading from an old ThinManager system to a modern one.

Select the **Next** button to configure the configuration.
The Monitoring Configuration page sets the speed that failover is detected and initiated. A thin client creates a socket connection to the terminal server. If the socket is disconnected the terminal will try to reconnect and failover based on these settings.

- The “Fast” setting is a good setting to use.

These are the settings in case you want to tweak your system.

- **Monitor Interval**
  - **Monitor Interval** (Fast/Medium/Slow) – These settings have a set rate for the frequency that the terminal server status is checked.
  - **Monitor Interval** (Custom) – This setting allows the administrator to change the settings from the defaults.

- **Monitor Interval** – This is the period of time the terminal will wait after losing the socket connection before it tries to reconnect.
- **Monitor Timeout** – This is the period of time the terminal will wait between tries.
- **Monitor Retry** – This is the number of times the terminal will try to reestablish a connection before failing over.
- **Primary Up Delay Multiplier** – This is a constant used to generate the Primary Up Delay time.
- **Primary Up Delay** - This is a delay added (usually set to 30 or 60 seconds) to allow a Terminal Server to get fully booted before the terminal will try to login. This time period is equal to the Monitoring Interval times the Primary Up Delay Multiplier. This prevents a terminal using Enforce Primary from switching back to its primary terminal server before it is ready.

Faster rates will cause a quicker failover but will check on terminal server status more often, causing more network traffic. Slowing down the rate will cause less traffic but will slow the failover speed a little.

Select **Finish** to save and close or **Cancel** to close without saving.

### 12.3. Copy Settings from another Terminal

You can copy the settings from one terminal during the creation process to speed the configuration.

Create a new terminal by right clicking on the Terminals branch and select **Add Terminal** to launch the *Terminal Configuration Wizard*.

The **Terminal Name** page has a **Copy Settings from another Terminal** checkbox. Select this checkbox and click the **Copy From** button to launch the **Select Terminal** window.
The **Select Terminal** window will show a tree with all of the created terminals. Highlight a terminal and click the **OK** button. This will close the window and apply the configuration from the highlighted terminal to the new terminal.

Select the **Next** button to navigate to the **Terminal Hardware** page.
Terminal Hardware page of the Terminal Configuration Wizard

The new terminal will need terminal hardware applied to it. You will need to select the hardware Make and Model before the Finish button is available. You should also check the Username and Password on the Login Information page since every terminal needs a unique Windows account for logging in.
12.4. Using Groups for Organization

ThinManager allows the consolidation of terminals into Terminal Groups. Groups can be used like folders to organize the terminals into functional or geographic groups. The **Group Setting** checkbox allows settings to be applied to all members of the group to speed configuration and change deployment.

Any group setting is passed down to its members.

The **Group Terminal Configuration Wizard** is launched from the **Terminals** branch of the ThinManager tree.

Open the **Terminals** tree by selecting the **Terminal** icon at the bottom of the ThinManager tree.

![Add Group Command](image)

**Add Group Command**

Right click on the Terminals branch and select **Add Group** to launch the **Group Terminal Configuration Wizard**.

The wizard for the Group parallels the Terminal Configuration Wizard since the group is a collection of terminals.

A group can be used as a folder to group and organize terminals.
Add Group Menu

You can create sub-groups by highlighting a group, right clicking, and selecting **Add Group**. It will add a group under the selected group.
A terminal can be added to a group by clicking the **Change Group** button to launch the **Select Terminal Group** window.
The **Select Terminal Group** window will list the groups and subgroups. Expand the tree as needed, highlight the desired group, and select the **OK** button.

The terminal will be assigned to the selected group.

Select the **Finish** button to close the wizard and apply the changes before continuing. If you need to adjust the configuration, close the wizard then re-open it.
Group Membership

The Terminal Configuration Wizard will show the group in the Terminal Group field. The Terminals tree will show the terminal nested in the group.
12.4.1. Moving Out of a Group

A terminal can be removed from a group by moving it to the Terminals branch of the Select Terminal Group window.

Double click on the terminal you want to change by double clicking on it in the Terminals tree to launch the Terminal Configuration Wizard.

![Terminal Configuration Wizard](image)

Change Group Button on the Terminal Name Page

A terminal can be removed from a group by clicking the Change Group button to launch the Select Terminal Group window.
Select Terminal Group Window

Select the top level **Terminals** in the Terminal Group tree. This will move the terminal from a group to the terminals.

Select the **OK** button to finish.

Select the **Finish** button to close the **Terminal Configuration Wizard** and apply the changes before continuing. If you need to adjust the configuration, close the wizard then re-open it.
Once the wizard is closed the ThinManager Terminals tree will show the terminal under the **Terminals** branch and the **Terminal Group** field of the **Terminal Name** page will be empty.
12.5. Using Groups for Configuration

ThinManager Terminal Groups can be used for configuration. Every setting in the Group Configuration Wizard has a Group Setting checkbox. If this is checked the setting will be applied to every member of the group.

This speeds configuration as you only have to make a configuration change once to have it deployed to all the terminals in the group.

This picture shows the Line_1 group has two terminals with a single display clients assigned. Adding display clients is easy when using Group Settings. You open the Group Configuration Wizard, navigate to the Display Client Selection page, change the selected display clients, and then restart the terminals.
This picture shows that the Line_1 group had its group display clients changed once and the change was propagated to all of the member terminals.

The following section will show the **Group Configuration Wizard** on the left and the **Terminal Configuration Wizard** of a member terminal on the right to show the effects of using the **Group Setting** checkbox.
The left shows the opening screen of the **Group Configuration Wizard**. The right shows the **Terminal Configuration Wizard**. The Group will not show the **Terminal Hardware** page since that is an individual selection, not a group selection. The terminal will show the Terminal Hardware page to allow you to select the hardware for the individual device.

The **Group Configuration** on the left has had the **Group Settings** selected. The terminal on the right has the settings grayed out because it is inheriting the **Group Settings**.
**Group Terminal Mode Selection**

*Use MultiMonitor* is shown on the Terminal Configuration Wizard on the right because that is based on the hardware selected and not the group membership.

**Group Display Client Selection**

Selecting display clients on the Group Configuration Wizard and checking the Group Setting checkbox will assign those display clients to all member terminals. You cannot add or subtract from the list on the terminal.

This is great when all members of a group run the same applications. If they need different applications then leave the Group Setting unchecked and assign the display clients individually.
The **Group Configuration** on the left has had the **Group Settings** selected.
The terminal on the right has the settings grayed out because it is inheriting the **Group Settings**.

The **Group Configuration** on the left has had the **Group Settings** selected.
The terminal on the right has the settings grayed out because it is inheriting the **Group Settings**.
Group Video Resolution    Terminal Video Resolution

The video resolution can be applied to all members of a group. However, if you have to add a different sized monitor in an emergency you would have to uncheck the Group Settings and apply the resolutions individually.

Since switching monitors is a task that almost anyone might be able to do it might be better to set the video resolutions individually.
WinTMC Settings

The **Group Configuration Wizard** will have a **WinTMC Settings** page to allow WinTMC clients to be configured with **Group Settings**.

This page will not show up on the **Terminal Configuration Wizard** unless the terminal had **GENERIC/WinTMC** selected as the **Make** and **Model** on the **Terminal Hardware** page.

Mobile Device Group Options

The **Group Configuration Wizard** will have a **Mobile Device Group Options** page to allow mobile clients to be configured with **Group Settings**.

This page will not show up on the **Terminal Configuration Wizard** unless the terminal has **GENERIC/Android Device** or **Apple/iOS** selected as the **Make** and **Model** on the **Terminal Hardware** page.
Modules can be added at the group level and at the terminal level. Modules selected for a group will display a Group icon on the Module Selection page of its members.

The picture on the left shows a module added to the group configuration.

The picture on the right shows that module on the terminal with the Group icon to show where is originated from. The USB touch screen module was added to the terminal and won’t show a group icon.

The Group Configuration on the left has had the Group Settings selected.

The terminal on the right has the settings grayed out because it is inheriting the Group Settings.
12.5.1. Deleting Old Groups

An unneeded group can be deleted by right clicking on the group and selecting **Delete**.

![Delete Option on Group Right Click Menu](image)

Selecting **Delete** will launch a dialog box for deletion.

![Delete Dialog Box](image)

The **Delete dialog** has two options.

Selecting **Yes** will delete the group **AND** the member terminals.

Selecting **No** will delete the group but leave the terminals under the Terminals tree.

Selecting **Cancel** will close the dialog without deletion.
Read the dialog box before clicking to prevent the loss of needed terminals.

The terminals from Line_1 are now nested under the Terminals branch of the tree.

**Note:** The two terminals from the Line_1 group are showing the Alert icon indicating that they need to be restarted to load the changed configurations.
13. Devices – IP Configuration

There are four types of terminals that can be used in a ThinManager system. They are:

- ThinManager Ready thin clients
- ThinManager Compatible thin client
- WinTMC client for Windows PCs
- iTMC client for iOS iPads and iPhones

Each has a different method of connecting to ThinManager to receive its configuration.

A ThinManager Ready thin client is shipped from the factory with the ACP BIOS onboard. A ThinManager Ready thin client requires two things to connect to the ThinManager system:

- An IP Address for the client
- The ThinManager Server Address to retrieve the needed boot file and configuration

A ThinManager Ready thin client can use DHCP or static for the client and ThinManager Server IP address. Its BIOS will instruct it to download the firmware.

A ThinManager Compatible thin client is a common off-the-shelf thin client that lacks the ACP BIOS. ThinManager Compatible thin clients do not store static IP addresses so each of them require DHCP (Dynamic Host Configuration Protocol) to assign the client IP address. The ThinManager Server IP address and bootfile name can be provided by a DHCP server, or by the ThinManager PXE Server.

A ThinManager Compatible thin client requires three things to connect to the ThinManager system:

- PXE Boot enabled in ThinManager
- An IP Address for the client
- The ThinManager Server Address to retrieve the needed boot file

The WinTMC client is a ThinManager client that runs on a Windows operating system and provides a centrally managed connection to the terminal server.

Each client PC requires two things to connect to the ThinManager system:

- The installation of the WinTMC program
- The IP address of the ThinManager Server

The iTMC client is a ThinManager client that runs on an Apple iOS operating system and provides a centrally managed connection to the terminal server.

Each iPad requires three things to connect to the ThinManager system:

- The installation of the iTMC program from the Apple App Store
- Membership on the ThinManager Server network
- The IP address of the ThinManager Server
13.1. ThinManager Ready Thin Client IP Configuration

13.1.1. DHCP

A ThinManager Ready thin client is shipped from the factory set to use DHCP (Dynamic Host Configuration Protocol).

When the terminal is turned on it will display a screen telling you to press any key to enter the IP Configuration menu.

![IP Configuration Prompt Page]

Press the space bar to open the menu.

![IP Configuration Menu Page]

The ThinManager Ready thin clients uses DHCP out of the box.

DHCP passes out IP addresses but the thin client also needs the IP address of the ThinManager Server. This can be provided by the DHCP server using Option 066, Boot Server Host Name.
Microsoft DHCP Server

Option 066 provides the Boot Server Host Name. Enter the IP address of the ThinManager Server in the Option 066 field to have the DHCP server send this to the ThinManager Ready thin clients.

PCs and laptops that use DHCP will ignore this setting.

13.1.2. Static IP Addressing.

Most models of ThinManager Ready thin clients allow the usage of static IPs. These are set on the IP Configuration Menu.

Open the IP Configuration Menu by selecting any key at the IP Configuration Prompt page.
Press the **A** to allow the client IP to change from DHCP to static by assigning a static IP address to the terminal.

Type in the static IP address for the client, including the separating periods and press the **Enter** key.

Once the Terminal has a static IP assigned, the IP Configuration Menu will be shown to allow the setting of other values.

- **(A) Terminal IP Address** - This should be a unique address for the terminal.
- **(B) Primary ThinManager Server IP Address** - This should be the unique address for your main ThinManager Server.
- **(C) Secondary ThinManager Server IP Address** - The Secondary ThinManager field allows the terminal to use two ThinManager Servers. If the terminal cannot connect to the Primary ThinManager Server, it will connect to the Secondary ThinManager Server to receive its configuration. If you are not using a Secondary ThinManager Server, set the IP address to 0.0.0.0.
- **(D) Router IP Address** - Fill in the IP address of the router or gateway if one is being used. If not this should be set to 0.0.0.0.
- **(E) Subnet Mask** - Set this to your subnet mask. 255.255.255.0 is a standard setting.
- **(F) Password Status** - Allows a password to be set to prevent unauthorized people from changing the configuration.

**Note:** Forgetting this password is a bad thing.

- **(G) Load Default Values** – This resets the ThinManager Ready thin client to the original IP values.
- **(H) Help** - Will launch a Help to explain the IP Configuration Menu.
- **(Q) Abort Changes and Exit** - This will cancel any setting changes and let the terminal continue to boot with the old settings.
- **(S) Save Changes and Exit** - This will apply any changes and allow the terminal to continue to boot with the new settings.

Type the letter of the desired setting and type the IP address, with periods. Press the **Enter** key on the keyboard to accept each change.
13.1.3. Hybrid IP Addressing

ThinManager Ready thin clients with Boot Loader 5.01 and later can use DHCP to assign the terminal IP address, but can assign the ThinManager Server IP address as a static IP in the IP Configuration Menu. Boot your thin client and press the spacebar when prompted on the IP Configuration Prompt page. This will open the IP Configuration Menu.

Boot Loader Default Values
Select the B key to add a static IP for the ThinManager Server. Type the numbers and periods for the address.

DHCP with Static ThinManager Server
Once a ThinManager Server is assigned, selecting C will allow a redundant secondary ThinManager Server to be assigned. Select S to save the changes and allow the connection to the ThinManager Server. The terminal will now boot using DHCP.

Note: The Escape key will let you exit the entry field and return to the IP Configuration Menu.
13.1.4. Firmware Download

Once the ThinManager Ready thin client is configured, the terminal will connect to the ThinManager Server and download the firmware and configuration.

Firmware Download

If the static IP address for the terminal is a duplicate of another IP address on the network, it will display an error message instead of downloading the firmware.

Duplicate IP Address Error

A terminal with this error message needs to be rebooted and the IP address corrected.
13.2. Adding and Configuring Thin Clients

13.2.1. Connect and Start Wizard

Turning on a terminal for the first time will initiate the Create New Terminal mode if:

- No terminals are defined in ThinManager, or
- All the defined terminals are currently connected, or
- All the defined terminals that are turned off have the Allow This Terminal To Be Replaced If Off Line check box unselected.

Create New Terminal Mode Screen

When a terminal enters the Create New Terminal Mode, the terminal will launch the Terminal Configuration Wizard on the ThinManager Server. The terminal will display a screen indicating that it will wait until the configuration is finished before progressing further.

13.2.2. Pre-configure and Select Configuration

Turning on a terminal for the first time will initiate the Replace or Create New Terminal Mode if one or more of the defined terminals are offline and they have the Allow This Terminal To Be Replaced If Off Line check box selected.

Replace or Create Mode

The screen will display all the offline terminals that the terminal can replace. Groups will be displayed, requiring a drill down to the desired terminal. Highlight the desired terminal name using the keyboard and press the Enter button. The terminal will retrieve the selected configuration and assume its identity.
If a terminal has previously connected to ThinManager and received its configuration, rebooting it will not give it a choice of configurations, but will apply its normal configuration.

13.3. PXE Server and PXE Boot

A ThinManager Ready thin client is shipped from the factory with the ACP BIOS onboard. A ThinManager Ready thin client can use DHCP or static for the client IP address and the ThinManager Server IP address. Its BIOS will instruct it to download the firmware.

A ThinManager Compatible thin client is a common off-the-shelf thin client that lacks the ACP BIOS. ThinManager Compatible thin clients do not store static IP addresses so each of them require DHCP (Dynamic Host Configuration Protocol) to assign the client IP address. The ThinManager Server IP address and bootfile name can be provided by a DHCP server, or by the ThinManager PXE Server.

A ThinManager Compatible thin client requires three things to connect to the ThinManager system:

- An IP Address for the device.
- The ThinManager Server Address to retrieve the needed boot file.
- The Boot File name.

13.3.1. PXE Server Modes

There are three modes or methods that a ThinManager Compatible thin client can use to receive this information.

Using standard DHCP server

This mode will allow the client to use an existing DHCP server to provide the client IP address while the ThinManager PXE server will provide the ThinManager IP and boot file name.

Using standard DHCP server with Boot Options

This mode allows the DHCP server to provide all the information needed. It will use Option 066 to provide the ThinManager IP and will use Option 067 to provide the boot file name in addition to the client IP address.

Not using standard DHCP Server

This gives ThinManager the power to provide all the necessary information, including client IP addresses.

ThinManager Compatible Thin Client IP Sources

<table>
<thead>
<tr>
<th>Device IP</th>
<th>ThinManager IP</th>
<th>Boot File Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using Standard DHCP</td>
<td>DHCP Server</td>
<td>ThinManager</td>
</tr>
<tr>
<td>DHCP with Boot Options</td>
<td>DHCP Server</td>
<td>DHCP Option 066</td>
</tr>
<tr>
<td>Not Using Standard DHCP</td>
<td>ThinManager</td>
<td>ThinManager</td>
</tr>
</tbody>
</table>
13.3.2. Using standard DHCP server

The Using standard DHCP server mode is used when you have an existing DHCP server in your system to pass out the IP addresses.

Select Manage > PXE Server to open the PXE Server Wizard.

PXE Server Configuration Wizard

Select the Enable PXE Server checkbox on the PXE Server Configuration page.

Select Next to continue with the wizard.
The **Network Interface Configuration** page allows you to select the network interface if the ThinManager Server has multiple network cards.
A synchronized ThinManager Server will have a dropdown for the network interface on both ThinManager Servers.

The easiest method of PXE boot is if you have an existing DHCP server. Select the **Using standard DHCP server** radio button and click **Finish**.

The PXE server will initialize and become active.
The ThinManager Compatible thin client will make a request for the DHCP and PXE information when it is turned on. The DHCP server will respond with the client IP address. The ThinManager will respond with the PXE boot information and the thin client will connect to ThinManager.
13.3.3. Using standard DHCP server with Boot Options

The Using standard DHCP server mode is used when you have an existing DHCP server and want it to provide all the information.

On the DHCP Server:
Open the Microsoft DHCP Service by selecting Start > Administrative Tools > Computer Management on your Microsoft DHCP server.

![Microsoft 2012 Server DHCP Scope Options](image)

Right click on the Scope Options in the Scope tree and select Configure Options.

Scroll to Option 066 Boot Server Host Name, check the check box, and enter the IP address of the ThinManager Server in the String Value field. If you use a redundant pair of ThinManager Servers enter both IP addresses separated by a space.

Scroll to Option 067 Bootfile Name, check the check box, and enter "acpboot.bin" in the String Value field.

Configuring a DHCP to provide IP addresses, the ThinManager Server IP address as Option 066, and the acpboot.bin bootfile as Option 067 will allow the DHCP server to provide the boot information to both ThinManager Ready thin clients using the default DHCP and ThinManager Compatible thin clients using PXE boot.
In ThinManager:

Select **Manage > PXE Server** to open the **PXE Server Wizard**.
Select the **Enable PXE Server** checkbox on the **PXE Server Configuration** page.
Select **Next** to continue with the wizard.

![PXE Server Wizard](image)

**Network Interface Configuration Page of PXE Server Configuration**

Select the **Using standard DHCP server with Boot Options** radio button on the Network Interface Configuration page.

Select the **Finish** button and the PXE server is configured.

The ThinManager Compatible thin client will make a DHCP request when it is turned on. The DHCP server will respond with the client IP address, the ThinManager address, and the name of the bootfile to download. The ThinManager Compatible thin client will connect to ThinManager.
13.3.4. Not using standard DHCP server

The Not using standard DHCP server mode is used when you do not have an existing DHCP server. This mode is configured to give ThinManager the ability to pass all the information needed to boot.

In ThinManager:

Select Manage > PXE Server to open the PXE Server Wizard.
Select the Enable PXE Server checkbox on the PXE Server Configuration page.

Select the Not using standard DHCP radio button on the Network Interface Configuration page.
Select the Next button to navigate to the IP Address Range Configuration page.
The ThinManager Server needs to have a range of IP addresses added so that it can give the ThinManager Compatible thin client their IP addresses. This is done on the IP Address Range Configuration page.

Select the Add button on the IP Address Range Configuration page to launch the IP Address Range window.
Enter the first IP address of the range in the **Starting IP Address** fields.

Enter the last IP address of the range in the **Ending IP Address** fields.

You may also configure the Subnet Mask and add the IP address for a router.

If you are done select the **OK** button to set the range and close the **IP Address Range** window.

If you want to add an **Exclusion** select the **Exclusion** button to open the **Exclusions** window.
13.3.5. Exclusions

Exclusions, IP addresses not to be assigned, can be configured by selecting the Exclusions button to launch the Exclusions window.

Exclusions Window and Exclusion Range Window

Select the Add button on the IP Address Range Configuration page to launch the IP Address Range window.

Select the Exclusions button to launch the Exclusion window.

Select the Add button to launch the Exclusion Range window.

Enter the range of IP addresses to exclude from assignment by putting the first and last IP address in the Exclusion Start IP Address and Exclusion Stop IP Address fields and click the OK button.

If you are excluding a single IP address then enter it in the Exclusion Start IP Address field and click the OK button.

If you are done select the OK button to set the range and close the Exclusion window.

If you want to add a Reservation close the Exclusion window and select the Reservation button to open the Reservations window.
13.3.6. Reservations

Reservations allows you to assign a specific IP address to a thin client each time it boots. This can be done in the PXE Server or in the Terminal Configuration Wizard.

13.3.7. Reservations in the PXE Server:

Select the Add button on the IP Address Range Configuration page to launch the IP Address Range window.

Select the Reservations button to launch the Reservations window.

Select the Add button to launch the Reservation window.

![Reservation Window in the PXE Server](image)

Reservation Window in the PXE Server

Enter the MAC address from the ThinManager Compatible thin client in the Hardware Address (MAC) field. Enter a secondary MAC if it has two NICs. These are often on the serial number label.

Enter the IP address you want to assign to it in the IP Address fields and click the OK button.
The IP address range will be displayed when you close the IP Address Range window.

**Note:** The ThinManager PXE server is not a true DHCP server. It will only issue IP addresses to PXE boot devices. It will not assign IP addresses to other computers, laptops, or devices.

### 13.3.1. Reservations in the Terminal Configuration Wizard

ThinManager has an easy way to reserve IP addresses for PXE boot thin clients.

- Turn on the device and associate it with a configuration.
- Turn off the device so the terminal icon in the tree is red.
- Open the Terminal Configuration Wizard and assign the IP address on the Terminal Hardware page.
- Restart the device.
Original Assigned IP Address

This picture shows the original IP address.

Turn off the device. You cannot change the IP address of a terminal that is turned on.
Edit Terminal ID Window

Double click on a turned off terminal in the ThinManager tree to open the Terminal Configuration Wizard.

Navigate to the Terminal Hardware page and click the Edit button to launch the Edit Terminal ID page. It will only be active on terminals that are off.

Check the Statically assign IP address checkbox. This allows you to set a static IP reservation.

Select OK to close the Edit Terminal ID page and the Finish button to close the Terminal Configuration Wizard.
Newly Assigned IP Address

Restart the terminal. It will now be assigned the new IP address.

Note: An advantage of using ThinManager to assign IP addresses is that if you do a replacement, the replacement terminal will be assigned that reserved IP address.
13.4. Local WinTMC Configuration

WinTMC is a PC application that allows ThinManager to manage the RDP connections between the PC and terminal servers. It also provides enhanced features lacking in standard RDP connections like failover and Instant Failover.

The WinTMC needs installed on the PC then it needs to be configured to point to ThinManager to receive its configuration.

When WinTMC starts, a **Configure** button will be displayed on the splash screen.

![WinTMC Splash Screen](image)

Click on the **Configure** button to specify the ThinManager Server(s) to use.
WinTMC ThinManager Server List Configuration

The ThinManager Server List allows the WinTMC to be pointed to one or more ThinManager Servers to retrieve its configuration.

Enter the IP address or name of your ThinManager Servers in the **Enter new ThinManager Server Name or IP Address** field and click the **Add** button to add them to the Current ThinManager Servers list.

The WinTMC will try to connect to the ThinManager Servers in the order listed, so the order can be changed with the **Move Up** and **Move Down** buttons.

Unneeded ThinManager Servers can be removed with the **Delete** button.

This configuration menu can be password protected by selecting the **Set Password** button. Once the password is set, when WinTMC is started and the Configure button is clicked, a password will be required to change the configuration.

If the **OK** button is selected without entering a ThinManager Server, an error window will remind you to enter a ThinManager Server address.

Once the local configuration is set, WinTMC will connect to a ThinManager Server and attempt to retrieve its configuration.
If the WinTMC PC has not been defined, the user will be prompted with a dialog box to allow for the creating a new configuration or replacing an existing terminal configuration on the ThinManager Server. This functionality is similar to that of the create/replacement menu on a Thin Client. Select the thin client configuration you want to assume. Once the WinTMC has been assigned a configuration you will not need to make a selection again.
13.5. **WinTMC Configuration in ThinManager**

If you want to pre-create a WinTMC client in ThinManager using the Terminal Configuration Wizard, select **GENERIC** for the **Make/OEM** and **WinTMC** for the **Model** on the **Terminal Hardware** page of the Terminal Configuration Wizard.

The **Terminal ID** will fill in with the name of the PC once the WinTMC client is tied to a PC.

The **Terminal Configuration Wizard** for a WinTMC client is the same as for a thin client with a few exceptions. These include the **Video Resolution** page and the **WinTMC Settings** page.
The Video Mode for WinTMC includes a setting for **FullScreen**. This will fill whatever resolution the PC client is running.

You may also select from set resolutions.

**Note:** WinTMC running on computers with multiple monitors can run as MultiMonitor WinTMC clients.
The Terminal Configuration Wizard includes a WinTMC Settings page for WinTMC clients. These only apply to connections made by the WinTMC application.

The settings include:

**Redirect Local Resources:**

- **Redirect Serial Ports** - This checkbox, if selected, will make local serial ports available in a session. Serial Port redirection does not work when you connect to a terminal server running Windows 2000 or earlier.

- **Redirect Drives** - This checkbox, if selected, will make local drives available in a session. Drive redirection does not work when you connect to a terminal server running Windows 2000 or earlier.

- **Redirect Printers** - This checkbox, if selected, will make your local printer available in a session.

- **Redirect Sound** - This checkbox, if selected, will allow audio played in your session to play locally. Sound redirection does not work when you connect to a terminal server running Windows 2000 or earlier.

- **Redirect Smart Cards** - This checkbox, if selected, will make your smart card available in a session. Smart card redirection does not work when you connect to a terminal server running Windows 2000 or earlier.
Client Control Settings:

- **Allow Client to be closed** - This checkbox, if selected, will enable your user to close the client (WinTMC program).
- **Allow client to be sized** - This checkbox, if selected, will enable your user to resize the client.
- **Always maintain monitor connection** – Enable this setting to keep the monitoring connection active when WinTMC is closed to allow shadowing. Unselecting this checkbox will release the WinTMC license when the WinTMC program is closed but will deny shadow access.
- **Show groups in separate windows** – This checkbox, if selected, will display multiple Display Clients as separate windows rather than in one window shell.

Experience Settings:

- **Show Desktop Background** - This checkbox, if selected, will enable your user to select a Windows Desktop Background. If not selected, the background will be a solid color.
- **Show window contents while dragging** - This checkbox, if selected, will show the window contents to be shown while the window is being dragged.
- **Show menu/window animations** - This checkbox, if selected, will enable menu/window animations on the client.
- **Show Themes** - This checkbox, if selected, will enable your user to select a Windows Theme.

**Note:** These functions may be denied by user policies or terminal server configuration. Check the Microsoft Local Policy, Group Policy, and Terminal Services Configuration. See Non-ThinManager Components for details.
13.5.1. MultiMonitor WinTMC

ThinManager supports MultiMonitor for WinTMC if the PC has Windows running on multiple video cards. If the PC is successfully running multiple monitors on the host OS then WinTMC can run MultiMonitor using up to five monitors.

![MultiMonitor - Enable MultiMonitor](image)

Selecting the **Enable MultiMonitor** checkbox on the **Terminal Mode Selection** page will allow you to configure a WinTMC client for MultiMonitor use.

MultiMonitor requires the use of Display Clients. Once the **Use Display Clients** checkbox is selected on the **Terminal Mode Selection** page the **Enable MultiMonitor** checkbox becomes visible.

Select the **Use Display Clients** and the **Enable MultiMonitor** checkboxes, and then select the **Next** button.

The Terminal Configuration Wizard will display the **MultiMonitor Video Settings** page, **Monitor Layout** page, and **Display Client Selection** page like it does for thin clients. See MultiMonitor for details.

13.5.2. WinTMC Modules

WinTMC clients cannot use the ThinManager modules because they are running Windows locally. One must install touch drivers, sound drivers, printers, and etc. through the local Windows operating system instead of relying on ThinManager modules.
14. Devices – Mobile Devices
ThinManager supports Apple iPads, Apple iPhones, and Android devices.

Apple iPad 2 is supported but Bluetooth requires iPad 4.

Currently we support Android 4.0 and higher. That includes Ice Cream Sandwich (4.0), Jelly Bean (4.1-
4.3), KitKat (4.4) and Lollipop (5.0-5.1). However, Bluetooth Beacons and iBeacons are only supported on
4.4 and higher. This is a limitation in the OS, not our app.

14.1. Configuring an iPad in ThinManager
A configuration needs to be created in ThinManager so that the mobile device can join the system as a
terminal.

Open ThinManager and select the Terminal icon to show the Terminal branch of the tree.

Right click on the Terminals branch and select Add Terminal to launch the Terminal Configuration
wizard.
Enter the name for your mobile device and select **Next**.

**Terminal Hardware Page**

Select **Apple / iOS** for the make and model of hardware.

Navigate to the **Terminal Mode Selection** page by clicking **Next**.

Complete the wizard as you would for any other thin client.
14.1.1. Configuring an iPad for ThinManager

The iPad needs to have the iTMC client installed. The iTMC application can be downloaded from the Apple App Store for free.

Go to the Apple App Store.
Enter ThinManager in the search field.
Select the iTMC application and select Open. It will download and install on your iPad.
The ThinManager app shown on the left is the ThinManager Mobile app that lets you control ThinManager from a mobile device.
Select the **Settings** button at the bottom to launch the **Settings** page.

**Settings Page**

Select *New Configuration* to launch the New Configuration page.
New Configuration Page

Enter your ThinManager Server name from your Station Sheet in the Configuration Description field.

Enter the IP address of the ThinServers (usually the ThinManager Server) in the Primary ThinServer IP field.

Enter the IP address of a secondary ThinManager Server, if you have one.

Select the Save button in the corner. This will return you to the Settings page.

Select the Configurations button in the top left corner to return to the configurations screen.
14.1.2. Associating the iPad to the Configuration

Once the ThinManager Server is defined on the iPad you need to associate the hardware to the iTMC configuration you created.

*Defined ThinManager Servers*

The defined ThinManager Server will be displayed on the configuration screen.

Select the ThinManager Server. You will be connected to that ThinManager Server.
Pick Replacement

A **Pick Replacement** window will be shown allowing you to select the newly created terminal configuration or to launch the Terminal Configuration Wizard by selecting **Create New Terminal**.

Touch your newly defined terminal to choose the configuration you created for the iPad.

iTMC Client Session

Once the iTMC client connects it will launch the display client assigned in ThinManager.
Configurations with MultiSession, using more than one display client will allow you to minimize the display client and switch display clients using a finger swipe.
14.2. Configuring an Android Device in ThinManager

A configuration needs to be created in ThinManager so that the mobile device can join the system as a terminal.

Open ThinManager and select the Terminal icon to show the Terminal branch of the tree.

![ThinManager Terminal Configuration Wizard](image)

Right click on the Terminals branch and select **Add Terminal** to launch the **Terminal Configuration wizard**.

Enter the name for your mobile device and select **Next**.
Terminal Hardware Page

Select *Generic / Android Device* for the make and model of hardware.

Navigate to the *Terminal Mode Selection* page by clicking *Next*.

Complete the wizard as you would for any other thin client.
14.2.1. Configuring an Android for ThinManager

The Android device needs to have the AndroidTMC client installed. The AndroidTMC application can be downloaded from the ThinManager Download page at http://downloads.thinmanager.com/.

![Android ThinManager Compatible thin client on an Android Desktop]

The AndroidTMC program is launched from an icon on the desktop.

The first action will be to define the ThinManager Server.

![Add ThinManager Server Window]

The Add ThinManager Server window will launch with fields for the ThinManager Server name and IP address.
Enter **ThinManager** in the Title field and the IP address of the Primary and Secondary ThinManager Server in the **Primary** and **Secondary** address field and select **Done**. If you have only one ThinManager Server you will need to select the **Next** button to cycle to the **Done** button.

**Add ThinManager Server Window**

Select the Add button and the AndroidTMC app has your ThinManager Server listed.

### 14.2.2. Associating the Android Device to the Configuration

Once the ThinManager Server is defined on the iPad you need to associate the hardware to the iTMC configuration you created.

**AndroidTMC Start Screen**

The AndroidTMC Start Screen will show the registered ThinManager Server. Touch the ThinManager Server to connect.
Connecting Status

The AndroidTMC will connect to the ThinManager Server.

Select a Terminal to Replace

Once the AndroidTMC had connected to the ThinManager Server you will get the Select a Terminal to Replace window. You may choose an existing terminal configuration or you may choose Create New Terminal. If you choose Create New Terminal then a Terminal Configuration Wizard will launch on the ThinManager Server that will let you configure the AndroidTMC as a new terminal.
AndroidTMC Client

Once connected the Android device will display the applications assigned in ThinManager.
15.  Active Directory and ThinManager Users

ThinManager 8.0 adds Active Directory integration to make user management easier. It is not full active directory integration in the sense that there is still configuration for each user stored in the ThinManager database. However, you can automatically synchronize AD users with the ThinManager database. Users added to AD will be added to the ThinManager tree, users deleted from AD will be removed from the ThinManager tree.

You can

- Reference domain user account information in the Terminal Configuration Wizard
- Reference domain user account information in the Terminal Server login.
- Use domain accounts as TermSecure User accounts.

The ability to Reference domain accounts into TermSecure gives the administrator quite a few powerful tools.

- You can import a single Windows Security Group or multiple OU organizational units.
- You can convert pre-existing TermSecure accounts to domain accounts.
- You can manage and update passwords from ThinManager.

For handling AD passwords there are two basic modes for TermSecure users:

- No password stored. In this mode ThinManager does not keep/store the AD users password. The user is prompted to enter the password when needed.
- ThinManager maintains password. ThinManager can store the AD password, and manage the password. This means that ThinManager will generate a new password and rotate the password in AD when necessary. This allows you to conform to your standard password policy and still use the account with ThinManager.
Use of the Active Directory tools requires:

- ThinManager 8 or later
- The ThinManager Server (ThinServer) must be on a domain computer
- The ThinManager Server user does not need to be a domain administrator. They do need to know the password for any account they reference. Certain actions may require a domain administrator login to complete.

Selecting **Manage > Manage Accounts** from the menu will open the **Manage Active Directory Accounts** window. It will be empty until you reference user accounts from the Active Directory.
15.1. Using Active Directory for Terminal Server Account

The Windows login for the terminal is integrated with Active Directory on the Log In Information page of the Terminal Configuration Wizard.

To reference an Active Directory account, select the Search button by the User Name field. This will launch the Search for AD User window.
Search for AD User Window

The Search for AD User Window has a **Locations** button that allows you to search sections of the Active Directory tree by launching a **Select AD Location to Search** window.

Select AD Location to Search Window

Highlight the desired AD branch and select the **OK** button.
Search for AD User Window

Highlighting an AD location on the Select AD Location to Search window will enter the location in the Search for AD User window.

Select the Search button to populate the Search for AD User window.

Select a user account from the Active Directory accounts and select the OK button to add them to the User Name field on the Terminal Server Name page.
The **Terminal Server Name** page has a Password field. Enter the password for the AD user account and select the **Verify** button.

If the password is incorrect a message will be displayed saying that the account is not valid.
Account Verify Dialog

If the password is correct a message will be displayed saying that the account is valid. You may proceed at this point.

Terminal Server Name Page

This shows the result of adding an Active Directory account as the administrative user for a Terminal Server.
15.2. Using Active Directory for Terminal Users

The Windows login for the terminal is integrated with Active Directory on the Log In Information page of the Terminal Configuration Wizard.

The Log In Information page has Search, Verify, and Password Options buttons. The Search button will open will open the Search for AD User window.
Search for AD User window allows you to reference users from the Active Directory. Click the *Locations…* button to choose where to select users.

Select AD Location to Search window shows the available locations to search. Highlight the domain branch you want to use and select the *OK* button.
Highlighting the domain branch you want to use and select the **OK** button will add the Location for the search.

Selecting the **Search** button will fetch the user accounts and populate the **Search for AD User** window.

Highlight the domain user you want and select the **OK** button. This will reference the user for the terminal log in account.
Highlighting the domain user you want and selecting the **OK** button will load the domain user into the **Username** field of the **Log In Information** window of the **Terminal Configuration Wizard**.

You can enter the password and select the **Verify** button to check its accuracy.

If the password is incorrect a message will be displayed saying that the account is not valid.
Account Verify Dialog

If the password is correct a message will be displayed saying that the account is valid. You may proceed at this point.

Terminal Server Name Page

This shows the result of adding an Active Directory account as the user account of a terminal.
15.3. Password and Account Management

ThinManager has tools to manage domain accounts and passwords.

15.3.1. Active Directory - Manage Accounts Management

The first tool is the Manage Accounts tool.

Selecting Manage > Manage Accounts will launch the Manage Active Directory Accounts window. It lists all the AD user accounts that have been referenced in ThinManager.

Double click on an account to launch the Password Maintenance Options window.
The **Password Maintenance Options** window allows you to have ThinManager manage the password for the account.

Check the **Allow ThinManager to manage password** checkbox to add this account to the list of managed accounts.
Once the **Allow ThinManager to manage password** checkbox is checked you can use the system defaults or uncheck the **Use System Default Password Settings** to customize the password settings.

The password settings include:

**Password Complexity Requirements:**

- **Minimum Password Length** – This is the minimum number of characters a password may have.
- **Maximum Password Length** – This is the maximum number of characters a password may have.

**Password Maintenance:**

- **Rotate Password every** – This is the number of days before the password must be changed.

Select the **OK** button to accept the changes or select the **Cancel** button to close the dialog without saving.
Once the **Allow ThinManager to manage password** checkbox is checked then the account will be displayed as a managed account.
15.3.2. **Active Directory – Convert Accounts**

Domain accounts that were used in previous versions of ThinManager can be converted to a managed account with the *Convert* function.

*Legacy Domain Log In*

This shows a domain account that was entered in an earlier version of ThinManager that didn't have Active Directory integration.
Open the **Manage Active Directory Accounts** window by selecting **Manage > Manage Accounts**. Highlight the legacy account and select the **Convert** button.

This will launch the **Convert Accounts to Managed Accounts** window.

Highlight the legacy account and select the **Convert** button.
Manage Active Directory Accounts Window

The Manage Active Directory Accounts Window will show that the account is now managed by ThinManager.

Double click on a legacy domain account to launch the Password Maintenance Options window for that account.

Password Maintenance Options Window

Once the Allow ThinManager to manage password checkbox is checked you can use the system defaults or uncheck the Use System Default Password Settings to customize the password settings.

The password settings include
Password Complexity Requirements:

- **Minimum Password Length** – This is the minimum number of characters a password may have.
- **Maximum Password Length** – This is the maximum number of characters a password may have.

Password Maintenance:

- **Rotate Password every** – This is the number of days before the password must be changed.

**Re-synch Account Button** – This will launch the Synchronize Active Directory Account window that allows you to re-synchronize the password in ThinManager with the password in the Active Directory.

Select the **OK** button to accept the changes or select the **Cancel** button to close the dialog without saving.

Selecting the **Re-synch Account** button will launch the Synchronize Active Directory Account window.

![Synchronize Active Directory Account](image)

Synchronizing the Active Directory account requires a Domain Administrator password. Enter domain admin credentials.

You can have the ThinManager program automatically create a password by checking the Auto-Generate Password checkbox.

You can create a password of your choosing by un-checking the Auto-Generate Password checkbox and entering the password in the New Password field.

Select the **OK** button to synchronize the password or select the **Cancel** button to close the dialog without saving.
Password Reset Dialog

A dialog box will acknowledge a successful synchronization.
15.3.3. **Active Directory - Synchronize Password**

Selecting *Manage > Synchronize Passwords* will launch the **Synchronize Active Directory Passwords** window.

![Synchronize Active Directory Passwords Window](image)

This allows the synchronization of passwords for many accounts at once.
This action requires a Domain Administrator account.

Enter the credentials in the appropriate fields.
Synchronizing Passwords Window

The selected accounts will have their passwords synchronized between ThinManager and the Active Directory.
15.3.4. Active Directory - Settings

Selecting Manage > Settings (Active Directory) will launch the Active Directory System Settings window.

![Active Directory System Settings](image)

The Settings (Active Directory) button launches the Active Directory System Settings window. This has the settings for the passwords. They include:

**Active Directory Default Password Settings**

- **Password Change Interval** – This is the number of days before the password must be changed.
- **Minimum Password Length** – This is the minimum number of characters a password may have.
- **Maximum Password Length** – This is the maximum number of characters a password may have.

**Active Directory Synchronization Mode**

- **Choose AD Synchronization Mode** – This is used when batch creating TermSecure Users. You may generate users from one Windows Security Group or multiple Organizational Units.
- **Synchronize every X Minutes** – This is how often that ThinManager will synchronize with the Active Directory. Password communication is encrypted for security.
- **Start Sync Now** – This will manually start the synchronization between the ThinManager Server and the Active Directory.
16. TermSecure Overview

TermSecure is a ThinManager feature that allows users to use a ThinManager Ready thin client to access user-specific or terminal-specific Display Clients. This does not replace the Windows logon, but adds an additional layer of security and control to the Window login.

16.1. TermSecure Functions

TermSecure has two main functions, hiding applications from unauthorized users and deploying applications to a user at any location.

- SecureAccess or Permission Deployed Applications: You can assign a display client to a terminal and keep it hidden from operators with Permissions. A user with the proper TermSecure credentials will be able to reveal and access the hidden application. An example would be a recipe program that would allow a supervisor to initiate a product change. This belongs to the station on the floor but you want to prevent users from initiating the change.

- SmartContext or User-specific Applications: You can assign Display Clients to a TermSecure user and they can get access to it from any terminal in the system. This can be initiated by either manual login or the use of an authentication device. This allows a user to leave one terminal, logon to a different terminal, and reconnect to their session, essentially having the session follow him from terminal to terminal. An example would assign a session with reports to a quality control worker who could login anywhere and retrieve their reports.

SecureAccess or Permission Deployed Applications are controlled with Permissions. This is covered in Using Access Group Permissions on page 299.

SmartContext or User-specific Applications are controlled by adding the Display Client to the TermSecure User configuration. This is covered in Using TermSecure to Provide Roaming Applications on page 318.

16.2. User Accounts in TermSecure

TermSecure has three user account strategies.

- The application can belong to the terminal and TermSecure is used to grant access to the application assigned to the terminal. The TermSecure account doesn’t need to tie to a Windows account.

- The applications can be assigned to a specific user who needs to use their Windows account to access their applications. The TermSecure account is created to match the user’s Windows account.

- The applications can be assigned to a specific user. Instead of the Windows account matching the TermSecure account, the TermSecure User is assigned a different aliased Windows account to hide the credentials from the user.

The user accounts will be covered in TermSecure Users on page 266.
16.3. Deploying TermSecure Quick List

TermSecure may require a number of steps to configure and deploy:

- TermSecure Access Groups can be created to use Permissions (optional).
- Terminals can be assigned TermSecure Access Groups to limit access to specific users (optional).
- Display Clients can be assigned TermSecure Access Groups to limit access to specific users (optional).
- TermSecure Users need to be created (required).
- TermSecure Users can be assigned to TermSecure Access Groups (optional).
- A Login strategy needs to be put in place. The TermSecure User can use the Terminal Login, a TermSecure login, or a Windows login to access the terminal servers (required).
- USB drives and ProxCards, if used, need to have the identification number entered in their configuration (optional).
- The TermSecure User can then login to a ThinManager Ready thin client using TermSecure. TermSecure prompts the TermSecure User to login to the terminal servers using a Windows User account, or it will pass the pre-configured Windows User account information to the terminal server for auto-login, based on the login strategy selected.
- The TermSecure User is granted access to all Display Clients that share the same TermSecure Access as the TermSecure User, and is denied access to Display Clients that they don’t share a TermSecure Access Group membership.
16.4. TermSecure User Configuration Wizard

This section will show the TermSecure User Configuration Wizard that allows you to create and configure TermSecure Users.

Open the TermSecure User tree by clicking on the TermSecure User icon at the bottom of the ThinManager tree.

TermSecure User Tree

Right click on the TermSecure Users branch of the ThinManager tree and select the Add User command to open the TermSecure User Configuration Wizard.

The first page of the TermSecure User Configuration Wizard is the TermSecure User Information page that creates the TermSecure User account.
Selecting the **Active Directory User** checkbox allows you to draw the user account from the Active Directory. See Create the TermSecure User using Active Directory on page 272.

Unselecting the **Active Directory User** checkbox allows you to create a TermSecure User with a different name than its Windows account. See Create the TermSecure User with a Non-Domain Windows Account on page 270.

Select the **Next** button to continue the wizard.
You can tie a TermSecure User to a HID card and validate with a card scan or you can associate a user fingerprint to the account and have a fingerprint scan validate the user.

These methods are covered in Card Readers and Fingerprint Scanners on page 335.

Select the **Next** button to continue.
Display Client Selection Window

The Display Client Selection window has one setting, Add User-specific Display Clients?

- If No is selected for Add User-specific Display Clients? then the user will only be able to access display clients that belong to the terminal they log in to. This is used with Permissions to grant access to applications hidden with Access Group Permissions.

- If Yes is selected for Add User-specific Display Clients? then the user can be assigned display client of their own that they can access from any terminal that has TermSecure enabled. You may also assign the user Permissions to let them access hidden applications.

Select the Next button to continue.
The **Display Client Specification** page allows Display Clients to be assigned to the TermSecure User if the **Add User specific Display Clients?** radio button is set to **Yes**.

Move a Display Client you want the TermSecure User to use into the **Selected Display Clients** list by double-clicking on it in the **Available Display Clients** list or by highlighting it and clicking the **Right Arrow** button.

To add a new Display Client, select the **Edit Display Clients** button to launch the Display Client Wizard. See Display Client List for details.

Select the **Next** button to continue.
The **Terminal Interface Options** page sets the menus and hotkeys for the TermSecure User so a terminal using MultiSession will need to have a method to switch between sessions. This is similar to the page in the Terminal Configuration Wizard.

**Group Selector Options** allow on-screen switching of sessions.

**Use Terminal Settings** - This checkbox, when selected, will let the TermSecure User inherit the properties that were configured for use with the terminal.

- **Show Group Selector on Terminal** - This checkbox, if selected, will display an on-screen drop-down menu that can be activated by mouse.
- **Enable Tiling** - This checkbox, if selected, allows the sessions to be tiled so that the user can make a visual selection of the desired selection.
- **Screen Edge Group Selection** - This checkbox, if selected, will activate a feature that will switch windows if the mouse is moved off screen.
- **Selector Options** - This button, if selected, will launch the **Group Selector Options** window.
- **Tiling Options** - This button, if selected, will launch the **Tile Options** window.

The **Main Menu Options** button will launch the **Main Menu Options** window that allows configuration of the TermSecure Main Menu.

Select the **Next** button to continue.
Terminal Hotkeys on the Hotkey Configuration page allows the selection of keyboard combinations that allow switching between sessions. This is similar to the page in the Terminal Configuration Wizard.

**Use Terminal Settings** - This checkbox, when selected, will let the TermSecure User inherit the properties that were configured for use with the terminal. If unselected the user receives the settings as configured for them.

- **Enable Instant Failover Hotkeys** - This checkbox, if selected, allows the hot key switching between the two active sessions of a Display Client that is using Instant Failover.

- **Enable Group Hotkeys** - This checkbox, if selected, allows the hot key switching between different sessions of a terminal using MultiSession.

- **Enable Tiling Hotkey** – This checkbox, if selected, allows SessionTiling to be activated by a hotkey combination.

Selecting the **Change Hotkeys** button when **Enable Instant Failover Hotkeys** is selected will allow the hotkeys to be changed from the default.

Select the **Next** button to continue.
The User Options page has a few options for the user experience.

Log In / Log Out Options

- **Inactivity Timeout** - TermSecure will log a TermSecure User off the terminal after this much inactive time has passed.
- **Reset Sessions at Logout** - This checkbox, if selected, will logoff a session when the TermSecure User logs off.
- **Activate User Group at Log In** - This checkbox, if selected, will display the TermSecure User's first Display Client when the user logs in to the terminal.

User Schedule

- **Set Schedule** -

Selecting the **Schedule** button on the User Options page will launch the Event Schedule window and allow a schedule to be created for terminal events.

See Terminal Schedule for details.

Terminal Effects

- **Enable Terminal Effects** - This allows the use of Terminal Effects. This currently includes sliding Windows and message rollups.
Shadowing

- **Allow terminal to be shadowed** - This drop-down box allows the configuration of Shadowing Options.
  - **No** - Prevents the TermSecure Users from being shadowed.
  - **Ask** - Will display a message window that will prompt for a positive response before the shadowing is allowed.
  - **Warn** - Will display a message window alerting the terminal that it is to be shadowed, but doesn’t require a positive response before the shadowing is allowed.
  - **Yes** - Allows shadowing to occur without warning or recipient input.

- **Allow Interactive Shadow** - This checkbox, if selected, will allow members with Interactive Shadow privileges to shadow this TermSecure User.

Shadowing is initiated from the Shadow tab on the Details pane of the ThinManager program. Unselecting this will prevent shadowing from within ThinManager.

Select **Finish** to finish the configuration.

Select the **Finish** button to accept the changes.
17. TermSecure Users Accounts

TermSecure User accounts may grant the user access to a restricted program or may give a user a program session that follows them from terminal to terminal. The terminal will not display restricted applications until an appropriate TermSecure User has logged in.

There are several methods of TermSecure User creation.

- Users can be created without being tied to a Window account. They are assigned membership in an Access Group. This gives them a Permission level to access display clients that are hidden by Access Groups.
- Users can be created and tied to non-domain Windows user accounts.
- Users can be created from Active Directory user accounts.

**Note:** TermSecure Users need to be associated with a Windows account if they are to access a display client that is assigned to them and not the terminal.

Using Access Groups and Permissions to control application access is discussed in Using Access Group Permissions on page 299.

Assigning specific applications to an individual TermSecure User is discussed in Using TermSecure to Provide Roaming Applications on page 318.

Creating a TermSecure User who is not a member of a domain is discussed in Create the TermSecure User with a Non-Domain on page 270.

Using Active Directory to create TermSecure User accounts will be discussed in Create the TermSecure User using Active Directory on page 272.

Create the TermSecure User using Active Directory on page 272 contains the entire TermSecure User wizard.

Using Card Readers with TermSecure Users is covered in Card and Badge Configuration for a TermSecure User on page 335.

Using Fingerprint Scanners for TermSecure Users is covered in Fingerprint Reader on page 351.
17.1. TermSecure User without Windows Accounts

If the TermSecure User is only accessing Terminal-specific display clients and not launching display clients of their own then the TermSecure User does not need to be tied to a Windows account.

Open the TermSecure User tree by clicking on the TermSecure User icon at the bottom of the ThinManager tree.

![TermSecure User Tree](image)

Right click on the TermSecure Users branch of the ThinManager tree and select the Add User command to open the TermSecure User Configuration Wizard.
The TermSecure User Configuration Wizard allows a TermSecure User to be created and configured. If the TermSecure User is only accessing Terminal-specific display clients and not launching display clients of their own then the TermSecure User does not need to be tied to a Windows account. Uncheck the Active Directory User checkbox.

Enter a user name in the User Name field.

Select the Permission button to launch the Permission window.

**Note:** The full description of the TermSecure User Configuration Wizard is described in TermSecure User Configuration Wizard on page 257.
Permissions Window

Add your TermSecure Access Group to your created user by double clicking on the Access Group in the **Available** text box to move it to the **Member Of** list.

Select the **OK** button to accept the changes.

These are the only settings needed for a TermSecure User to unlock hidden applications, a TermSecure User name and membership in a TermSecure Access Group. The wizard has other settings that will be described in TermSecure User Configuration Wizard on page 257.
17.2. Create the TermSecure User with a Non-Domain Windows Account

The first page of the TermSecure User Configuration Wizard is the TermSecure User Information page that creates the TermSecure User account.

TermSecure User Information Page

To create a TermSecure User that is not an Active Directory user you first uncheck the Active Directory User checkbox.

Enter a name in the User Name field.

Enter a password in the Password and Verify Password fields.

**Note:** This is not a Windows account but is a TermSecure account to be used within ThinManager.

Select the Permissions button to launch the Permissions window.
Add your TermSecure Access Group to your created user by double clicking on the Access Group in the Available text box to move it to the Member Of list.

Select the OK button to accept the changes.

These are the only settings needed for a TermSecure User to unlock hidden applications, a TermSecure User name and membership in a TermSecure Access Group. The wizard has other settings that will be described in the next section.

**Note:** The full description of the TermSecure User Configuration Wizard is described in TermSecure User Configuration Wizard on page 257.
17.3. **Create the TermSecure User using Active Directory**

ThinManager Active Directory integration allows a TermSecure User to have its Windows user account drawn from the Active Directory. You allow ThinManager to store the password to streamline password management.

The first page of the **TermSecure User Configuration Wizard** is the **TermSecure User Information** page that creates the TermSecure User account.

Selecting the **Active Directory User** checkbox allows you to draw the user account from the Active Directory.

Select the **Search** button to begin the Active Directory process by launching the **Search for AD User** window.

**TermSecure User Information**

Selecting the **Active Directory User** checkbox allows you to draw the user account from the Active Directory.

Select the **Search** button to begin the Active Directory process by launching the **Search for AD User** window.
Select the Locations button on the Search for AD User window to choose a location. This will launch the **Select AD Location to Search** window.

Highlight the AD location you want to select the user from and select the **OK** button. This will enter the location into the **Locations** field in the **Search for AD User** window.
Search for AD User Window – Location Selected

Once the Location has been selected click the **Search** button to populate the user field with users from the highlighted location.

Search for AD User Window – Users

Highlight the desired user account from the Active Directory members and select the **OK** button. This will enter the user account in the **AD User Name** field of the **TermSecure User Information** page.
TermSecure User Information Window

This shows an Active Directory user in the AD User Name field.

Select the Permission button to apply membership in Access Groups as shown in Using Access Group Permissions to Deploy Apps on page 299.

Select the Finish button if you only need a Permission applied.

Select the Next button if you want to apply user-specific display clients.
The Active Directory Password page has an Allow ThinManager to store password checkbox. If this is unchecked then ThinManager does not store the account and you must enter a password each time the session logs on. This is fine if you are logging in with a TermSecure password anyhow.

If the Allow ThinManager to store password checkbox is checked then you can have the Windows password stored in ThinManager. This allows a fingerprint scan to send the Windows password automatically for authentication.

If the Allow ThinManager to store password checkbox is checked you can use the system defaults or uncheck the Use System Default Password Settings to customize the password settings.

The password settings include:

**Password Complexity Requirements:**

- **Minimum Password Length** – This is the minimum number of characters a password may have.
- **Maximum Password Length** – This is the maximum number of characters a password may have.

**Password Maintenance:**

- **Rotate Password every** – This is the number of days before the password must be changed.

Enter a the user password in the Password field and select the Verify button.
Account Verify Dialog - Fail

Selecting the **Verify** button will check your password against the Active Directory. If it is incorrect it will show a failed dialog.

Account Verify Dialog - Pass

If the password is correct the dialog will show a positive result.

The rest of the TermSecure User Configuration Wizard follows the instructions in TermSecure User Configuration Wizard on page 257.
17.4. **TermSecure Groups**

TermSecure Users can be organized into TermSecure User Groups, just as Terminals can be organized into Terminal Groups. This section will show the configuration of a TermSecure User Group.

The **TermSecure Users Group Configuration Wizard** can be launched by right clicking on the TermSecure Users branch of the tree and selecting *Add TermSecure User Group*.

---

**Add User Group Command**

TermSecure User Groups are defined using the **TermSecure User Configuration Wizard**. It is launched by selecting the **User icon** at the bottom of the ThinManager tree, right clicking on the **TermSecure User** branch, and selecting *Add User Group*. 
The **TermSecure User Group**, like the **Terminal Group**, has a **Group Setting** checkbox. Selecting the **Group Setting** checkbox will apply the setting to all members of the group.

The **Permission** button allows you to apply permissions to the group.
Permissions Window

Highlight the desired permission and move it to the **Member Of** list to add.

Highlight the group and check the **Also apply to users in group** checkbox to apply the permission to all group members.

Click the **OK** button to close and apply.

Select **Next** on the **TermSecure User Group Information** page to go to the **Display Client Selection** page.
Select **Yes** to specify Display Clients for this user.

Select **Next** to go to the **Display Client Specification** page.
ThinManager User Information

Select the display clients for the group and move them to the **Selected Display Clients** list by double clicking on them.

Select the **Group Settings** checkbox.

Select **Next** to continue the group configuration.
The **Windows Log In Information** page has a **Group Setting** checkbox for the **Use Terminal Configuration Login Information** checkbox and **Same as TermSecure User username/password** checkbox.

The **Username** and **Password** fields are inactive because every user needs a unique Windows account and so a group setting isn't allowed.

The rest of the wizard follows the **TermSecure User Configuration** wizard. Select the **Next** button to continue or select the **Finish** button to close and save the settings.

**Note:** Any member of this group will receive the Group Settings. Change a Group Setting will change that Group Setting for all members.
17.5. Shortcut Method of Adding TermSecure Access Groups

Members can be added to TermSecure Access Groups quickly through the TermSecure Access Group Wizard.

Open the TermSecure Access Group Wizard by selecting Manage> Access Groups from the ThinManager menu.

This will launch the Access Groups window.

TermSecure Access groups can be added, deleted, or edited by highlighting the access group and selecting the appropriate button.

Highlight the desired TermSecure Access Group and select the Edit button.

Select the Edit Members button to launch the Access Group Members window.
Select the **Terminals**, **Display Clients**, or **TermSecure Users** radio button to configure that category and select the **Add** button.

**Select Terminal Window**

A **Select** window will be displayed with a tree of the configured terminals and terminal groups. Select the desired TermSecure User and select **OK** for each addition.
The **Access Group Members** window will show the members of the **TermSecure Access Group**. These can be removed by highlighting and selecting the **Remove** button.

Display Clients and TermSecure Users can be added by the same process of adding.
17.6. Adding a TermSecure User to a TermSecure User Group

TermSecure Users can be added to the TermSecure Group.
Create a new TermSecure User by right clicking on the TermSecure Users branch in the ThinManager tree and select the Add TermSecure User option.

TermSecure User Information Page

Enter a name for the TermSecure User in the User Name field.
Select the Change Group button.
This will launch the Choose User Group window.
Choose User Group Window

Highlight your TermSecure Users Group and select OK to close the window and accept the changes.
The TermSecure User Group will now be displayed in the Group field. Select the Finish button to accept the configuration.
Group Membership

Once a TermSecure User has joined a group it will be displayed in the tree under the group.
17.7. Batch Create TermSecure Users using Active Directory OU

You can create TermSecure Users in a batch, either by selecting one Windows Security Group or multiple Active Directory organizational units (OU).

You can select multiple OUs but only one Security Group because a user can only reside in one OU but they can be members in multiple Security Groups. Limiting to a single Security Group prevent duplicate accounts.

Active Directory System Settings

Select Manage > Active Directory Settings to launch the Active Directory System Settings window.
Select either **Organizational Unit** or **Security Group** in the **Choose AD Synchronization Mode** dropdown.

This manual will show the batch creation of TermSecure Users using Active Directory Organizational Units.

Select **OK** to close.
Add User Group Command

TermSecure User Groups are defined using the TermSecure User Configuration Wizard. It is launched by selecting the User icon at the bottom of the ThinManager tree, right clicking on the TermSecure User branch, and selecting Add User Group.

This will launch the TermSecure User Configuration Wizard for the TermSecure User Group.
Check the \textit{AD Synchronization Group} checkbox on the TermSecure User Group Information page. This will change the \textit{User Name} field to an \textit{Organizational Unit} field.

Select the \textit{Search} button to launch the Select AD Location to Search window.
The Select AD Location to Search window will list the Organizational Units for the domain that the ThinManager Server is a member. Highlight the desired Organizational Unit and select the OK button.

This will name the TermSecure User Group after the Organizational Unit. Select Next.
Group Settings

Once a TermSecure User Group is created a **Group Setting** checkbox appears on each page. Selecting this checkbox will apply the setting to all members of the group. This speeds configuration by having a change applied to all members at once.

You may select **Finish** now or select **Next** to complete the entire wizard.
Once the Finish button is selected the TermSecure User Group will be created. It may take some time to populate the TermSecure User Group depending on the Active Directory size.

Once populated all members of the Organizational Unit will show up as members of the TermSecure User Group.

Users added to AD will be added to the ThinManager tree, users deleted from AD will be removed from the ThinManager tree.
TermSecure User Group Created but Not Populated

One way to see if the users are created is to monitor the Total Users count by highlighting the TermSecure User branch in the ThinManager tree.

When the TermSecure User group is first created it won’t have an expansion box and the user count won’t have increased.

TermSecure User Group Created and Populated

Once ThinManager has imported the TermSecure Users the user count will increase and the expansion box will appear.
18. Using Access Group Permissions to Deploy Apps

SecureAccess provides terminal-specific Applications. This allows you to assign an application to a terminal and hide it with permissions. It will only be revealed when a user logs in with the appropriate permission set.

Steps:

- Create a TermSecure Access Group
- Add the Access group to a Display Client
- Configure a terminal for TermSecure
- Create a TermSecure User and apply TermSecure Access Group permissions
- Login and log out of TermSecure

These steps are best illustrated in an example. This section will use these for demonstration:

<table>
<thead>
<tr>
<th>TermSecure Access Group</th>
<th>Display Client</th>
<th>TermSecure User</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maintenance</td>
<td>Form01</td>
<td>Mike, Matt, Bob</td>
</tr>
<tr>
<td>Supervisor</td>
<td>Form02</td>
<td>Steve, Sam, Bob</td>
</tr>
</tbody>
</table>

18.1. Create Access Group

TermSecure Access Groups are created in the Access Group window. Open it by selecting Manage>Access Groups from the ThinManager menu.

The Access Group window shows the default Access Groups. Select the Add button to open the Access Group window.
Access Group Popup

Enter the name of the Access Group you wish to add. **Maintenance** is used in this example. Select the **OK** button to add the group.

Access Groups Window

The **Access Groups** window will show the added TermSecure Access Groups.


TermSecure Access Groups can be created using Windows Security Groups. Open the **Access Group** window by selecting **Manage>Access Groups** from the ThinManager menu.

The **Access Groups** window shows the default Access Groups.

Select the **Add** button on the **Access Groups** window to launch the **Access Group** window.
The **Access Group** window has a **Select Windows Security Group** button that launches the **Select AD Locations to Search** window.

The **Select AD Location to Search** window will be displayed.

Select the **Users** group and expand the tree.
Select AD Locations to Search

The Windows User Groups will be shown once the **Users** branch is expanded. Select a Windows Group to add as a ThinManager Access Group and select the **OK** button.

Access Groups

The Windows User Group will be added to the ThinManager Access Groups.
18.2. Add Access Group to a Display Client

You need to add the Access Group to the Display Client that you want to hide from un-authorized users. This example will use Form1 and Form02.

Double click on the desired display client in the ThinManager tree to launch the Display Client Wizard.

![Client Name Page of the Terminal Configuration Wizard](image)

Select the Permissions button on the Client Name page to open the Permissions window.
Display clients are members of the **Unrestricted** group by default.

Remove **Unrestricted** from the **Member Of** list by highlighting it and selecting the **left arrow** or double clicking.

**New Group Membership**

Add the desired **Access Group** to the **Member Of** list by highlighting it and selecting the **right arrow** or double clicking. A display client can have several TermSecure Access Groups added to it.

The **Permissions** window will show the TermSecure Access Group membership.

Select the **OK** button to accept the change.

Select the **Finish** button to close the **Display Client Wizard** and accept the changes.
Display Client Configuration Properties

You can see TermSecure membership quickly by highlighting the display client in the Display Client tree and selecting the Configuration tab. The TermSecure Access Group membership is at the bottom. This was repeated to assign Supervisors to Form02 for this example.
18.3. Configure Terminals for TermSecure

Each terminal can be configured to allow TermSecure logins. Double-click on a terminal in the ThinManager tree to open the Terminal Configuration Wizard.

Default Terminal Permissions

Terminals are members of the Unrestricted Access Group by default. This allows any user to use the terminal. Leave it this way unless you want to require a TermSecure login to allow any access at all. TermSecure Access is configured on the Terminal Mode Selection window.
Select the **Enable TermSecure** checkbox to enable TermSecure logins on the terminal.

**Note:** You must use Display Clients with TermSecure.

Select **Next** and navigate to the **Display Client Selection** page.
Display Client Selection

Add the display clients to the terminal. In this example HMI_1 is Unrestricted, Form01 is restricted to Maintenance, and Form02 is restricted to Supervisors.

Select Next and navigate to the Terminal Interface Options page.
When *Enable TermSecure* is selected on the **Terminal Mode Selection** page, a **Main Menu Options** button will be displayed on the **Terminal Interface Options** page.

The **Main Menu Options** configures the **TermSecure Login Menu**.

Select the **Main Menu Options** button to launch the **Main Menu Options** window.

- The **Allow reboot/restart** checkbox will add **Reboot** and **Restart** to the menu.
- The **Show Main Menu on Selector** checkbox will add the **TermSecure Main Menu** to the Display Client drop-down selector.
- The **Show Virtual Keyboard** checkbox will show a virtual keyboard to the login process.
  - Use the Show Virtual Keyboard to display an on screen keyboard for touch screens.

Select the **OK** button to accept the changes.

Select **Next** on the **Terminal Interface Options** page to navigate to the **Hotkey Configuration** page.
When **Enable TermSecure** is selected on the **Terminal Mode Selection** page, an **Enable Main Menu Hotkey** checkbox is displayed on the Hotkey Configuration page. This allows you to set a keyboard hotkey to launch the TermSecure menu.

Select **Finish** to apply the changes.

Reboot the terminal after changes are made.
18.4. TermSecure Results

This example has the following created:

<table>
<thead>
<tr>
<th>TermSecure Access Group</th>
<th>Display Client</th>
<th>TermSecure User</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maintenance</td>
<td>Form01</td>
<td>Mike, Matt, Bob</td>
</tr>
<tr>
<td>Supervisor</td>
<td>Form02</td>
<td>Steve, Sam, Bob</td>
</tr>
</tbody>
</table>

The 02_Terminal and 04_Terminal are using TermSecure with the unrestricted HMI_1 display client and the restricted Form01 and Form02 display clients.

ThinManager Shadow of Thin Client Example

The example shows the ThinManager tree and the shadowed display of the thin client.

- The Terminal tree shows three display clients assigned to 4_Terminal. The lightning bolt indicator for the hidden display clients are red to show that it doesn’t have a connection. Only HMI_1 is visible on the terminal because it is unrestricted.
- The picture shows the group selector in the shadow and displays the “public” display client in the selector, along with the option to launch the Main Menu.
18.5. Logging On to TermSecure

To log in a TermSecure User on a terminal, go to a terminal that has the Enable TermSecure checkbox selected on the Terminal Mode Specification page.

You can log in by:

- Opening the display client selector drop-down and selecting Main Menu.
- Typing the CTL+m hotkey to launch the Main Menu if the hotkey checkbox was selected.

The Main Menu will be displayed on the terminal.

Select the Log In button to login.

A virtual keyboard will be displayed if Show Virtual Keyboard was selected on the Main Menu Options window when configuring the terminal for TermSecure on the Terminal Interface Options page.
Enter your TermSecure User name in the **Enter User Name** field. Select **OK**.

Enter the password in the field. Select the **OK** button.
ThinManager with TermSecure Log On

The example shows Matt logged in to the terminal.

Notice that the Terminal displays the name of the TermSecure User in parentheses.

Notice that the group selector on the shadowed terminal now has the hidden display client showing in the drop-down selector. The lightning bolt indication now shows a connection.
The TermSecure User tree will list the users.
A user that is logged into a terminal with TermSecure will show a different icon and will show the name of the terminal that it is logged into.
Membership in Multiple TermSecure Access Groups

A TermSecure User can be a member of multiple TermSecure Access Groups. In this example Bob is a member of both Maintenance and Supervisors. When he is logged in the display clients for both Maintenance and Supervisors are displayed. They will be hidden when he logs off.
18.6. Logging Out

The TermSecure User can be logged out by:

- Opening the TermSecure Main Menu on the terminal and selecting Log Off.
- Right clicking on the TermSecure User in the ThinManager tree and selecting Logoff User.
- Restarting or rebooting the terminal that has a TermSecure User logged in.

![Main Menu](image)

**Main Menu**

The Switch User button will log off the TermSecure User and disconnect any sessions from Display Clients assigned to the user. It opens the Login screen for another TermSecure User.

The Log Off button will log off the TermSecure User and log off any sessions from Display Clients assigned to the user and return to the terminal’s display.
19. Using TermSecure to Provide Roaming Applications

The second function of TermSecure is to allow a user to access their applications from any terminal. You do this by creating a TermSecure User and assigning a Display Client to the user. The session resides on the terminal server but is able to be accessed from any terminal configured with TermSecure.

Each TermSecure User that is assigned its own Display Client needs to be tied to a Windows account to authenticate the Windows login.

There are four methods of Windows Logins for a TermSecure User:

- Use the Terminal Login
- Use a TermSecure User account that matches a Windows User account
- Use an aliased Windows account.
- A blank Windows account

19.1. Using TermSecure to Provide Roaming Applications

Each TermSecure User that has its own display client assigned need to be tied to a Windows User account.

19.1.1. Use Terminal Configuration Login Information checkbox

The TermSecure User can use the terminal's username and password to auto-log on to the terminal server. To do this, check the Use Terminal Configuration Login Information checkbox.

Since a different account is used at each terminal this doesn’t keep a consistent session for the TermSecure User.

19.1.2. Same as TermSecure User username/password checkbox

The TermSecure User can use the TermSecure User username and password to auto-log on to the terminal server. To do this, check the Same as TermSecure User username/password checkbox.

The TermSecure User username and password must match a Windows User username and password to get authenticated by Windows.

If the TermSecure User is selected from the Active Directory then this is the default behavior.

19.1.3. Use the Username and Password fields

The TermSecure User can use an aliased username and password to auto-log on to the terminal server. To do this, use the fields for the Username, Password, and Domain that are provided.

This allows you to tie the TermSecure User account to a different Windows account. This allows you to alias the login, hiding the actual Windows account from the user.

19.1.4. Blank Username and Password fields

The TermSecure User can be required to manually log onto the terminal servers. To do this, leave the checkboxes unchecked and the Username, Password, and Domain empty.
Three Window Login Methods

The Windows Log In Information page of the TermSecure User Configuration Wizard.

This page will not be displayed if the TermSecure User is selected from the Active Directory then this is the default behavior.

Number 1 is the **Use Terminal Configuration Login Information** checkbox for section 19.1.1

Number 2 is the **Same as TermSecure User username/password** checkbox for section 19.1.2.

Number 3 is the Username, Password, and Domain fields for sections 19.1.3 and 19.1.4
Add User Command on the TermSecure User Tree

Launch the TermSecure User Configuration Wizard by right clicking on the TermSecure Users branch of the ThinManager tree and selecting Add TermSecure User.

**Note:** The complete TermSecure User Configuration Wizard is shown in TermSecure User Configuration Wizard on page 257.
If you select the **Active Directory User** checkbox and use the **Search** button to select an Active Directory user then the TermSecure User name will match the Windows account.

**Active Directory Password Page**

If you check the **Allow ThinManager to store password** checkbox and verify the password then ThinManager can store the password allowing the TermSecure User to login without entering the password. This can be helpful using the DigitalPersona UareU Fingerprint Reader.
TermSecure User Information Page

If you unselect the *Active Directory User* checkbox then you can manually name the TermSecure User. This can match a Windows account, or be a TermSecure only name.
Display Client Selection

The Display Client Selection page allows Display Clients to be assigned to the TermSecure User. When the TermSecure User logs onto a terminal, these Display Clients will be available on the terminal for him.

**Add User specific Display Clients?** - This setting will allow the selection of Display Clients for the TermSecure User that will be opened when the TermSecure User logs in to the terminal.

Select **Yes** to specify Display Clients for this user.

If you select **No** then the TermSecure User will only display the terminal display clients and won’t need tied to a Windows account.

Select the **Next** button to continue with the configuration.
The **Display Client Specification** page allows Display Clients to be assigned to the TermSecure User. Move display clients you want the TermSecure User to use, Form03 in this example, by double-clicking on it in the **Available Display Clients** list, or by highlighting it and clicking the **Right Arrow** button.

Select the **Next** button to continue with the configuration.
The Windows Log In Information page allows the configuration of how the TermSecure User will log on to the Windows terminal servers.

There are several Windows login options for the TermSecure User that were discussed earlier. To use the Windows account as the TermSecure User you need to check the Same as TermSecure User username/password checkbox.

The Domain field is included to use domain authentication.

Select the Next button to continue with the configuration.
Windows Login Information

The **Windows Log In Information** page allows the configuration of how the TermSecure User will log on to the Windows terminal servers.

Enter the Windows account that you will use for the TermSecure User in the **Username** and **Password** fields.

- Enter a Windows account on the Windows Log In Information page and keep it secret from the TermSecure User. They will think their TermSecure User account is providing the access.
Pre-Configured Windows Accounts

The alias lets you reuse Windows accounts without having to customize for every temporary user. It also lets hide the actual account to prevent them from using it improperly.

In this example the administrator has pre-configured five Contractor accounts and applied the needed group policy. Instead of creating a new account for every temporary contractor the administrator can tie a TermSecure User for the new worked to an established pre-configured Windows account.

Select the **Next** button on **Windows Log In Information** page to continue with the configuration.
Open ThinManager and select the **TermSecure User** tree.

The tree shows TermSecure Users.

**Pburns** is a Windows account that is a member of the **Foreman** group and has the **Foreman** permission from that group. He has the **Maintenance** permission added individually, along with **Form03** added as its personal display client.

These accounts are created and can be logged on through a terminal.
19.2. Logging On

To log in a TermSecure User on a terminal, go to a terminal that has the Enable TermSecure checkbox selected on the Terminal Mode Specification page.

You can log in by:
- Opening the display client selector and selecting Main Menu.
- Typing the CTL+m hotkey to launch the Main Menu.

The Main Menu will be displayed on the terminal.

![TermSecure Main Menu](image1)

Select the Log In button to login.

![TermSecure Log On Screen](image2)

Enter your TermSecure User name in the Enter User Name field. Select OK.

![Password Screen](image3)

Enter the TermSecure password in the field.
If the Window password isn’t supplied by the TermSecure User configuration the terminal will display a login window requesting the Windows password.

Select the **OK** button.

In this example the user logged on with the TermSecure User account that matches their Windows account.
The terminal shows the changed icon and the name of the TermSecure user. The user’s personal display client is displayed.

19.3. Logging Out

The TermSecure User can be logged out by:

- Opening the TermSecure Main Menu on the terminal and selecting Log Off.
- Right clicking on the TermSecure User in the ThinManager tree and selecting Logoff User.
- Restarting or rebooting the terminal that has a TermSecure User logged in.

![Main Menu]

Main Menu

The Switch User button will log off the TermSecure User and disconnect any sessions from Display Clients assigned to the user. It opens the Login screen for another TermSecure User.

The Log Off button will log off the TermSecure User and log off any sessions form Display Clients assigned to the user and return to the terminal’s display.
19.4. TermSecure User Schedule

TermSecure Users and TermSecure User Groups have a schedule on the User Options page of the TermSecure User Configuration Wizard.

TermSecure User Terminal Configuration Wizard – User Options Page

Check the Set Schedule checkbox and select the Schedule button to launch the Event Schedule window.

**Note:** The Schedule for TermSecure User Groups is the same as for individual TermSecure Users. It has an advantage of applying the scheduled events to a whole group of users instead of requiring a configuration for each event on each user.
Event Schedule

The Event Schedule will list events for the TermSecure User or TermSecure User group. It has four buttons:

- The **Add** button will launch a **Schedule** window to allow an event to be configured.
- The **Edit** button will allow a highlighted event to be changed.
- The **Delete** button will remove a highlighted event.
- The **OK** button will accept changes and close the Event Schedule window.

Events can be added by selecting the **Add** button to launch the **Schedule** window.
The Schedule window has several configuration settings.

**Event Type** is a drop-down box that allows event selection:

- **Disable User** - This will prevent a user from logging in through TermSecure or will disconnect an existing session.
- **Enable User** - This will allow a user to become active again.

The **Repeat Interval** radio buttons allow the event in the **Event Type** drop-down to be run **Once Only**, **Weekly/Daily**, **Monthly**, or **Yearly**.

- Selecting **Once Only** will show a **Select Date** field for the event.
- Selecting **Weekly/Daily** will show a **Weekly Schedule** list for the event to run. The **Every Day** button will select all the days in the list.
- Selecting **Monthly** will show a **Select Day of Month** field for the event.
- Selecting **Yearly** will show a **Select Date** field for the event.
- The **Time** field allows the selection of the time that the event should occur.

Select the **OK** button to close the Schedule window.

Select **Add** to add another event to the **Event Schedule** or select **OK** to close the **Event Schedule** window and return to the terminal configuration.
20. Card Readers and Fingerprint Scanners

20.1. Card and Badge Configuration for a TermSecure User

ThinManager has the ability to use Prox (proximity) cards for TermSecure logins. This requires:

- Adding a card reader to the ThinManager Ready thin client
- Adding the card reader module to the terminal configuration
- Associating the card number to the TermSecure User configuration.

ThinManager has support for the RF Ideas Inc. serial RDR-6081AK2 pcProx card reader and the USB RDR-6081AKU and RDR-80582AK0 pcProx card reader (www.rfideas.com).

20.1.1. Configure a Terminal with the Card Reader Module

Open the Terminal Configuration Wizard by double clicking on the terminal in the tree. Navigate to the Module Selection page.

Select the Add button to launch the Attach Module to Terminal window.
Scroll to the **RF Ideas pcProx Module** in the TermSecure section.
Highlight the **RF Ideas pcProx Module** and select the **OK** button.
The module can be configured once it is attached to a terminal. Highlight the RF Ideas pcProx Module and select the Configure button to launch the Module Properties window.
The RF Ideas Serial pcProx Module has parameters that can be configured:

- **Port** - This selects the port that the serial RF Ideas pcProx card reader is installed.
- **Number of Data Bits** – Different cards use different numbers of data bits in their format. This sets the number of data bits to match that used by the card as an identifier. The choices are 26, 37, or Raw.
- **Use Facility Code** - This value, when set to Yes, will add the card’s Facility Code to the Card / Badge ID number.
- **Allow Manual Login** - This, when set to **Yes**, will allow a TermSecure user to log into a terminal without a TermSecure ID device. If set to **No**, TermSecure users must use a TermSecure ID device to log in.
- **Prompt for Password** - This, when set to **Yes**, will require a TermSecure to enter their password for access, even if the password is configured in ThinManager.

**Note:** The USB RDR-6081AKU does not have the Facility Code option. Do not use the Facility code on serial pcProx card readers if you are using a mix of both USB RDR-6081AKU and RDR-6081AK2 serial devices.
The RF Ideas USB pcProx Module has parameters that can be configured:

- **Model** - This allows you to select between the RDR-6081AKU and RDR-80582AK0 USB pcProx card reader.

- **Mode** – This allows you to select between TermSecure, Wedge, and TermMon modes.
  - TermSecure Mode – This allows the card to be used with TermSecure as a login device.
  - Wedge Mode – This allows the data to be sent to the session as a character string.
  - TermMon Mode – This allows the data to be sent to the TermMon ActiveX.

- **Bits in ID Number (AK0 Only)** – Different cards use different numbers of data bits in their format. This sets the number of data bits to match that used by the card as an identifier.

- **Bits in Facility Code (AK0 Only)** - Different cards use different numbers of data bits in their format. This sets the number of data bits of the Facility Code.

- **Zero Pad Facility Code and ID (AK0 Only)** – This adds a leading 0 to the Facility Code if needed.

- **Allow Manual TermSecure Logon** - This, when set to Yes, will allow a TermSecure user to log into a terminal without a TermSecure ID device. If set to No, TermSecure users must use a TermSecure ID device to log in.

- **Prompt for TermSecure Password** - This, when set to Yes, will require a TermSecure to enter their password for access, even if the password is configured in ThinManager.

- **Expose Card ID to TermMon ActiveX Control** – Allows the card data to be sent to the TermMon ActiveX without incorporating TermSecure.
To configure a parameter:

- Highlight the parameter.
- Change the value.
- Select the Set button to apply the new value.
- Select Done to accept the changes.

Once the terminal has the module added it will need to restart to apply the changes. Select the Finish button to close the Terminal Configuration Wizard.

Right click on the terminal in the ThinManager tree and select Restart.
20.1.2. Configure ThinManager for Automatic User Configuration

A card reader can be used to associate cards with TermSecure Users using wizards.

Select View > Options from the ThinManager menu to open the Options window.

Options Window

Select the Display “Create New User” dialog for unknown users check box.

Select the OK button to accept the change.

The Display “Create New User” dialog for unknown users check box will launch the TermSecure User Configuration Wizard on the ThinManager Server when an unknown ID device (USB key or ID card) is read by a terminal. Once this checkbox is selected, scanning a new ID card or inserting an undefined USB key will launch the TermSecure User Configuration Wizard with the Enter Card/Badge ID number automatically filled in.
20.1.3. Automatically Applying the Card to a Configuration

Once ThinManager has the Display “Create New User” dialog for unknown users checkbox selected the card on a terminal it can be used to associate cards with TermSecure Users using wizards.

Pass a Prox card over the card reader on the terminal to launch the TermSecure User Configuration Wizard.

Card / Badge Information Page

Once the card reader has scanned an unknown Prox card a TermSecure Configuration Wizard will be launched associated with the new card number. Select the Assign Card Number to Existing User button to launch the TermSecure User Replacement page.

If you want to create a new TermSecure User for this card instead of associating it with a pre-created TermSecure User, then select the Next button to navigate to the TermSecure User Configuration Wizard.
The TermSecure User Replacement Page allows you to select an existing TermSecure User to associate the card. Select a TermSecure User from the tree and select the OK button.
The TermSecure User Configuration Wizard for the selected user will be displayed. The **Password** and **Permissions** can be modified at this time if it isn't an Active Directory user. Select **Next** to continue to the **Card/Badge Information** page.
The Card/Badge Information page will now have the **This user will use a card or badge to login** checkbox selected. The serial number of the HID card will be entered in the **Enter Card/Badge ID number** field.

Checking the **Always Prompt for Password** checkbox will require the user to enter a password manually each time the card is used.

Select **Finish** to accept the changes.

The card can now be used to login at terminals configured with card readers.
20.1.4. Manually Applying the Card to a Configuration

Although the easiest method for assigning a card or badge is automatic as described in the previous section, ThinManager can be configured for manual entry.

If the Display “Create New User” dialog for unknown users check box on the Options window is unselected, the Enter Card/Badge ID number field will need to be entered manually. The Card/Badge ID number is accessible in the event log. To configure a terminal to allow a device one needs to:

- Turn the TermSecure User Event Log on in the ThinManager Server Configuration Wizard.
- Have the appropriate hardware on the terminal, either a USB or Serial ProxCard reader.
- Add the appropriate module.
- Use the device once to have the device’s identifier entered to the event log.
- Open the TermSecure User Configuration Wizard and enter the ID number to tie the TermSecure User to the device.
- Login with the ID device.

20.1.5. Event Log

The Event Log is configured in the ThinManager Server Configuration Wizard.

Go to the ThinManager Server branch of the ThinManager tree by selecting the ThinManager Server icon.

Open the ThinManager Server Configuration Wizard by double clicking on the ThinManager Server icon, or by selecting Edit > Modify from the menu.

Navigate to the Historical Logging page.
All events may be selected to be logged, but the **TermSecure User Configuration changes** checkbox is critical to the TermSecure Device detection. Select the **TermSecure User Configuration changes** checkbox and select the **Finish** button.

### 20.1.6. Device Identifier Number

Next the Prox card needs to be scanned to help find the ID number. Pass the Prox card over the pcProx Card scanner attached to a terminal. A TermSecure message should be displayed.

**TermSecure Message**

18432038 Is Not a Valid User ID

The ID device will not work so the terminal will send a message with the ID device’s identifier number.
Record the number displayed.
This number is also entered in the event log if the Terminal Events were selected in the ThinManager Server Configuration Wizard.
Open ThinManager.
Highlight the terminal in the tree and select the Event Log tab.
The ID for the device is entered in the log.

Next the ID number needs to be associated with the TermSecure User.
Open the TermSecure User Configuration Wizard for the user you want to have use that ID device.
Navigate to the Card / Badge Information page.
Select the **This user will use a card, badge, or other device to log in** checkbox.
Enter the ID Identifier from the earlier steps into the **Enter Card/Badge ID number** field.
Select the **Always Prompt for Password** checkbox, if desired.

Now the Terminal is configured, the ID device is identified, and the TermSecure User is configured to use the device.

Select the **Finish** button to complete the configuration.
Event Log

Rescan the card now that is associated with a TermSecure User account.

The Event Log will show the results of the successful login. The terminal will have the TermSecure User added to its icon in the tree, while the TermSecure User icon will show the name of the terminal that it is logged into.
20.2. **Fingerprint Reader**
ThinManager supports the DigitalPersona UareU model 4500 fingerprint reader as a biometric reader. This can be used as an identifier for TermSecure.

The DigitalPersona UareU model 4500 fingerprint scanner requires:

- Activation in the ThinManager Server Configuration Wizard.
- The unit plugged into a terminal and the DigitalPersona UareU Fingerprint Reader module added to the terminal.
- The user fingerprint scanned in TermSecure to associate a user with the fingerprints.

20.2.1. **Fingerprint Reader in ThinManager**
The DigitalPersona UareU fingerprint reader needs activated in the ThinManager Server Configuration Wizard.

Open the **ThinManager Server Configuration Wizard** by double clicking on the ThinManager Server icon in the ThinManager branch of the ThinManager Server tree.
Navigate to the **Biometric Device Configuration** window.

Select the **Support Finger Print Readers** checkbox to enable the use of readers.

Select the data format you plan to use. There are two formats to choose, **ISO_19794_2_2005** and **ANSI_378_2004**.

The **False Match Probability** sets the sensitivity of the read. 1/100 is less sensitive than 1/1,000,000.

Select the **Finish** button to accept the changes.
20.2.2. Fingerprint Reader on the Terminal

You need to add the DigitalPersona UareU Fingerprint Module to a terminal if you plan on plugging a DigitalPersona UareU fingerprint reader into the terminal.

Open the **Terminal Configuration Wizard** by double clicking on the terminal icon in the Terminal branch of the ThinManager Server tree.

![Terminal Mode Selection Page of the Terminal Configuration Wizard](image)

**Terminal Mode Selection Page of the Terminal Configuration Wizard**

Navigate to the **Terminal Mode Selection Page** of the **Terminal Configuration wizard** and select the **Enable TermSecure** checkbox to make the fingerprint reader work with TermSecure.

Select the **Next** button to navigate to the **Module Selection** page.
Attach Module to Terminal Window

Select the **Add** button on the **Module Selection** page to launch the **Attach Module to Terminal** window.

Select **TermSecure** in the **Module Type** drop-down and highlight the **DigitalPersona UareU Fingerprint Reader module**. Select the **OK** button to add the module to the terminal.
Highlighting the DigitalPersona UareU Fingerprint Reader module and selecting the **Configure** button on the **Module Selection** page will launch the **Module Properties** window.

The DigitalPersona UareU Fingerprint Reader module has several configurable settings:

- **Mode** – This allows you to choose the Mode. The modes are:
  - **TermSecure** – This is used to identify a TermSecure User.
  - **TermMon** – This sends the fingerprint data to the TermMon ActiveX.
  - **TermMon Lookup** – This allows the TermMon ActiveX to identify the user without logging them in.

- **Data Format** – This sets the data format for the fingerprint reader. The data formats are:
  - ISO_19794_2_2005
  - ANSI_378_2004
  - DigitalPersona

- **Show Status Messages** – Setting this will show a brief message in the upper right corner of the terminal for each fingerprint reader event.

- **Allow Manual Logon** – If set to **No** then a user must use the fingerprint reader to logon. If set to **Yes** then you can use the fingerprint scanner or manually logon.

- **Prompt for TermSecure Password** – If set to **Yes** then the user will be required to enter a password in addition to the fingerprint scan. If set to **No** then the fingerprint scan is enough to allow a logon.
20.2.3. **Fingerprint Reader at the TermSecure User**

Fingerprint data is associated with a user in the **TermSecure User Configuration Wizard**.

Open the **TermSecure Users** branch of the ThinManager tree and double click on the TermSecure User whose fingerprints you want to register. This will launch the **TermSecure User Configuration** wizard.
The Card / Badge Information Page has an Enroll Fingerprint button that begins the registration process.

Select the Enroll Fingerprint button to launch the Enroll Fingerprint window.

**Note:** The Always Prompt for Password checkbox will force the user to enter their password at each login if checked.
Select the **Change** button to open the **Select Terminal Group** window to select the terminal that has the fingerprint scanner you will use for registration.

**Select Terminal Group Window**

Highlight the terminal that has the fingerprint scanner you will use for registration in the **Select Terminal Group** window and select the **OK** button.

This terminal will be registered as the **Enrollment Terminal**.
Enroll Fingerprint Window

Once you have selected the Enrollment Terminal select the finger you want to enroll in the **Select Finger to Enroll** drop-down.

The selected finger will show a crosshair logo.

Select the **Start Enrollment** button to begin.

Enroll Fingerprint Window

The enrollment requires four scans of the fingerprint. Place it on the scanner. The blue light should turn red, and then back to blue. Leave it on until the red light turns off.
Enroll Fingerprint Window

The enrollment requires four scans of the fingerprint. Repeat until complete.

Enroll Fingerprint Window

Once the finger has been scanned and enrolled the scanned finger will show as green on the Enroll Fingerprint Window. A new finger will be selected in the Select Finger to Enroll drop-down.
Shadow of a Terminal Scan

Scanning a registered fingerprint will trigger a TermSecure logon. If the *Always Prompt for Password* checkbox was checked then a dialog box will appear requesting the Windows password for the Windows account.
Shadow of a Terminal Scan

This picture shows a TermSecure User logged into a terminal using a DigitalPersona UareU Fingerprint Reader.

The Terminal icon shows a user logged in, it names the user, and the Desktop2012 application shows a user login to show that that display client was assigned through the TermSecure User.
21. Packages

21.1. Firmware, Packages and Modules

**Firmware** is the basic operating system that the thin clients run. It is downloaded and expanded into memory where it serves as an operation system.

**Modules** are additional functions that a thin client may use. These include touch screens, keyboard modules, and sound modules.

**Packages** contain a version of firmware and the modules that belong with it.

In the past ACP made all of the firmware changes backwards compatible so that a 12 year old x486 thin client could run the same firmware as the latest model of thin client. This limits what ACP can do with to take advantage of new hardware.

ThinManager 6.0 introduced a new approach to firmware and modules called **Packages**. ThinManager has the ability to run different versions of the firmware on different thin clients. Legacy thin clients can run **Package 5** that is equal to the ThinManager 5 firmware while newer thin clients can run **Package 6** and later. As new hardware is released you will be able to run even newer packages to take advantage of new features.

A package, the firmware version and the modules that go with it, can get assigned to by default to a thin client, or you can override the setting and run a different package.

This will be particularly helpful in validated systems. If new hardware is purchased that requires a new firmware you can assign a new package to the new hardware while the existing thin clients can continue to run the original validated package.

Packages, firmware, and modules are included with ThinManager and are registered automatically during ThinManager installation. Packages may be updated occasionally and can be downloaded from the ThinManager web site at [http://downloads.thinmanager.com/](http://downloads.thinmanager.com/) and applied to ThinManager.
21.1.1. Updating Packages and Files

ThinManager allows the updating of Packages. You can also update just the firmware or specific modules if needed.

**Note:** These get updated automatically during Service Pack upgrades. This shows how to do it without updating with a Service Pack.

- New components can be downloaded from the ThinManager web site at [http://downloads.thinmanager.com/](http://downloads.thinmanager.com/)
- **Install > Firmware Package** will launch a file browser and allow you to install a *.pkg file.
- **Install > Firmware** will launch a file browser and allow you to install a *.fw file. You also use this command to load a new version of the legacy firmware.acp firmware file
- **Install > Module** will launch a file browser and allow you to install a *.mod file.

ThinManager uses a Boot Loader and a Chain Loader during PXE boot.

- **Install > Boot Loader** will launch a file browser and allow you to install a *.bin file.
- **Install > Chain Loader** will launch a file browser and allow you to install a *.bin file.

ThinManager uses a Terminal Capabilities Database, or TermCap, to aid in configuring the thin clients.

- **Install > TermCap Database** will launch a file browser and allow you to install a *.db file.

This picture shows a folder with three firmware packages, v.5, v. 6, and v 7. Highlight the desired firmware package and select the **Open** button.
Install > Firmware will launch a file browser and allow you to install a *.fw file. You also use this command to load a new version of the legacy firmware.acp firmware file.

This picture shows a folder with several versions of firmware.

Highlight the desired firmware and select the Open button.
Module Installation

*Install > Module* will launch a file browser and allow you to install a *.mod* file.

This picture shows a folder with two sound modules.

Highlight the desired module and select the *Open* button.

21.1.2. Customizing Packages

ThinManager allows you to run different packages on different models or individual terminals. You can modify a package by copying it and making changes to it.

Modules and packages are normally updated with service packs and releases. You can download updated modules at [http://downloads.thinmanager.com/](http://downloads.thinmanager.com/) when needed.

Open the **Package Manager** by selecting **Manage > Packages**.
ThinManager 8.0 User Manual

Package Manager Window

Select the **Edit Packages** button to launch the **Edit Firmware Package** window.

Edit Firmware Packages Window

Select the package you want to modify in the **Select Package** window and select the **Copy** button to make a copy.
New Package Name Window
Enter a name for the new package in the Enter name of new package field.

Success Dialog
Success will be confirmed with a dialog.
Close the Edit Firmware Packages and Package Manager windows.
Open the Modules window by selecting Install > Modules from the ThinManager menu bar.
Select the Install Modules button on the Modules window. This will open a file browser.
File Browser

Use the file browser to navigate to your downloaded modules.
Select the needed module and select the *Open* button. This will launch a dialog box.
A **Select Firmware Package** window will be displayed that allows the selection of which package you want to add the module.

Highlight your copied module and click the **Selected Packages** button. This will add the new module to that package.

Close the **Modules** window to finish.
You can lock a package on the Edit Firmware Packages window.

Open the Package Manager Window by selecting Manage > Packages on the ThinManager menu bar.

Select the Edit Packages button on the Package Manager window to launch the Edit Firmware Packages window.

Highlight the package in the Select Package dropdown and select the Lock checkbox. This will lock the package.
21.2. Configuring Packages for a Model of Thin Client

ThinManager allows you to change the package for all units of a make and model. Select *Manage > Packages* to launch the Package Manager window.

![Package Manager](image)

Select your *Manufacturer* and *Model* in the drop-downs.

Set the package version you want in the *Package* dropdown. This becomes the *Model Default*.

Select *OK* to close the *Package Manager* window.

Older Makes and models will have less options than newer, more powerful makes and models.
The ancient DC-30-100 can only run package 5. This is set in the TermCap as the default package.

The more recent ACP TC3000 can run firmware v.5, v.6, v.7, and custom firmware.
New Default Firmware

Changing the firmware package in the **Package** dropdown will set that firmware as the default firmware. Any terminal of that make and model will run that firmware.
21.3. Configuring Packages for an Individual Thin Client

Packages can be changed for an entire series of thin clients or for an individual thin client. This is done in the Package Manager window.

Select Manage > Packages to launch the Package Manager window.

Select Allow the setting of the Package in Terminal Configuration checkbox. This allows you to override an individual thin client’s package setting.

Select OK to close the Package Manager window.
Open the **Terminal Configuration Wizard** by double clicking on the terminal in the Terminal branch of the ThinManager tree.

Navigate to the **Terminal Hardware** page.

**Terminal Firmware Package Setting**

The **Terminal Firmware Package** drop-down allows you to pick a different package to run once you allow individual firmware on the Package Manager window.

The current setting shows the **Package 7_b** that was used in the previous example.
New Terminal Firmware Package Setting

Once individual firmware is allowed on the Package Manager window the Terminal Package window the Terminal Firmware Package dropdown becomes active and allows you to select a firmware for that individual terminal.

Select the **Terminal Firmware Package** of your choice.

Select **Finish** to close.

Reboot the terminal by highlighting the terminal and selecting **Tools > Reboot** from the ThinManager Menu.

The terminal will show the ThinManager splash screen for that firmware during the boot process.
22. **Modules**

Modules are components and drivers for the terminals that aren’t needed for the basic boot but can be added to enhance the features and functions of the terminals.

Modules are added to terminals individually or through Terminal Groups.

This manual will cover a dozen modules. The first will cover the general steps with the **Key Block Module**. The other modules will cover the individual configuration.

- Keyboard>Key Block Module
- Keyboard>Key Block Single Key Module
- Keyboard>Keyboard Configuration Module
- Local Storage>USB Flash Drive Module
- Miscellaneous>Redundant Ethernet Module
- Miscellaneous>Second Network Module
- Mouse>Locate Pointer Module
- RDP>RDP Serial Port Redirection Module
- Screen Saver>MultiSession Screen Saver Module
- Screen Saver>Screen Saver Module
- Sound>Universal Sound Driver
- TermSecure>DigitalPersona UareU Fingerprint Reader
- TermSecure>RF Ideas pcProx Modules
- Touch Screen>Serial Touch Screen Drivers
- Touch Screen>USB Touch Screen Driver
- Video>Custom Video Mode Module
22.1. Adding a Module (Keyboard>Key Block Module)

Double click on your terminal to launch the Terminal Configuration Wizard. Navigate to the Module Selection page.

---

**Module Selection Page**

Select the *Add* button to launch the Attach Module to Terminal window.
Attach Module to Terminal Window

The **Attach Module to Terminal** window has been organized with a drop-down box. The modules may be viewed by category or as a whole.

Select a module category from the **Module Type** drop-down.

Highlight a module and select **OK**.
Key Block Module

This picture shows the Key Block Module in the Installed Modules window. The Key Block Module has configurable settings.

Highlight the Key Block Module and select the Configure button to launch the Modules Properties window.
The **Module Properties** window shows the settings that can be configured.

You change a parameter by highlighting it and changing the **Value**, either through a dropdown or typing the new setting.

By default **CTRL+ALT+DEL, CTRL+ALT+ESC, and CTRL+ESC** are blocked. The other key combinations can be blocked by highlighting the key combination and changing the **Value** to **Yes** and selecting the **Set** button.

**Note:** You need to click the **Set** button to poke the value into the database.

Select **Done** to close the window.
The module and settings will be displayed on the **Modules** tab when the terminal is highlighted.

**Note:** The 4_TERMINAL shows the red Configuration Indicator icon to show that the configuration changed when the module was added but it hasn’t been restarted yet to load the new configuration.
22.2. **Keyboard>Key Block Single Key Module**

The **Key Block Single Key Module** lets you block a single key combination from being send from the terminal to the session.

### Module Properties

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modifier</td>
<td>CTRL</td>
</tr>
<tr>
<td>Key to Block</td>
<td>A</td>
</tr>
</tbody>
</table>

**Key Block Single Key Module Properties**

You can block a single set of key combinations by adding and configuring the **Key Block Single Key Module**.

You can set **ALL, CTL, ALT, or CTL+ALT** as the modifier key(s) and set **A-Z, F1-F12, and ESC, Tab, Backspace**, etc. as the key to block.

If you have multiple keys to block add the **Key Block Single Key Module** once for each combination and configure them accordingly.
22.3. **Keyboard>Keyboard Configuration Module**

The Keyboard Configuration Module allows you to set the keyboard language and control the behavior of the Caps lock and Number lock on the terminal.

<table>
<thead>
<tr>
<th>Module Properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parameter</td>
</tr>
<tr>
<td>Num Lock State</td>
</tr>
<tr>
<td>Caps Lock State</td>
</tr>
<tr>
<td>Scroll Lock State</td>
</tr>
<tr>
<td>Repeat Delay (ms)</td>
</tr>
<tr>
<td>Repeat Rate (chars/sec)</td>
</tr>
<tr>
<td>Disable Repeat for Enter Key</td>
</tr>
<tr>
<td>Keyboard Layout</td>
</tr>
</tbody>
</table>

The Keyboard Configuration parameters include:

- **Num Lock State** – This allows the Number Lock to be set to **On** at startup, **Off** at startup, always **On**, or always **Off**.
- **Cap Lock State** – This allows the Caps Lock to be set to **On** at startup, **Off** at startup, always **On**, or always **Off**.
- **Scroll Lock State** – This allows the Scroll Lock to be set to **On** at startup, **Off** at startup, always **On**, or always **Off**.
- **Repeat Delay (ms)** – This parameter sets the amount of time that a key needs to be held down before it starts repeating the keystroke. If this parameter is set to **Disable** a key will only send one keystroke even if the key is held down.
- **Repeat Rate (chars/sec)** – This parameter sets the number of characters per second that a held down key will send.
- **Disable Repeat for Enter Key** – This parameter, when set to **Yes**, will prevent the **Enter** key from repeating if it is held down.
- **Keyboard Layout** – This parameter allows the thin client to use keyboards other than the default English (United States) keyboard map.
22.4. Local Storage>USB Flash Drive Module

USB ports are disabled by default in the ThinManager system. You can use the USB ports for keyboards and mice, but not USB drives. You need to allow the port to be used with the **USB Flash Drive Module**.

The USB port will also work with devices that work as a keyboard wedge.

The **USB Flash Drive Module** has several parameters.

- **Drive Access Rights in Session** - **ReadWrite** allows the user to read and write to the flash drive. **ReadOnly** allows the user to read data but not write data, and **None** sets the flash drive to access only the unique serial number to make it usable as a TermSecure ID device.

- **Use with TermSecure** - This needs to be set to **YES** to allow the device to be a TermSecure identifier. A **NO** setting, in conjunction with a **ReadWrite Access Rights** setting, will allow the device to be used as a remote storage drive.

- **Allow Manual Logon** - This value, when set to **Yes**, will allow a TermSecure user to log into a terminal without a TermSecure ID device. If set to No, TermSecure users must use a TermSecure ID device to log in.

- **Prompt for Password** - This value, when set to **Yes**, will require a TermSecure User to enter their password for access, even if the password is configured in ThinManager.

**Note:** USB doesn’t map to the session like serial does. If you want to add a USB device that requires a driver installed, like a printer, you can use a IP-to-USB converter that allows you to address the device and mount the drives from the session.
22.5. Miscellaneous>Redundant Ethernet Module

Adding the Redundant Ethernet Module to a terminal with dual network ports will allow the terminal to use the second port as a backup. The terminal will have one IP address but it can have the ports plugged into two switches to have redundant paths to the terminal servers.

The Redundant Ethernet Module has no configurable settings. Plug each network port into different switches on the same network.

The terminal will boot from the first available network port and download the configuration. If the first network path fails it will seamless switch to the backup port to prevent interruption of service.

22.6. Miscellaneous>Second Network Module

The Second Network Module allows you to use the dual network ports on a terminal on different networks.

Add the Second Network Module and configure the second port. The terminal will always boot from the first port but once booted it will enable the second port and allow communication on both networks. This is useful for separating IP camera bandwidth from the process control network, for example.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>IP Method</td>
<td>STATIC</td>
</tr>
<tr>
<td>IP Address (Static Only)</td>
<td>0.0.0.0</td>
</tr>
<tr>
<td>NetMask (Static Only)</td>
<td>255.255.255.0</td>
</tr>
<tr>
<td>Router (Static Only)</td>
<td>0.0.0.0</td>
</tr>
</tbody>
</table>

The settings include:

- **IP Method** – This allows the second port to use DHCP or a static IP.
- **IP Address (Static Only)** – This allows the second port to be assigned a static IP address.
- **NetMask (Static Only)** – This allows the second port to be assigned a subnet mask.
- **Router (Static Only)** - This allows the second port to be assigned a router.
22.7. Mouse>Locate Pointer Module

The **Locate Pointer Module** adds a large crosshair to the cursor when it becomes active after being idle. This allows you to see its location quickly. This is particularly helpful in a MultiMonitor system.

![Module Properties]

The settings include:

- **Locate Pointer Hotkey** – This allows you to set a hotkey to make the cursor appear.
- **Locate Pointer Hotkey Modifier** – This allows you to set the modifier key to activate the hotkey to show the pointer cursor.
- **Home Pointer Hotkey** – This allows you to set a hotkey that will move the cursor to the center of the main screen.
- **Home Pointer Hotkey Modifier** – This allows you to set the modifier key that will move the cursor to the center of the main screen.
- **Locate Inactivity Time (seconds)** – This sets the length of the idle time before the locate pointer cursor is activated.
- **Home Pointer Inactivity Time (seconds)** – This sets the length of the idle time before the locate pointer cursor is moved to the center of the main screen.
- **Locate Display Time (seconds)** – This is the length of time that the locate pointer crosshair cursor will be displayed when activated.
22.8. **RDP>RDP Serial Port Redirection Module**

Using serial ports on a thin client presents a paradox. The session is running on a terminal server and not the thin client. If you connect a serial device to the thin client and reference it in the session, the session will look at the local serial ports on the server and not the remote serial ports on the terminal where the device is attached.

Adding the RDP Serial Port Redirection Module will map the remote ports on the terminal to the local ports in the session. If the session references COM Port 1 it will be sent to the terminal COM Port 1.

The RDP Serial Port Redirection Module has no configuration, adding it is enough to map the remote COM Ports.

22.9. **Screen Saver>MultiSession Screen Saver Module**

The **MultiSession Screen Saver Module** is a screen saver that allows a cycling of the different sessions of a MultiSession client.

![Module Properties](image)

**MultiSession Screen Saver Module**

The **MultiSession Screen Saver Module** has two modes. It can be set to cycle through the MultiSession windows when the terminal is inactive, or it can be set to return to the main MultiSession screen when the terminal is inactive.

The parameters are:

- **Mode** - The **Cycle** mode will switch between all active sessions on the terminal. The **GotoFirstGroup** mode will switch the terminal to the main session when it is inactive.

- **Start Delay Time in secs** - This is the number of seconds of inactivity that the terminal will allow before starting the screen saver.

- **Switch Interval in secs (Cycle only)** - This is the number of seconds that the terminal will display each session when using the Cyclic mode.
22.10. Screen Saver>Screen Saver Module

*Screen Saver Module* is a module that loads a screen saver on the client. The screen saver will run when the terminal is idle to protect the monitor. Since the screen saver runs on the client, it saves CPU resources on the terminal server.

This module has a Disable Time Period function that will disable the screen saver during working hours so that the screen is visible during the working hours.

### Screen Saver Module Parameters

The *Screen Saver Module* configuration includes:

- **Screen Saver** - the graphic that is displayed when the screen saver is active.
- **Wait Time in Minutes** - the length of time that the terminal needs to be idle before the screen saver starts.
- **Use Disable Time Period** - the screen saver can be set to be disabled or unavailable during a time block. This could be used to prevent the screen saver from running during normal business hours.
  - **Disable Start Hour (0-23)** - This sets the start of the disabled time block. 0 is Midnight and 23 is 11:00 p.m.
  - **Disable End Time (0-23)** - This sets the end of the disabled time block. 0 is Midnight and 23 is 11:00 p.m.
  - **Force Off when Start Hour is Reached** - If set to *Yes*, this will turn the screen saver off when the *Disable End Time* is reached.
22.11. Sound>Universal Sound Driver

Many ThinManager Ready thin clients and ThinManager Compatible thin clients have audio ports for speakers.

The use of sound from a thin client requires several things:

- Hardware with a Line Out/Speaker plug
- Amplified speaker(s)
- The Universal Sound Driver Module

Plug the speaker(s) into the Line Out plug on the terminal, add the module, and connect to the terminal server.

The **Universal Sound Driver Module** will activate ThinManager to send the correct sound driver for that terminal. This module can be added to any thin client that has an audio jack to enable sound.

![Module Properties](image)

### Universal Sound Driver Properties

The **Universal Sound Module** has several settings:

- **Audio Bandwidth (ICA Only)** - This parameter can be set to **Low**, **Medium**, or **High** bandwidth when using Citrix ICA.

- **Sound in Session** - This setting, when set to **Enabled**, will allow sound generated within the session to be played through the terminal. When this is set to **Disabled** the session sounds will be turned off but system sounds will still be generated during TermSecure login for audio feedback during the login process.

- **Terminal Sound Effects** - This setting, when set to **Enabled**, will allow terminal sound effects like TermSecure login sounds on the terminal.

- **Only Play sound in Foreground Session** – This turns off the sound in background sessions when using MultiSession.
• **Master Volume Level (0-100)** – This sets the master volume for the terminal.

• **Start Sound Volume Level (0-100)** - This sets the starting volume for the terminal.

• **Sound Effects Volume Level (0-100)** – This sets the level for sound effects on the terminal.

• **Sound Card Number** – This lets you specify which sound card to use if you have multiple sound cards.

### 22.12. TermSecure> DigitalPersona UareU Fingerprint Reader

ThinManager supports the DigitalPersona UareU Fingerprint Reader biometric reader from Crossmatch to add another element of security to a ThinManager system.

![Module Properties](image)

The **DigitalPersona UareU Module** has several settings:

• **Mode** – This allows you to use the reader with TermSecure, the TermMon ActiveX, or as a TermMon Lookup device.

• **Data Format** – This allows you to choose the data format used by the biometric reader.

• **Show Status Messages** – This will display activity messages in the upper right corner of the terminal.

• **Allow Manual Logon**  This can be set to **No** to require access only through the biometric device.

• **Prompt for TermSecure Password** – This will require a password in addition to finger print scan when set to **Yes**.
22.13. TermSecure>RF Ideas pcProx Modules

ThinManager supports card readers from RF Ideas for use with badges in TermSecure.
There is a serial RF Ideas pcProx Module and a USB RF Ideas pcProx Module.

22.13.1. Serial RF Ideas pcProx Module

This module is used with the RFIdeas pcProx Enroll Series 81 readers like RDR-xx81AKx.

The parameters are:

- **Port** - This selects the port that the RF Ideas pcProx card reader is installed.
- **Number of Data Bits** – Different cards use different numbers of data bits in their format. This sets the number of data bits to match that used by the card as an identifier. The choices are 26, 37, or Raw.
- **Use Facility Code** - This value, when set to Yes, will require the addition of the card’s Facility Code to the Card / Badge ID number.
- **Allow Manual Login** - This, when set to Yes, will allow a TermSecure user to log into a terminal without a TermSecure ID device. If set to No, TermSecure users must use a TermSecure ID device to log in.
- **Prompt for Password** - This, when set to Yes, will require a TermSecure to enter their password for access, even if the password is configured in ThinManager.
- **Zero Pad Facility Code and ID** – This will add a zero to the number string. This is rarely needed.
22.13.2. USB RF Ideas pcProx USB Module

This module is used with the RDR-6081AKU, RDR-80582AK0, and RDR-80082AK0 USB RF Ideas pcProx readers.

```
Module Properties

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Model</td>
<td>RDR 80082AK0</td>
</tr>
<tr>
<td>Mode</td>
<td>TermSecure</td>
</tr>
<tr>
<td>Bits in ID Number (AK0 Only)</td>
<td>16</td>
</tr>
<tr>
<td>Bits in Facility Code (AK0 Only)</td>
<td>8</td>
</tr>
<tr>
<td>Zero Pad Facility Code and ID (AK0 Only)</td>
<td>NO</td>
</tr>
<tr>
<td>Allow Manual TermSecure Login</td>
<td>YES</td>
</tr>
<tr>
<td>Prompt for TermSecure Password</td>
<td>NO</td>
</tr>
<tr>
<td>Expose Card ID to TermMon ActiveX</td>
<td>NO</td>
</tr>
</tbody>
</table>
```

The parameters are:

The **RF Ideas USB pcProx Module** has parameters that can be configured:

- **Model** - This allows you to select between the RDR-6081AKU, RDR-80582AK0, and RDR-80082AK0 USB pcProx card reader.

- **Mode** – This allows you to select between TermSecure, Wedge, and TermMon modes.
  - **TermSecure Mode** – This allows the card to be used with TermSecure as a login device.
  - **Wedge Mode** – This allows the data to be sent to the session as a character string.
  - **TermMon Mode** – This allows the data to be sent to the TermMon ActiveX.

- **Bits in ID Number (AK0 Only)** – Different cards use different numbers of data bits in their format. This sets the number of data bits to match that used by the card as an identifier.

- **Bits in Facility Code (AK0 Only)** - Different cards use different numbers of data bits in their format. This sets the number of data bits of the Facility Code.

- **Zero Pad Facility Code and ID (AK0 Only)** – This adds a leading 0 to the Facility Code if needed.

- **Allow Manual TermSecure Login** - This, when set to **Yes**, will allow a TermSecure user to log into a terminal without a TermSecure ID device. If set to **No**, TermSecure users must use a TermSecure ID device to log in.
- **Prompt for TermSecure Password** - This, when set to **Yes**, will require a TermSecure to enter their password for access, even if the password is configured in ThinManager.

- **Expose Card ID to TermMon ActiveX Control** – Allows the card data to be sent to the TermMon ActiveX without using it as a TermSecure User identifier.

To configure a parameter:

- Highlight the parameter.
- Change the **value**.
- Select the **Set** button to apply the new value.
- Select **Done** to accept the changes.

Once the terminal has the module added it will need to restart to apply the changes. Select the **Finish** button to close the Terminal Configuration Wizard.

Right click on the terminal in the ThinManager tree and select **Restart**.
22.13.3. **RFI Ideas pcProx Sonar Module**

RF Ideas has a sonar device that can be pointer to the operator. It becomes active when a TermSecure User logs on and measured the time for a sonar echo. If the user walks away without logging off the sonar will detect the absence because of the increase in the time interval of the echo.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Walk-Away Modifier</td>
<td>CTRL</td>
</tr>
<tr>
<td>Walk-Away Key</td>
<td>NONE</td>
</tr>
<tr>
<td>Walk-Up Modifier</td>
<td>CTRL</td>
</tr>
<tr>
<td>Walk-Up Key</td>
<td>NONE</td>
</tr>
</tbody>
</table>

The **Walk-Away Modifier** and **Walk-Away Key** allow you to use a key combination to trigger to turn the sonar off.

The **Walk-Up Modifier** and **Walk-Up Key** allow you to use a key combination to turn the sonar on.
22.14. Touch Screen>Serial Drivers

Each serial touch screen has a specific touch driver based on the touch controller of the monitor. You need to add the appropriate driver that matches the touch controller. ThinManager supports over a dozen serial touch screen controllers.

**Note:** The touch controller is the important component. Many people make touch screen monitors but few make the controller. You need the module that matches the controller.

---

### Module Properties

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Serial Port</td>
<td>COM1</td>
</tr>
<tr>
<td>Monitor Number</td>
<td>1</td>
</tr>
<tr>
<td>Double Touch Area (pixels)</td>
<td>10</td>
</tr>
<tr>
<td>Double Touch Time (milliseconds)</td>
<td>1000</td>
</tr>
<tr>
<td>Touch De-bounce Timeout (milliseconds)</td>
<td>0</td>
</tr>
<tr>
<td>Swap XY Coordinates</td>
<td>NO</td>
</tr>
<tr>
<td>Hold Down Time (milliseconds)</td>
<td>DISABLED</td>
</tr>
<tr>
<td>Hold Down Area (pixels)</td>
<td>20</td>
</tr>
<tr>
<td>Hold Down Action</td>
<td>RightClick</td>
</tr>
<tr>
<td>Number (of Serial Ports)</td>
<td>1</td>
</tr>
</tbody>
</table>

**Serial Touch Screen Driver**

Some, but not all, touch screen modules have parameters that can be modified. These may include:

**Connection**

- **Serial Port** – Sets the COM port that a serial touch screen is connected to.
- **Baud Rate** - Sets the speed used for communication between the terminal and the touch screen on some serial touch screens.
- **Monitor Number** – Used to specify which monitor in a MultiMonitor scheme will use for the touch screen. MultiMonitor thin clients with multiple touch screens will need a module loaded for each touch screen used.

**Touch Settings**

- **Double Touch Area (pixels)** – This sets the size of the area that a second touch will register as a double touch.
- **Double Touch Time (milliseconds)** - The amount of time between touches that qualifies as a double touch.
• **Touch De-Bounce Timeout** - a time interval used to prevent a single touch from being registered as multiple touches.

• **Swap XY Coordinates** – If X and Y are reversed, this setting will correct the orientation.

• **Hold Down Time (milliseconds)** - This setting, when enabled, will initiate the Hold Down Action when the touch is held for the configured time

• **Hold Down Action** - This sets the action that a long touch will initiate. These include Right Click and OnBoard Keyboard.

• **Hold Down Area (pixels)** - This sets the size of the area that a second touch will register as a right click.

**Calibration**

• **Number of Calibration Points** – This sets the number of calibration points that the calibration program uses during the calibration process.

• **Calibration Margin Percentage** – This sets the distance from the edge of the screen that the calibration points are displayed.

• **Calibration Hotkey** – This allows a function key to be set as a hotkey so that the calibration can be launched from a keyboard.

• **Calibration Hotkey Modifier** – This setting adds CTL or ALT to the hotkey to launch the calibration from the keyboard, if desired.

• **Calibration Hold Down Time (seconds)** – This setting, when enabled, will launch the calibration program when the screen is touched and held for the assigned number of seconds. This cannot be used with the Right Click Hold Time.

• **Clean Time** – This sets an idle time before the calibration to allow you to clean and wash a touch screen. The calibration will wait until you are done touching the screen while cleaning.

• **Calibration (entered automatically)** – This is set automatically by machine. These are the values set during the calibration process.

**Miscellaneous**

• **Hide Mouse Cursor** – This hides the mouse cursor if a mouse is not present.

• **Orientation (entered automatically)** - This is set automatically by machine. Used at the direction of Tech Support in error correction.
22.15. Touch Screen>USB Touch Screen Driver

USB touch screens are easy to use as they use a standardized format. The USB Touch Screen Driver should work for all USB touch screens.

Some, but not all, touch screen modules have parameters that can be modified. These may include:

**Connection**
- **Monitor Number** – Used to specify which monitor in a MultiMonitor scheme will use for the touch screen. MultiMonitor thin clients with multiple touch screens will need a module loaded for each touch screen used.

**Touch Settings**
- **Double Touch Area (pixels)** – This sets the size of the area that a second touch will register as a double touch.
- **Double Touch Time (milliseconds)** - The amount of time between touches that qualifies as a double touch.
- **Touch De-Bounce Timeout** - a time interval used to prevent a single touch from being registered as multiple touches.
- **Swap XY Coordinates** – If X and Y are reversed, this setting will correct the orientation.
- **Hold Down Time (milliseconds)** - This setting, when enabled, will initiate the Hold Down Action when the touch is held for the configured time
- **Hold Down Action** - This sets the action that a long touch will initiate. These include Right Click and OnBoard Keyboard.
- **Hold Down Area (pixels)** - This sets the size of the area that a second touch will register as a right click.

**Calibration**

- **Number of Calibration Points** – This sets the number of calibration points that the calibration program uses during the calibration process.

- **Calibration Margin Percentage** – This sets the distance from the edge of the screen that the calibration points are displayed.

- **Calibration Hotkey** – This allows a function key to be set as a hotkey so that the calibration can be launched from a keyboard.

- **Calibration Hotkey Modifier** – This setting adds **CTL or ALT** to the hotkey to launch the calibration from the keyboard, if desired.

- **Calibration Hold Down Time (seconds)** – This setting, when enabled, will launch the calibration program when the screen is touched and held for the assigned number of seconds. This cannot be used with the **Right Click Hold Time**.

- **Clean Time** – This sets an idle time before the calibration to allow you to clean and wash a touch screen. The calibration will wait until you are done touching the screen while cleaning.

- **Calibration (entered automatically)** – This is set automatically by machine. These are the values set during the calibration process.

**Miscellaneous**

- **Hide Mouse Cursor** – This hides the mouse cursor if a mouse is not present.

- **Orientation (entered automatically)** - This is set automatically by machine. Used at the direction of Tech Support in error correction.

The **Right Click Hold Time (milliseconds)** setting allows you to send a right click to the session. This can be used with the **Tile on right click setting** on the **Tile Options** window to allow a user to switch screens on a touch screen without keyboard or mouse.

The **Tile Options** page is found on the **Terminal Interface Options** page of the **Terminal Configuration Wizard**.
22.16. Video>Custom Video Mode Module

ThinManager Ready thin clients are designed for use with traditional computer monitors. Some modern monitors require the **Custom Video Mode Module**.

The optional Video Mode Types include:

- Default
- Detect
- ATSC_Standard
- Extended_Widescreen
- 1680x1050-60
- ATSC-720-59.94p
- ATSC-720-60p
- ATSC-720-71.93p
- ATSC-720-72p
- ATSC-1080-59.94p
- ATSC-1080-60p
- ATSC-1080-71.93p
- ATSC-1080-72p
- ATSC-1080-72p
- VESA-1080-60
- VESA-1080-75

Use the setting that matches the resolution and refresh rate of your monitor.
23. **MultiMonitor**

The **MultiMonitor** method uses specific ThinManager Ready thin clients that have multiple video ports built into the hardware. Each MultiMonitor thin client can have from two to five monitors attached. These monitors can be configured to merge into an expanded desktop (called “spanned” by ACP) or can display individual desktops (called “screened” by ACP), or combinations of “spanned” and “screened” sessions.

**MultiMonitor Thin Client with Four Monitors**

WinTMC supports MultiMonitor sessions on PCs that have Windows running on multiple desktops. MultiMonitor is configured in the [Terminal Configuration Wizard](#) or the [Group Configuration Wizard](#).
MultiMonitor configuration is initiated in the Terminal Configuration Wizard when a MultiMonitor-capable thin client is selected on the Terminal Hardware page.
MultiMonitor – Enable MultiMonitors

MultiMonitor requires the use of Display Clients. Once the **Use Display Clients** checkbox is selected on the **Terminal Mode Selection** page, the **Enable MultiMonitor** checkbox becomes visible.

Select the **Next** button to continue to the **MultiMonitor Video Settings** page.
The MultiMonitor Video Setting allows the user to choose how many monitors will be connected to the MultiMonitor thin client using the **Number of Monitors** radio button.

The **Color Depth** drop-down allows the color depth to be set for all the monitors.

The **Video Port** allows you to change the order of the output from the ports. It can be easier to change the port order of the thin client configuration than it is to open a cabinet and re-arrange the video ports if you connected them wrong.

Select the **Number of Monitors** you have connected.

Set the **Resolution** for each monitor.

Microsoft increased the supported resolution in 2012 Server to 8196 x 8196. The **Use Session Size Limits for** dropdown allows you to use this higher resolution limit when spanning several monitors connected to a 2012 Server. Previous versions were limited to 4196 x 2048.

Select the **Next** button to continue to the **Monitor Layout** page.
The Monitor Layout page allows the configuration of MultiMonitor. This terminal is set to use four monitors in a grid, with each monitor its own screen.

The Choose your monitor layout dropdown will display the various physical arrangements of the monitors. Select the layout that matches your layout.

Sample Monitor Layouts

The Main Monitor radio button determines which screen is considered the main monitor. This monitor will display the TermSecure login window, Main Menu, and ThinManager messages.

The Choose your screen layout dropdown will allow the assignment of sessions to the monitors. The monitors can be combined into a “Spanned” session that contains two or more monitors, or they can be configured to hold an individual session per monitor, called “Screened”, or a combination of the two.
Note: The desktop of a spanned session is limited to 4096x2048 in Server 2008 R2 and earlier. The resolution of a Server 2012 is 8196 x 8196. The Use Session Size Limits dropdown on the MultiMonitor Video Setting page allows you to change to this higher resolution.

The selection of monitor resolution on the MultiMonitor Video Settings page can affect the number of monitors that you can add to a spanned session.
Monitor Layout

This terminal is set to use four monitors in a grid, with all monitors merged into one screen. Select the **Next** button to continue.
Display Client Selection

The **Display Client Selection** page will show the layout of the monitors and allow you to select the display clients for each screen.

This example shows four monitors merged into a single screen. It has a single display client selected that will display on the merged monitors.
Display Client Selection

This example shows four monitors each running as a separate screen. It has display clients on each monitor.
23.1. Override Function

MultiMonitor has an Override function that allows Display Clients on a MultiMonitor thin client to login with different user accounts or video resolutions. This may be needed to run duplicate copies of a program on the same thin client.

Microsoft restricts each user to a single session on a server by default. It is smart to keep this setting to prevent conflicts.
Users on a Terminal Server

In reality a user can log into a terminal server multiple times as long as they are running different applications. Each Username/Application needs to be unique.

If you want to run the same application twice you will have a problem. This is a common desire on MultiMonitor displays. The **Override** function solves this issue.
Override Button on the Display Client Selection Page

Highlight a Display Client assigned to the MultiMonitor thin client on the Display Client Selection page. Select the Override button to launch the Override Settings window.
The **Override Settings** window allows you to configure the highlighted Display Client to use a different login or screen resolution.

Check the **Override** checkbox for the **Login Settings**.

Add a valid **Username** and **Password** that is different than the main account used by the terminal. This way the display client will run the same program with a different user account.

You can also add an individual **Command Line Option** or change the **Video Resolution**.

Select **OK** to save the changes.

**Note:** Using multiple user accounts on a terminal doesn’t affect the “Per Device TS/RDS CAL count but will require more “Per User” TS/RDS CALs.

Select the **Next** button on the **Display Client Selection** page to continue to the **Screen Options** page.
Display Client Selection

This shows the Override button and the icon for a Display Client that has its properties overridden. Repeat for any display client that requires a different user account.
23.2. Moving Applications

23.2.1. Terminal Configuration

Terminals using MultiSession can be configured to allow sessions to be moved from monitor to monitor for user preference. Selecting the *Allow groups to move to/from screen* checkbox configures this. If left unselected the sessions will stay in the assigned monitor.

*MultiMonitor - Screen Options*

Select the *Screen Option* button to launch the *Screen Options* window.
The **Screen Options** settings are:

- **Show Display Client Selector** – This checkbox, if selected, will display the Display Client Selector to allow the user to switch between MultiSession groups.
- **Enable Tiling** – This checkbox, if selected, allows multiple sessions to be tiled to allow a visual selection.
- **Allow groups to move to/from screen** – This checkbox will allow a session from a MultiSession group to be moved to or from the monitor to suit a user’s preference.
- **Use Microsoft Extended Desktop** – This uses the Microsoft style of full screen application that fills a single monitor instead of the full desktop.
- **Main Desktop Monitor** – This will allow you to select which your main screen is in a spanned desktop.

The **MultiStation Options** settings are:

- **Station has a keyboard** – Select this checkbox if each user in a MultiStation configuration has a keyboard.
- **Station has a mouse** – Select this checkbox if each user in a MultiStation configuration has a mouse.
- **Screen Edge Display Client Selection** – This checkbox will enable the Screen Edge method of switching between display clients.

You can lock a display client to a monitor by leaving the **Allow groups to move to/from screen** checkbox unchecked. If you check it then you can move display clients from the screen or off the screen, allowing you to view any display client in any monitor.
23.3. Share Keyboard and Mouse Module

The Share Keyboard and Mouse module allows several ThinManager Ready thin clients to be controlled with a single keyboard and mouse without the need of a KVM switch (Keyboard/Video/Mouse).

Shared Keyboard and Mouse Module

*Shared Keyboard and Mouse Layout*

The **Share Keyboard and Mouse** can be used by placing several monitors connected to ThinManager Ready thin clients side-by-side or top-to-bottom. The **Share Keyboard and Mouse Master module** is loaded on the center thin client. This module is configured by adding the IP addresses of the secondary slave thin clients. The other terminals receive the **Share Keyboard and Mouse Slave module**.

Place three terminals and their monitors side-by-side.

**23.3.1. Master Thin Client Configuration**

One thin client needs to be configured as the Master. It is the dominant terminal whose keyboard and mouse will be used to control the grouped terminals.

Open the **Terminal Configuration Wizard** for the center terminal by double clicking on it in the ThinManager tree.

Navigate to the **Modules Selection** page by selecting the **Next** button.

Select the **Add** button and select the **Share Keyboard and Mouse Master module**.

Highlight the **Share Keyboard and Mouse Master module** and select the **Configure** button to launch the **Module Properties** window.
Highlight the **Left Terminal IP Address** parameter.
Enter the appropriate IP address into the **Value** field.
Select the **Set** button to apply the setting.

Highlight the **Right Terminal IP Address** parameter.
Enter the appropriate IP address into the **Value** field.
Select the **Set** button to apply the setting.

Select the **Done** button and Restart the ThinManager Ready thin client to apply the changes.
23.3.2. Slave Thin Client Configuration

The other terminals in the group need the *Slave* module.

Open the *Terminal Configuration Wizard* for the each terminal by double clicking on it in the ThinManager tree.

Navigate to the *Modules Selection* page by selecting the *Next* button.

Select the *Add* button and select the *Share Keyboard and Mouse Slave* module.

Select the *Done* button and restart the ThinManager Ready thin client to apply the changes.

The *Share Keyboard and Mouse Slave* module has a parameter that allows the slaves to point to a master.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Master IP Address</td>
<td>ANY</td>
</tr>
</tbody>
</table>

*Share Keyboard and Mouse Master Module Properties*

Once the ACP Enabled thin clients are booted, the mouse on the master thin client can be moved seamlessly into the other desktops. The keyboard will be active in the screen the mouse pointer is on.

This allows an operator to have control of several displays with only one keyboard and mouse. The mouse movement is seamless, allowing access to displays without switching.

**Note:** A Master Share Keyboard and Mouse session cannot be interactively shadowed in ThinManager unless that parameter is activated.

The keyboards and mice for the slave thin clients can be left attached, but stowed away until a multi-user configuration is needed.
23.3.3. **Shared Keyboard and Mouse with MultiMonitor**

Using the Shared Keyboard and Mouse module fell out of favor when the MultiMonitor hardware was introduced. It was easier to use a single MultiMonitor thin client to show multiple displays than using several thin clients and the Shared Keyboard and Mouse module.

The Shared Keyboard and Mouse module made a comeback once people realized they could tie several MultiMonitor thin clients together to provide a wall of monitors in a control room.

![MultiMonitor Shared Keyboard and Mouse Module](image)

*MultiMonitor with Shared Keyboard and Mouse*

The configuration of the Slave and Master Shared Keyboard and Mouse modules are the same with MultiMonitor.
24. ThinManager Server Configuration Wizard

The ThinManager Server Configuration wizard allows the configuration of global ThinManager settings. It can be launched by:

- Selecting *Edit > Modify* while the ThinMan icon is highlighted in the ThinManager tree, or
- Double-clicking on the ThinManager icon in the tree, or
- Right clicking the ThinMan icon and selecting *Modify*.

Importance of Page: This displays introductory information

Select *Next* to Configure the ThinManager Server settings.
**Unknown Terminals**

### Importance of Page:
Controls creation and replacement of terminals through use of passwords and auto-creation.

### Settings:
- **Allow unknown terminals to connect** - This checkbox, if selected, lets new terminals be added to the ThinManager Server. Replacements and new terminals are prevented if this box is un-selected.
- **Require password on unknown terminals** - This checkbox, if selected, allows use of a password so that only authorized personnel can add terminals to the ThinManager Server. If checked, the password fields become active and allow the addition of a password.
- **Enable AutoCreate** - This checkbox, if selected, allows the auto-creation of an array of terminals as described in Auto-Creation of Terminals.
- **AutoCreate Mask** - This field is the base name used in the array of terminals when using Auto-Creation of Terminals.

### Why Change from Default Settings:
- Requiring a password can control who adds terminals. Using auto-creation can be helpful in some large deployments.

Select **Next** to continue, **Finish** to save and close, or **Cancel** to close without saving.
**Terminal Replacement**

**Importance of Page:** Sets the global setting for enabling replacement of offline terminals.

**Note:** Terminals that are on cannot be replaced until they are turned off.

**Settings:**
- **Enable Replacement** – This checkbox gives global permission for terminals to be replaced. Un-selecting this will prevent all terminals from showing up in the replacement list when a new terminal is added, making Create New Terminal the only option. This feature is also available for the Group and terminal level on the first page of the corresponding wizard. However, if this checkbox is unselected in the ThinManager Server Configuration Wizard, checking it in a Terminal Configuration Wizard will have no effect.

- **Allow Replacement only with like model** – This checkbox prevents the replacement of a terminal with a different model to prevent configuration changes, a PXE for a PXE or an Android for an Android, for example.

- **Allow Terminal Creation during replacement** – Normally a terminal displays the “Create New Terminal” option during replacement. Unchecking this checkbox will remove that option and only allow a terminal replacement, not a new configuration.

**Why Change from Default Settings:** Un-selecting this will prevent all terminals from showing up in the replacement list when a new terminal is added, making Create New Terminal the only option.

Select **Next** to continue, **Finish** to save and close, or **Cancel** to close without saving.
**Historical Logging**

**Importance of Page:** Sets the duration that logs are maintained.

**Settings:**

- **Maintain Historical Log for X days** - This field determines the length of time that the terminal server CPU and memory data from the **Terminal Server Graph** tab is stored. See Details Pane for an example of the graph.

- **Maintain Event Log for X days** - This field determines how long the event log is kept.

- **Choose events to log** - These checkboxes determine what events are stored in the log.
  - **Terminal Server Events** - This checkbox, when selected, records events of the terminal servers.
  - **Terminal Events** - This checkbox, when selected, records events of the terminal.
  - **Terminal Configuration changes** - This checkbox, when selected, records changes to the terminal configuration.
  - **User Configuration Changes** - This checkbox, when selected, records changes to the TermSecure User configuration.

**Buttons:**

- **Clear History** - This button will erase the Historical log.
- **Clear Event Log** - This button will erase the Event log.
**Why Change from Default Settings:** You can add Terminal Server events and TermSecure User events that aren’t collected by default. You can change the duration of the logs.

Selecting the **Event Log** tab will show the events for the highlighted tree icon.

![Event Log Tab](image)

**Event Log Tab**

Details of an event can be obtained by double-clicking on an event.
The **Event Details** window shows details of the selected event. Select either the **OK** or **Cancel** button to close.

Select **Next** to continue, **Finish** to save and close, or **Cancel** to close without saving.
Importance of Page: Allows schedules to be setup for ThinManager and the ThinManager system.

Buttons:

- **Edit Schedule** – This button launched the Event Schedule window. See Scheduling for details.

Why Change from Default Settings: Automating backups, reports, and actions with the Scheduler saves time.

Select **Next** to continue, **Finish** to save and close, or **Cancel** to close without saving.
Access to ThinManager can be assigned to Windows User Groups on the ThinManager Security Groups page.

ThinManager Security Groups

Importance of Page: Normally administrators are the only people who have access to ThinManager functions. This page allows access to be granted to people so they can perform specific jobs without being elevated to the administrator role.

Settings:

- **Windows User Group** – This dropdown shows the group that is being configured.

Fields:

- **Available** – This list box shows the ThinManager functions that are available to the Windows group displayed in the Windows User Group box. These functions can be added to the **Allowed** list by double clicking.

- **Allowed** – This list box shows the ThinManager functions that are granted to the Windows group displayed in the Windows User Group box. These functions can be removed from the **Allowed** list by double clicking.

Buttons:

- **Delete Group** – This button will remove the highlighted group in the Windows User Group box.

- **Add Group** – This button launched the New Window Group window where a new Windows© group can be added to the configuration. See Add Windows Group for details.
**Why Change from Default Settings:** Creating a Windows Group and granting access to ThinManager functions allows people to use ThinManager without being an administrator.

ThinManager allows different levels of access and functionality based on standard Windows groups. By default only members of the Windows Administrator group has the ability to connect to ThinManager and use the application. The ThinManager Security Groups allows other Windows groups to be granted privileges in ThinManager.

ThinManager comes with privileges pre-defined for six groups. Each of these groups (except Administrators) needs to be created on the domain controller or in the Local Users and Groups on the Computer Management console and members added before they can be used.

- **Administrators** - The Microsoft defined Administrator group is given all privileges by default in ThinManager. This may be denied by unselecting the various allowed Windows User Group Permissions.

- **ThinManager Administrators** have full permission to do anything within ThinManager including the power to logoff sessions, kill processes, send messages, restart terminals, calibrate touch screens, change terminal configurations, update firmware, update the TermCap, and restore configurations. Administrators and members of ThinManager Administrators can shadow terminals and interactively control the terminal session. These privileges may not be removed and will be grayed out.

- **ThinManager Interactive Shadow Users** - Members of this group may shadow a terminal interactively.

- **ThinManager Power Users** can logoff sessions, kill processes, send messages, restart terminals, and calibrate touch screens. They cannot change terminal configurations, update firmware, update the TermCap, and restore configurations. ThinManager Power Users can shadow terminals from within ThinManager but cannot interact with the session.

- **ThinManager Shadow Users** - Members of this group may shadow a terminal but not interactively.

- **ThinManager Users** can view only. They cannot logoff sessions, kill processes, send messages, restart terminals, or calibrate touch screens. ThinManager Users cannot shadow a terminal.

Selecting the Add Group button in a non-domain ThinManager Server will launch the New Windows Group window. This will allow the configuration of additional Windows User Groups.

![New Windows Group Window](image)

**New Window User Group Window**

Adding a Windows Group name in the Enter Windows User Group Name field of the New Window Group window and selecting the OK button will add the Windows User Group to the drop-down list.

**Note:** This doesn’t create the user group on any servers. This just adds the name of an existing group to the list that ThinManager is maintaining.
Selecting the **Add Group** button in a domain ThinManager Server will launch the **Select Security Group** window. This will allow you to add Active Directory groups and configure their permissions in ThinManager.

![Select Security Group Window](image)

**New Window User Group Window**

Adding a Windows Group name in the **Enter Windows User Group Name** field of the **New Window Group** window and selecting the **OK** button will add the Windows User Group to the drop-down list.

The **Manual Entry** field will allow you to enter a local Windows User Group.
ThinManager Security Groups Page

Select the group from the **Windows Users Group** drop-down. Choose the permissions you want to grant to the group by double clicking on the function in the **Available Windows User Group Permissions** list. Members of the Windows User Group will have the selected permissions the next time they login.

Although ThinManager has Windows User Groups pre-configured with privileges, these groups have not been created on the terminal servers.

To create a Windows User Group, open the **Computer Management Console** by selecting **Start > Settings > Control Panel > Administrative Tools > Computer Management.**
Created ThinManager Security Groups

Highlight **Groups** in the tree and select **Action > New Group** to launch the **New Group window**.

![Microsoft New Group Windows](image)

Enter the group name in the **Group name** field.

Add **Users** to the Windows User Group by selecting the **Add** button.

Select the **Create** button to finish the Windows User Group creation. Members of the Windows User Group will have the selected permissions the next time they login.
**Note:** The ThinServer service may need to be stop and restarted to load the new ThinManager Security Group settings.

Select **Next** to continue the ThinManager Server Configuration Wizard, **Finish** to save and close, or **Cancel** to close without saving.

**Event Selection**

**Importance of Page:** ThinManager has event notification. E-mails or Windows messages can be sent by ThinManager to identify changes in the setup, configuration or status.

**Settings:**

- **Email** – Checking the *E-mail* checkbox will send an e-mail message when that event occurs. The e-mail needs to be set up on the next page of the wizard.

- **Windows Messages** – Checking the *Windows Message* checkbox will send a message to a terminal when that event occurs. The terminal needs to be defined on the next page of the wizard.

**Why Change from Default Settings:** Information about these events can be useful. The event needs checked to add the notification.

The ThinManager Server Stop/Start, Terminal Server Monitor Connection, and Terminal Monitor Connection events may indicate the failure of the ThinManager Server, Terminal Server, or terminal. Sharing information on configuration changes, firmware, TermCap, or license installation can be useful when management is shared among a group. Sending an e-mail to all group members keeps them informed of all changes.

Select **Next** to continue, **Finish** to save and close, or **Cancel** to close without saving.
Importance of Page: This page defines what users are notified of event changes from the Event Selection page.

Fields:

- **SMTP Server** - Enter the SMTP (Simple Mail Transfer Protocol) server to be used by the ThinManager Server in the field.
- **E-Mail Return Addresses** - Enter the return e-mail address to be used by the ThinManager Server in the field.
- **E-Mail Addresses** - ThinManager will send an e-mail message to the addresses in this text box when an event selected on the Event Select page occurs.
- **Terminals** - ThinManager will send a message to the terminals in this text box when an event selected on the Event Select page occurs.

Buttons:

- **Add (E-Mail Addresses)** - Select this button to add e-mail addresses through the Enter the E-mail address window.
- **Delete (E-Mail Addresses)** - Select this button to delete a highlighted e-mail address from the E-mail Addresses list.
- **Add (Terminals)** - Select this button to add a terminal through the Select Terminal(s) window.
- **Delete (Terminals)** - Select this button to delete a highlighted terminal from the Terminals list.

  **Add (E-Mail Addresses)** - Select this button to add e-mail addresses through the Enter the E-mail address window.

  **Enter the E-mail Address Window**
  Enter the desired e-mail address in the entry form and select **OK**. Select the **Cancel** button to close the window without making changes.

- **Add (Terminals)** - Select this button to add a terminal through the Select Terminal(s) window.

  **Terminal Selection Window**
  The Select Terminal(s) windows will list the terminals configured on the ThinManager Server. Highlight the desired terminal and select the **OK** button.

**Why Change from Default Settings:** You need to add recipients for event notification to work.

Select **Next** to continue, **Finish** to save and close, or **Cancel** to close without saving.
Multicast Configuration Page

**Importance of Page:** Allows multicast to be configured for ThinManager Servers.

**Fields:**
- **Maximum Packet Size** – This allows the firmware download packet size to be changed, if needed.

**Settings:**
- **Enable Multicast** - This checkbox, if selected, enables Multicast.
- **Enable Smart Multicast** - This checkbox, if selected, enables Smart Multicast.

**Buttons:**
- **Advanced** - This button, if selected, displays the advanced settings.
- **Set to Defaults** - This button, if selected, sets the advanced settings back to the defaults.

**Why Change from Default Settings:** You may need to change the settings if there is a conflict with another multicast server on the network.

**Multicast** provides the ability for an unlimited number of terminals to boot simultaneously from the same data stream. This feature reduces the amount of network traffic and reduces the amount of load on the ThinManager Server when multiple terminals are booting concurrently. This function is especially useful for low bandwidth connections and highly utilized networks.

**Smart Multicast** allows the terminal firmware to be sent directly to the terminal while a single terminal is booting. If additional terminals request the terminal firmware during this time, the firmware will be
multicast so that all terminals can receive the firmware from a single data stream. If Smart Multicast is disabled, the firmware will always be sent as a multicast transmission.

Multicast is only available on terminals with ACP Boot Loader Version 5.0 and later. No local terminal configuration is needed to use Multicast.

**Unicast** – ThinManager has error checking that will switch a terminal’s firmware download to unicast if the multicast download fails.

The thin client will continue to try to use multicast at each boot but will use unicast if multicast keeps failing.

**Advanced Settings** – Selecting the *Advanced* button will reveal advanced settings for multicast.

![Image](image.png)

**Advanced Multicast Options**

**Importance of Page:** This allows changing the multicast settings if there is a conflict with another multicast server on the network.

**Settings:**

- **Multicast Settings**
  - **Address** – This is the IP address that will be used for Multicast transmissions.
  - **Port** – This is the destination port that will be used for Multicast transmissions.
  - **Time-to-Live (TTL)** – This is the maximum number of router hops for Multicast packets. Setting this value to 255 allows for unlimited hops.

- **IGMP Settings (Internet Group Management Protocol)**
- Version – This sets the IGMP version for use with multicast capable routers.
- Time-to-Live (TTL) – This sets the time-to-live value for IGMP packets.

**Buttons:**

- **Advanced** - This button displays the advanced settings.
- **Set to Defaults** - This button sets the advanced settings back to the defaults.

**Why Change from Default Settings:** Change these if a conflict develops.

Select **Next** to continue, **Finish** to save and close, or **Cancel** to close without saving.

---

**Shadow Configuration Port**

ThinManager allows the port used for shadowing to be configured.

**Importance of Page:** This allows the port that is used for shadowing to be changed.

**Settings:**

- **Shadow Port** – ThinManager uses port 5900 as the default port for shadowing. Entering a different port number into the Shadow Port field will change the port used if it is in conflict with another processes use of the port.

**Why Change from Default Settings:** ThinManager uses the save port as VNC. If VNC is installed on a WinTMC PC then there could be a conflict between shadowing services. If this happens the port can be changed in ThinManager.

Select **Finish** to accept changes or select **Cancel** to close without making changes.
Navigate to the **Biometric Device Configuration** window.

Select the **Support Finger Print Readers** checkbox to enable the use of readers.

Select the data format you plan to use. There are two formats to choose, **ISO_19794_2_2005** and **ANSI_378_2004**.

The **False Match Probability** sets the sensitivity of the read. 1/100 is less sensitive than 1/1,000,000.

Select the **Finish** button to accept the changes.
25. Reports and Schedules

ThinManager has the ability to run reports, show data, and collect data on the ThinManager system. These reports can show the event log, configurations, uptimes, and other data.

A Reports tab on the Details pane will show a report for a highlighted ThinManager Server, terminal, terminal group, terminal server, TermSecure user, or TermSecure user group. Reports can be scheduled to be run and saved as *.html files for storage or further analysis.

25.1. Selecting Reports

The reports are displayed on a Report tab in ThinManager. The Select Reports window allows the selection of which report to display.

Select Reports Window

Select View > Reports from the ThinManager menu to launch the Select Reports window.

The Select Reports window has four fields that determine which report is displayed on the report tab.

- **System Report** – This selects the report to display on the Report tab when the ThinManager Server is highlighted.
- **Terminal Report** – This selects the report to display on the Report tab when a terminal or terminal group is highlighted.
- **Terminal Server Report** – This select the report to display on the Report tab when a terminal server is highlighted.
- **TermSecure User Report** – This selects the report to display on the Report tab when a TermSecure User or TermSecure User Group is highlighted.

Use the drop-down list to select the desired reports.
25.2. **Report Tab**

The reports selected in the **Select Reports** window will be displayed on the **Report** tab in ThinManager.

Highlight the desired ThinManager Server, terminal, terminal group, terminal server, TermSecure user, or TermSecure group, and then select the **Report** tab to display the report.
25.3. Print Report

A Report can be printed by:

- Selecting the Report tab and selecting View > Print from the ThinManager menu. A Print window will be displayed to allow the selection of the printer.
- Right clicking on the report inside of the Details pane.

![Print Window](image)

A **Print** window will be displayed with all the printers defined on the ThinManager Server. Highlight the desired printer and select the **Print** button to print the report.
25.4. Report Template Installation

ThinManager will install a number of reports into the ThinManager folder during installation. The default is \`C:\Program Files\Automation Control Products\ThinManager\ReportTemplates\`.

Additional report templates can be downloaded from `http://downloads.thinmanager.com/` as they become available. New Reports are added to service packs and new releases.

New reports are installed by selecting **Install > Reports** from the ThinManager menu. This launches the Reports window.

![Reports Window](image)

Select the **Install** button to launch a file browser.

- **Report Templates** – If this radio button is selected the file browser will browse for `*.html` files.
- **SQL Files** – If this radio button is selected the file browser will browse for `*.sql` files.
- **Images, Finished Reports, etc.** – If this radio button is selected the file browser will browse for assorted files.
Each report has a *html component and a *sql component. Select the Report Templates radio button, browse to the new *html file, and select Open to install. Select the SQL Files radio button, browse to the new *sql file and select Open to install. Once these two components are added the report will be available.
26. Scheduling

Reports can be scheduled to be run once at a specified time or to be run regularly at a specific time. The reports are saved as *.html files for storage or further analysis.

Scheduling is available for more than running reports. Schedules can be created for:

- The System in the ThinManager Server Configuration Wizard.
- Terminals in the Terminal Configuration Wizard.
- Terminal Servers in the Terminal Server Configuration Wizard.
- TermSecure Users in the TermSecure User Configuration Wizard.

26.1. System Scheduling of Reports

Reports are scheduled on the ThinManager Server Configuration Wizard.

Open the ThinManager Server Configuration Wizard to schedule report generation by highlighting the ThinManager Server icon, right clicking, and selecting Modify.

Navigate to the System Schedule page and select the Edit Schedule button to launch the Event Schedule window.
Select the **Add** button to open the **Schedule** window.
Schedule Window

The Schedule window allows system events to be configured.

- **Event Type** – This drop-down allows the event to be chosen. There are two types:
  - **Backup Configuration Database** – This allows a scheduling of automatic configuration backups.
  - **Run Report** – This allows a report to be run and saved as a *.html file on a regular basis.
- **Report Template File** - This drop-down allows the selection of the report to run.
- **Report Output File** – This applies the naming convention to the saved reports.
- **Auto Generate Filename** – This checkbox, if selected, will save the file to the ThinManager folder with the report name and a time stamp as its title.
  - If the **Auto Generate Filename** is unselected, the field allows entry of the desired filename. The filename needs to end in .html.

There are a few switches that allow the file name to be modified with a timestamp for identification purposes. If you do not use a timestamp, the file will be overwritten each time the report is run.

- `%c` – Adds date and time
- `%h` – adds hour (0-24)
- %M – adds minute (0-59)
- %x – adds date
- %X – adds time
- Repeat Interval – These radio buttons allow the frequency of the report generation to be set.
- Time – The fields to set the time of the report generation changes to match the Report Interval selected by the radio button. The Time field may allow dates, days, hours, or intervals to be set for the report.

Once the report is configured, select OK to accept the report schedule.

![Event Schedule](image)

The scheduled report will be displayed in the Event Schedule window.
- Select Add to add another report schedule.
- Select Edit to edit the schedule of a highlighted report.
- Select Delete to delete the schedule of a highlighted report.
- Select OK to accept the schedules and close the window.

When a report is run the files are saved for viewing.
Saved Reports

Once the report has run it can be opened in a web browser.
Once the report is generated the data can be saved or reformatted as desired using standard HTML tools.
26.2. Scheduling Configuration Backups

It is a good idea to back up your ThinManager configuration before you make any major changes. You can use the Scheduler to do this automatically.

Open the ThinManager Server Configuration Wizard to schedule report generation by highlighting the ThinManager Server and selecting File > Modify.

Navigate to the System Schedule page and select the Edit Schedule button to launch the Event Schedule window.

ThinManager Server Configuration Wizard – System Schedule

Navigate to the System Schedule page and select the Edit Schedule button to launch the Event Schedule window.
Select the Add button to open the Schedule window.
The Schedule window allows system events like configuration backups to be created.

- Select Backup Configuration Database from the Event Type drop-down.
- Select an interval. Weekly is adequate.
- Select a day and time.
- Select OK to accept the changes.

A weekly backup allows you to have a current configuration available in case you need one.
27. TermMon ActiveX Data

Microsoft Terminal Services lacks the ability to monitor clients and provide much useful information. ACP has written an ActiveX component to overcome this shortcoming. The TermMon (Terminal Monitoring) ActiveX can be embedded into an application that will run on the terminal server. When a terminal starts a session on the terminal server and launches the application with the TermMon ActiveX, the ActiveX will create a socket connection to the terminal and is able to pull data from the terminal into the application for display. You can create tags for the data and populate them with data from the client via the ActiveX.

27.1. Registering the Control

The TermMon ActiveX Control can be found on the ThinManager CD as `termmon.ocx`. It is also available in the Download section of www.thinmanager.com.

The Control must be registered before it can be used. Copy the file `termmon.ocx` to the computer where you want to use it. Register the OCX by executing `regsvr32 <path\termmon.ocx>`.

27.1.1. Read-Only Properties

The following properties are read only strings. An event will be generated any time one of these properties changes. The Enable method must be invoked prior to reading these properties.

- **TerminalName** - This is the name of the terminal.
- **TerminalModel** - This is the terminal model number.
- **TerminalIP** - This is the terminal IP address.
- **TerminalMAC** - This is the terminal MAC Address.
- **TerminalBootLoaderVersion** - This is the terminal network boot loader version.
- **TerminalFirmwareVersion** - This is the firmware version that the terminal is running.
- **TerminalWindowsUsername** - This is the Windows Username that is specified in the terminal’s ThinManager configuration.
- **TermSecureUsername** - This is the TermSecure username of the TermSecure user currently logged onto the terminal. If no TermSecure user is logged on, this value will be blank.
- **TermSecureWindowsUsername** - This is the Windows Username associated with a TermSecure user. This is the Windows Username for all TermSecure user sessions. If no TermSecure user is logged on, this value will be blank.
- **TerminalServerGroupList** - This is a comma-separated list of Display Clients currently running on the terminal.
- **ConnectionState** - This is the Control’s connection state with the terminal.
- **CurrentTerminalServerGroup** - This is the Display Client that is currently being displayed on the terminal.
- **CurrentWindowsUsername** - This is the Windows Username of the session where the Control has been executed. This property is not available when the RunInSession property is set to `False`.
- **TerminalServerName** - This is the name of the Terminal Server where the Control is running. This property is not available when the RunInSession property is set to `False`.
- **UserID** - This is the identifier associated with a TermSecure user. An example of this would be the badge number of a security badge used by a TermSecure user when scanning the badge.
Using this property may require enabling the “Expose ID” setting in the appropriate ThinManager module (i.e. RFIdias pcProx USB Module).

- **RelevanceLocationName** - This is the complete path and name of the current Relevance Location.
- **ScanResult** – This property will contain the result of the Command Method Scan Code commands.

### 27.1.2. Read-Write Properties

These properties can be set by the application.

- **RunInSession** - When the RunInSession property is set to True, the Control will be running in the terminal’s terminal services session. The terminal IP address will be determined automatically by the control.
- **OverrideIP** - If the RunInSession property is set to False, the OverrideIP property specifies the IP Address of the terminal that the Control will connect to.

**Note:** To use the OverrideIP property, the TermMon ActiveX Control Configuration Module must be added to the terminal configuration in ThinManager. In the module configuration, **Allow ActiveX Connections** must be set to **YES**, and **Only Allow Connections from Session** must be set to **NO**.

- **WatchdogTime** – This is the number of seconds before the watchdog will reset the terminal session. Once this property is set to a non-zero value, the property must be updated before the watchdog time reaches zero. To disable the watchdog, set this property to zero. The watchdog is disabled by default.

**Note:** The **Enable Method** does not need to be called for watchdog operation. Watchdog operation is independent of the **Enable** and **Disable Methods**.

- **ActiveScreen** – For MultiMonitor configurations, this is the active screen number. A value of zero (default) will set the active screen to the screen the mouse pointer is on when a method or command is executed. A non-zero value will set the Active Screen to the screen number specified. All methods and commands will be executed on the specified screen.

### 27.1.3. Events

When a property value changes, an event will be generated by the Control. When an Event occurs the event code can be used to determine the property that changed. The Enable method must be invoked in order to receive events (except for WatchdogTime). The event code is provided by the Control as follows:

- TermMonEvent.TerminalName
- TermMonEvent.TerminalModel
- TermMonEvent.TerminalIP
- TermMonEvent.TerminalMAC
- TermMonEvent.TerminalBootLoaderVersion
- TermMonEvent.TerminalFirmwareVersion
- TermMonEvent.TerminalWindowsUsername
- TermMonEvent.TermSecureUsername
- TermMonEvent.TermSecureWindowsUsername
- TermMonEvent.TerminalServerGroupList
- TermMonEvent.ConnectionState
- TermMonEvent.CurrentTerminalServerGroup
- TermMonEvent.CurrentWindowsUsername
- TermMonEvent.TerminalServerName
- TermMonEvent.WatchdogTime
- TermMonEvent.RelevanceLocationName
- TermMonEvent.ScanResult

27.1.4. Methods

- **Enable** - Invoking this method will enable the Control. The Control will attempt to connect to the terminal and generate events to update the Control Properties. The Control will maintain a connection to the terminal as long as it is enabled.

- **Disable** - Invoking this method will cause the Control to break the connection with the terminal. Events will be generated to clear the Control Properties.

- **Command** - The Command method can be used to send terminal action commands. The Command method requires one parameter which is the terminal command to be performed. The Enable method must be invoked before these commands can be executed (except for noted exceptions). The supported commands are:
  - **Reboot** - This command will initiate a terminal reboot.
  - **Restart** - This command will initiate a terminal restart.
  - **Calibrate** - This command will initiate a touch screen calibration.
  - **GotoMainMenu** - This command will cause the Main Menu to be displayed.
  - **SwitchToNextGroup** - This command will switch to the next Display Client.
  - **SwitchToPrevGroup** - This command will switch to the previous Display Client.
  - **SwitchInstFailover** - This command will switch the instant failover group.
  - **ChangeTermSecureUser** - This command will disconnect any current TermSecure user sessions and then display the TermSecure Log On menu.
  - **LogOffAndChangeTermSecureUser** - This command will log off any current TermSecure user sessions and then display the TermSecure Log On menu.
  - **LogOffTermSecureUser** - This command will log off any current TermSecure user sessions and will return to a Display Client which is assigned to the terminal. If no Display Clients have been configured on the terminal, the TermSecure Log On menu will be displayed.
  - **DisconnectTermSecureUser** - This command will disconnect any current TermSecure user sessions and will return to a Display Client which is assigned to the terminal. If no Display Clients have been configured on the terminal, the TermSecure Log On menu will be displayed.
  - **DisconnectSession** - This command will disconnect the Terminal Services Session running on the terminal. This command does not require that the Enable Method be invoked prior to execution.
- LogOffSession - This command will log off the Terminal Services Session running on the terminal. This command does not require that the Enable Method be invoked prior to execution.
- TileStart - This command will tile the Display Clients on the current Screen.
- TileEnd - This command will untile the Display Clients on the current Screen.
- ScanCodeReturnData - This command will prompt the user to scan a QR or Barcode. After the scan is complete, the scan data will be returned in the ScanResult property.
- ScanCodeAndQueryLocation - This command will prompt the user to scan a QR or Barcode. After the scan is complete, the location path and name will be returned in the ScanResult property.

The Command Method constants are provided by the Control as follows:
- TermMonCommand.Reboot
- TermMonCommand.Restart
- TermMonCommand.Calibrate
- TermMonCommand.GotoMainMenu
- TermMonCommand.SwitchToNextGroup
- TermMonCommand.SwitchToPrevGroup
- TermMonCommand.SwitchInstFailover
- TermMonCommand.ChangeTermSecureUser
- TermMonCommand.LogOffAndChangeTermSecureUser
- TermMonCommand.LogOffTermSecureUser
- TermMonCommand.DisconnectTermSecureUser
- TermMonCommand.DisconnectSession
- TermMonCommand.LogOffSession
- TermMonCommand.TileStart
- TermMonCommand.TileEnd
- TermMonCommand.ScanCodeReturnData
- TermMonCommand.ScanCodeAndQueryLocation

- ChangeTerminalServerGroup - This method can be used to change the Display Client currently displayed on the terminal. This method requires one parameter which is the name of the Display Client that the terminal should switch to.

- TermSecureCheckAccess - This method can be used to query the access rights of a TermSecure user. This method requires two parameters. The first parameter is the name of the user. The second parameter is the name of the Access Group. This method returns the result of the query as follows:
  - TermMonConst.Timeout - The request timed out.
  - TermMonConst.Busy - The Control is busy with another request.
  - TermMonConst.InvalidMember - The user is not a member of the specified TermSecure Access Group.
- TermMonConst.ValidMember - The user is a member of the specified TermSecure Access Group.
- TermMonConst.UserNotFound - The TermSecure Username was not found.
- TermMonConst.GroupNotFound - The Access Group Name was not found.

- **GetGroupScreen** - This method can be used to determine which screen the specified Display Client is currently on for MultiMonitor configurations. This method requires one parameter which is the name of the Display Client.

- **TermSecureLogonUser** - This method can be used to Log On a specified TermSecure user. This method requires two parameters. The first parameter is the name of the TermSecure user. The second parameter is the password of the TermSecure user. The password will be encrypted before being sent to the terminal. This method returns a result as follows:
  - TermMonConst.Success - The TermSecure user was successfully logged on.
  - TermMonConst.Timeout - The request timed out.
  - TermMonConst.Busy - The Control is busy with another request.
  - TermMonConst.UserNotFound - The TermSecure username was not found.
  - TermMonConst.BadPassword - The TermSecure password was invalid.
  - TermMonConst.NoPermission - The TermSecure user does not have permission to use the terminal.
  - TermMonConst.PasswordChangeReq - The TermSecure user is required to change his password.
  - TermMonConst.NoWindowsUsername - This TermSecure user does not have a Windows Username specified in the TermSecure user configuration. This is only required for Terminal Services Display Clients assigned to the TermSecure User.
  - TermMonConst.NoWindowsPassword - This TermSecure user does not have a Windows Password specified in the TermSecure user configuration. This is only required for Terminal Services Display Clients assigned to the TermSecure User.

- **CameraOverlayEnable** - This method is used to enable a camera overlay. This method requires two parameters. The first parameter is the name of the Display Client the overlay is on. The second parameter is the name of the overlay.

- **CameraOverlayDisable** - This method is used to disable a camera overlay. This method requires two parameters. The first parameter is the name of the Display Client the overlay is on. The second parameter is the name of the overlay.

- **CameraOverlayCycleStart** - This method is used to start camera cycling for a camera overlay. This method requires two parameters. The first parameter is the name of the Display Client the overlay is on. The second parameter is the name of the overlay.

- **CameraOverlayCycleStop** - This method is used to stop camera cycling for a camera overlay. This method requires two parameters. The first parameter is the name of the Display Client the overlay is on. The second parameter is the name of the overlay.

- **CameraOverlaySwitchNext** - This method is used to switch to the next camera in a camera overlay list. This method requires two parameters. The first parameter is the name of the Display Client the overlay is on. The second parameter is the name of the overlay.

- **CameraOverlaySwitchPrev** - This method is used to switch to the previous camera in a camera overlay list. This method requires two parameters. The first parameter is the name of the Display Client the overlay is on. The second parameter is the name of the overlay.
• **CameraOverlayFullscreenEnter** - This method is used to make the current camera in a camera overlay enter full screen. This method requires two parameters. The first parameter is the name of the Display Client the overlay is on. The second parameter is the name of the overlay.

• **CameraOverlayFullscreenExit** - This method is used to make the current camera in a camera overlay exit full screen. This method requires two parameters. The first parameter is the name of the Display Client the overlay is on. The second parameter is the name of the overlay.

• **CameraOverlaySwitchByName** - This method is used to change cameras in a camera overlay. This method requires three parameters. The first parameter is the name of the Display Client the overlay is on. The second parameter is the name of the overlay. The third parameter is the name of the camera. The camera name must include the full path if the camera is in a camera group.

• **CameraOverlayMove** - This method is used to change the position of a camera overlay. This method requires four parameters. The first parameter is the name of the Display Client the overlay is on. The second parameter is the name of the overlay. The third parameter is the x location. The forth parameter is the y position.

• **CameraOverlayResize** - This method is used to change the size of a camera overlay. This method requires four parameters. The first parameter is the name of the Display Client the overlay is on. The second parameter is the name of the overlay. The third parameter is the width. The forth parameter is the height.

• **CameraOverlayResizeMove** - This method is used to change the size and position of a camera overlay. This method requires six parameters. The first parameter is the name of the Display Client the overlay is on. The second parameter is the name of the overlay. The third parameter is the x position. The forth parameter is the y position. The fifth parameter is the width. The sixth parameter is the height.

• **RelevanceLocationLogon** – This method is used to log into a relevance location. This method requires two parameters. The first parameter is the complete path and name of the desired location formatted as “top_level_location_name\sub_location_name\location_name”. This string must match the location tree hierarchy in the ThinManager location tree. The second parameter is the action to be performed as defined by the TermMonRelevance action constants.

• **RelevanceLocationLogoff** – This method will log the device out of the current relevance location.
27.1.5. Control Constants

Constant values provided by the Control are as follows:

TermMonEvent
- TerminalName 1
- TerminalModel 2
- TerminalIP 3
- TerminalMAC 4
- TerminalBootLoaderVersion 5
- TerminalFirmwareVersion 6
- TerminalWindowsUsername 7
- TermSecureUsername 8
- TermSecureWindowsUsername 9
- TerminalServerGroupList 10
- ConnectionState 11
- CurrentTerminalServerGroup 12
- CurrentWindowsUsername 13
- TerminalServerName 14
- WatchdogTime 15
- UserID 16
- RelevanceLocationName 17
- ScanResult 18

TermMonCommand
- Reboot 100
- Restart 101
- Calibrate 102
- GotoMainMenu 103
- SwitchToNextGroup 104
- SwitchToPrevGroup 105
- SwitchInstFailover 106
- ChangeTermSecureUser 107
- LogOffAndChangeTermSecureUser 108
- LogOffTermSecureUser 109
- DisconnectTermSecureUser 110
- DisconnectSession 111
- LogOffSession 112
- TileStart 113
- TileEnd 114
- ScanCodeReturnData 115
- ScanCodeAndQueryLocation 116

**TermMonConst**
- Success 0
- Fail 1
- Disconnected 2
- Connected 3
- Timeout 4
- Busy 5
- Updating 6
- RequestFailed 7
- InvalidMember 8
- ValidMember 9
- UserNotFound 10
- GroupNotFound 11
- BadPassword 12
- NoPermission 13
- PasswordChangeReq 14
- NoWindowsUsername 15
- NoWindowsPassword 16

**TermMonRelevance**
- ActionNone 0
- ActionTransfer 1
- ActionClone 2
- ActionShadow 3